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No part of this document may be copied, reproduced, extracted or transmitted in any form or by any 
means without the prior written consent of Pixelhue Technology Ltd (hereinafter referred to as 
PIXELHUE). 

Trademarks 

 is a trademark of Pixelhue Technology Ltd. 

Brand and product names mentioned in this manual may be trademarks, registered trademarks or 
copyrights of their respective holders. 

Statement 

Thank you for choosing PIXELHUE products. This document is intended to help you understand and use 
the products. PIXELHUE may make improvements and/or changes to this document at any time and 
without prior notice. If you experience any problems in use or have any suggestions, please contact us 
via the contact information given in this document. We will do our best to solve any issues, as well as 
evaluate and implement any suggestions. 

This document could contain technical inaccuracies or typographical errors. Changes are periodically 
made to the information in this document; these changes are incorporated in new editions of this 
document. 

The latest edition of user manuals can be downloaded from the PIXELHUE website www.pixelhue.com.  
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1 General 

Overview 

 About This Manual 

 Version History 

 Symbols and Pictures
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About This Manual  
This user manual describes how to operate the P20/P20-DS/P10/Q8 seamless 
switchers and U5/U5 Pro event controllers, as well as how to use the matched all-
new event management software PixelFlow. This manual is designed to be a 
reference for your daily use of our products. It contains a complete description of the 
hardware and control software. 

 Note  

Always check for the latest version of all documents at www.pixelhue.com.  

Version History 

Version Date Changes 

V2.0.0 2026-04-17  Added system time display to the LCD home screen. 
(P80) 

 Updated the fan mode screen. (P80) 

 Changed Antistatic to Electrostatic Protection. (P80) 

 Updated the descriptions related to electrostatic 
protection and fan mode. (P80) 

 Added the Q8_1xST2110(100G)+4x12G-SDI Output Card. 
(Q8) 

 Updated the gross weight and packing information.(Q8) 

 Added the factory reset settings. (U5/U5 Pro) 

 Updated the gross weight information. (U5/U5 Pro) 

 Updated the PixelFlow software descriptions, such as 
live BKG, VPU, simulation device link, input view switch, 
etc.. 

V1.9.0 2026-01-15  Added system time display to the LCD home screen. (Q8) 

 Updated the fan mode screen. (Q8) 

 Changed Antistatic to Electrostatic Protection. (Q8) 

 Updated the function control area figure. (U5 Series) 

 Added PTZ control descriptions to the Smart 
Touchscreen. (U5 Series) 

 Updated the descriptions related to electrostatic 
protection and fan mode. 

 Updated the descriptions related to test pattern settings. 

 Updated the layer preset interface. 

 Updated the Multiviewer interface. 

 Added the skin changing section. 

V1.8.0 2025-11-05  Added the Q8_HDMI2.0+DP1.2+12G-SDI Input Card 
specifications in the rear panel description of the P80. 

http://www.pixelhue.com/
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 Added a description of embedded audio for the input and 
output connectors of the P80. 

 Updated the description for the Dante connectors of the 
P80. 

 Updated the front and rear panel diagrams. (Q8) 

 Updated the LCD home screen diagram and added 
descriptions related to front panel status. (Q8) 

 Added descriptions of file management for the smart 
touchscreen. (U5 series) 

 Updated the PixelFlow software function descriptions. 

V1.7.2 2025-10-15 Updated the Q8_8xHDMI2.0+12G-SDI Input Card 
specifications. 

V1.7.1 2025-09-25  EDID supports reduced blanking settings. (P10/P20/P20-
DS/P80) 

 EDID supports audio settings. (P20-DS/Q8) 

 Added descriptions related to Mac mosaic. 

 Add descriptions related to OPT port transmission mode 
settings. (P10/P20/P20-DS) 

 Added the Q8_8xHDMI2.0+12G-SDI Input Card. 

 Updated the PixelFlow software function descriptions. 

V1.7.0 2025-08-22  Added a new model: P80 

 Updated the PixelFlow software function descriptions. 

 Updated the Q8 front panel diagram. 

 Added the touchscreen calibration description for the 
U5/U5 Pro. 

 Updated the U5/U5 Pro function descriptions. 

V1.6.0 2025-04-15  Added a new model, P20-DS, and updated its related 
descriptions. 

 Added descriptions for Dante audio networking. (P20-
DS/Q8) 

 Added descriptions for connector groups. (P20-DS/Q8) 

 Added antistatic settings. (P10/P20/P20-DS/Q8) 

 Added support for 4x MAIN layers and 4x PIP layers. 
(P20/P20-DS) 

 Updated the operations in synchronization signal source, 
input backup settings and mode. (P10/P20/P20-DS) 

 Updated interlaced signal descriptions. (P10/P20/P20-
DS/Q8) 

 Added the maximum output resolution of the AUX 
connectors. (P10/P20/P20-DS) 

 Added the front LCD lock feature. (Q8) 

 Added the 3D feature. (Q8) 

 Added the Q8_HDMI2.0x4+DP1.2x4+SFPx8 Output Card. 

 Updated the application diagram for the Q8. 

 Changed the maximum pixel height of the DP 1.2 and 
HDMI 2.0 connectors. (P10/P20/P20-DS/Q8) 
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 Updated the PixelFlow software function descriptions, 
including switching layer specifications, synchronization 
settings, input backup settings, Multiviewer HDCP 
function, audio matrix function and property settings, 3D 
function, layer shortcuts, and more. 

V1.5.0 2024-10-25  Updated the P20/P10 hardware introduction and menu 
operations. 

 Updated the PixelFlow software descriptions and added 
the Companion plugin support. 

 Updated the hardware introduction and added the fan 
mode and plugin menu operations for the Q8. 

V1.4.2 2024-08-15  Updated the typography and cross references. 

 Updated the Q8+U5/U5 Pro+PixelFlow solution diagram. 

V1.4.1 2024-07-31  Added the key customization feature for the U5/U5 Pro. 

 Added the simulation event controller feature for 
PixelFlow. 

Symbols and Pictures 

Symbol Overview 

 Danger Indicates a hazard with a high level of risk, which if not 
avoided, will result in death or serious injury. 

 Warning Indicates a hazard with a medium or low level of risk, which if 
not avoided, could result in minor or moderate injury. 

 Caution Indicates a potentially hazardous situation, which if not 
avoided, could result in equipment damage, data loss, 
performance degradation, or unexpected results. 

 
Note Provides additional information to emphasize or supplement 

important points of the main text. 

Picture Overview 

Images and pictures given in this manual are used for illustration purposes only. The 
actual product may vary due to product enhancement. The content of the images can 
be slightly different from reality, such as device types, installed modules, form and 
position of software windows on the screen. 



All-New Event Presentation Switching Solutions 

User Manual 2 Safety 

 

www.pixelhue.com 5 
 

2 Safety 

Overview 

 General Considerations 

 Device Carrying 

 Device Mounting 

 Cable Requirements 

 Electrical Safety 

 Unpacking and Inspection 

 Device Labels 

 Notes and Cautions 
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General Considerations 
To ensure that you can use this product correctly and safely, please be sure to 
observe the following precautions: 

 Before performing any operation, make sure that you have read all the operating 
instructions provided by the device, especially the instructions that may endanger 
the personal safety and device safety, such as dangers, warnings and cautions, to 
minimize the probability of accidents. 

 All the operations must conform to local safety codes. When the safety and 
precautionary measures described in this manual conflict with local safety codes, 
please follow the local codes. 

 The personnel responsible for installing and maintaining the device must be 
professionals who have been trained and have mastered the correct operation 
methods and all safety precautions. Only trained and qualified personnel can 
perform device installation and maintenance. 

 This device must be used in an environment that meets the design specifications; 
otherwise, it may cause device failure. The resulting device function abnormalities 
or component damage, personal safety accidents, property losses and other 
situations are not included within the scope of the device warranty. 

General Safety 

 When operating the device, you must strictly abide by the local laws and 
regulations. The safety precautions described in this manual are only a 
supplement to the local safety laws and regulations. 

 The "Danger", "Warning" and "Caution" items described in this manual are only 
supplementary instructions for all safety precautions. 

 To ensure personal and device safety, please strictly follow all the safety 
precautions on the device labels and described in this manual when installing the 
device. 

Environmental Requirements 

 Ensure adequate air flow in the equipment room. 

 Take necessary measures to prevent dust, water and static electricity. 

 Avoid long-term direct sunlight. 

 Keep the device away from heat and ignition sources. 

 Do not place the device in an explosive atmosphere. 

 Do not place the device in a corrosive environment. 

 Do not place the device in a strong electromagnetic environment. 

Device Safety 

 Before operating, fix the device on the floor or other stable objects, such as a wall 
or mounting bracket. 
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 During transportation and use of the device and its packaging, the device must be 
fixed stably to avoid falling. 

 Do not step on, hit and violently operate the device and its packaging to prevent 
damage to the device or packaging box. 

 Do not block the ventilation openings during operation. 

 Tighten the board or card screws with a tool. 

 After the installation, remove the empty packing materials from the device area. 

 Save the packing box and materials for possible storage and transportation in the 
future. 

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Avoid dropping any object into the chassis. 

 Keep the device away from conductors that are easy to induce lightning to avoid 
lightning strikes to the device. 

 Do not make the circuit faces of the boards or cards contact each other. 

 Do not touch the circuit, components, connectors or wiring slots of the boards or 
cards with bare hands. 

 Do not repair the device without authorization. Only trained professionals can 
maintain the device. You can contact PIXELHUE at any time if needed. 

 Always use the spare parts recommended by PIXELHUE. 

 Regularly clean the dust on the heat dissipation holes to prevent the dust from 
blocking the holes and thus affect the heat dissipation of the device. 

Personal Safety 

 Place the device in a stable location to prevent personal injury caused by falling. 

 Avoid bare wires and maintain or replace them in time when they are damaged. 

 Do not operate the device and connect cables outdoors under thunderstorms. 

 Do not wear watches, rings, or other metal jewelry when installing spare parts or 
maintaining the device. 

Device Carrying 
 Do not relocate a powered device, and do not take any objects that may cause 

danger to the relocation. 

 Always pay attention to the wheels at the bottom of the flight case during 
transportation to avoid them being jammed by stones or deformed due to external 
forces. 

 Always hold the handles of the flight case firmly when pushing a flight case with 
wheels. Do not stack other devices on the flight case. 

 The relocated device should be repacked in the original factory packaging. 

 Do not disassemble the components during the transportation of the flight case. 
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 When handling or placing the boards or cards, bare board components or 
modules, always package them individually. 

 When carrying the device with your bare hands, always wear protective gloves to 
avoid injury. 

 When carrying the device, handle it gently and always hold the handles of the 
device or drag the bottom edge of the device. Do not hold the handles of a device 
component. 

 When the device weight exceeds the carrying limit of a single person, carry it with 
multiple people or use a carrying tool. 

 When using a forklift or handcart for transportation, place the device stably to 
ensure the device will not tip over. 

The following table lists the maximum weights that adults can carry at a time 
specified by some organizations for your reference. 

Organization Weight 

CEN (European Committee for Standardization) 25 kg/55.13 lb 

ISO (International Organization for Standardization) 25 kg/55.13 lb 

NIOSH (National Institute for Occupational Safety and Health) 23 kg/50.72 lb 

HSE (Health and Safety Executive) 25 kg/55.13 lb 

General Administration of Quality Supervision, Inspection and 
Quarantine of the People’s Republic of China  

Male: 15 kg/33.08 lb 

Female: 10 kg/22.05 lb 

Device Mounting 
When the device is installed on a desktop, the desktop must bear at least 4 times the 
device weight. 

Mounting on a Desktop 

 Ensure the stability and grounding of the desktop or working table. 

 Ensure that the device is placed horizontally and do not turn it over or hang it on 
the wall. 

 Do not place other objects on the device. 

 Do not put water cups, beverages and other containers with liquid close to or on 
the device to avoid liquid leakage and thus cause safety hazards. 

 If any object or liquid accidentally enters the device, stop using the device and 
disconnect the power cord and all cables connected to the device immediately, 
and then contact the after-sales personnel. 

 When handling a flight case with wheels, please lock and fix the wheels to prevent 
the device from sliding. 

 When stacking, ensure all the devices are stacked stably to avoid device damage 
and personal injury caused by falling.  
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Grounding 

 Connect the grounding wire first when installing a device, and disconnect the 
grounding wire at last when removing the device. 

 The connecting surface of the grounding wire and the device must have good 
conductivity. Spray painting is strictly prohibited, and there must be sufficient 
fastening force between the connecting parts. 

 Do not operate the device when the grounding conductor is not installed. 

 There must be no joints in the middle of the grounding wire, and it is strictly 
prohibited to install a switch or fuse on the grounding wire. 

 For devices using a three-pin socket, ensure that the ground terminal in the three-
pin socket is well grounded. 

Cable Requirements 

Power Cords 

 Warning 

Do not install or remove the power cord when the device is powered on. When the 
power cord core contacts the conductor, an electric arc or spark will be generated 
which may result in fire or eye injury.  

 Protect the power cord properly to prevent it from being punctured to avoid 
personal injury or fire caused by a short circuit. 

 To ensure the safety of the device and personnel, be sure to use the matched 
power cord. 

 User-supplied cables must comply with local cable regulations and device cable 
requirements. 

 Before installing or removing the power cord, turn off the device power first. 

 Check the electrical plug regularly and wipe off the dirt or dust accumulated on 
the plug. 

 Before connecting the power cord, read the labels or markings on the power cord 
to make sure it is a matched one. 

The device is intended to operate from an AC power source with a voltage range of 
AC 100–240V~, 50/60Hz. Various standard plugs are shown in the figure below. 

US NEMA5/15 Europe CEE 7 China GB 2099 UK BS 1363 

    

E Earth   N Neutral   L Live 
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Signal Cables 

 Before using a DVI signal cable, check whether the pins on the cable connector 
are vertical and even. If not, please replace the cable. 

 Before connecting the signal cable to the device, check whether there is any 
object in the device connector. If yes, remove the object first. 

 If the signal cable has not been used for a long time, discharge static electricity 
before using it. 

 Under normal working conditions of the device, it is recommended that non-
technical professionals do not perform hot-swapping to avoid device damage. 

Miscellaneous 

 Signal cables must be bound separately from strong current cables or high 
voltage cables. 

 When the temperature is too low, severe shock and vibration may cause brittle 
cracking of the plastic sheath of the cable. All cables should be laid and installed 
when the temperature is above zero. 

 If the storage temperature of the cable is below zero, the cable must be moved to 
room temperature and stored for more than 24 hours before laying and 
installation. 

 When carrying cables, especially in a low-temperature environment, always handle 
the cable with care. Violent handling, such as pushing down the cables directly 
from a high place, is prohibited. 

Electrical Safety 

Battery 

 The battery is not intended to be replaced. 

 Always follow the relevant instructions to dispose of batteries. 

 Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of 
a battery can result in an explosion. 

 Leaving a battery in an extremely high temperature surrounding environment can 
result in an explosion or the leakage of flammable liquid or gas. 

 A battery subjected to extremely low air pressure may result in an explosion or the 
leakage of flammable liquid or gas. 

Electromagnetic Interference 

 Keep the device away from transformers, high-voltage power lines and high-
current devices. 

 Keep the device away from high-power broadcast transmitters. 

 If there is a mobile communication transmitter around the device, its interference 
degree should meet the requirements of relevant standards. If needed, take 
necessary measures to prevent interference, such as shielding and isolation. 
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 When using hand-held wireless communication devices, such as interphones, 
keep at least 30 cm away from the device. 

Anti-Static 

 Always wear anti-static wrist bands and insulating gloves when touching the 
static-sensitive components. 

 Always hold the board by the edges to avoid touching the circuits or components, 
and do not touch the chip with your hands. 

 The disassembled board must be packaged with anti-static packaging material 
before storage or transportation. 

Unpacking and Inspection 

Unpacking 

 After receiving the device, check whether the packing box is damaged. If there is 
any damage, do not open the box and contact the carrier in time to confirm the 
damage to the device and matters related to compensation. 

 After unpacking, save the packing box and materials for possible storage and 
transportation in the future. 

Inspection 

 When the packing box is in perfect condition, unpack the box. Check the 
appearance of the device for damage. If there is damage, please contact the 
salesperson. 

 Check the box contents according to the packing list described in the certificate of 
approval. If any item is missing, please contact the salesperson in time. 

Device Labels 

Labels Description 

 

Warranty void if removed 

Do not open the chassis. If this label is damaged, the device 
will not be covered by the warranty. 

  

 

Grounding 

The two ends of the grounding wire are connected to the 
device and the grounding point respectively, which means 
that the device must be grounded through the grounding 
point to ensure the normal operation of the device and the 
personal safety of the operators. 

 

Sensitive electronic device 

Keep the device away from areas with strong 
electromagnetic radiation to avoid electromagnetic 
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Labels Description 

interference and thus affect the image output quality. 

 

Device carrying 

The device needs to be carried by multiple people. 

 

Removing cards 

Remove cards before taking out the motherboard. 

Notes and Cautions 

FCC Caution 

Any changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.  

This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense. 

Others 

 This is Class A product. In a domestic environment, this product may cause radio 
interference in which case the user may be required to take adequate measures. 

 This product can only be placed horizontally. Do not mount vertically or upside-
down. 

 Please read the specifications thoroughly and use the product in accordance with 
the requirements. If you have any questions about the specifications, please 
contact us immediately. If you use the product improperly, not following the 
requirements, or for illegal purposes, you shall be solely responsible for any 
consequences arising therefrom. 

 If the product does not have the relevant certifications required by the countries or 
regions where it is to be sold, please contact PIXELHUE to confirm or address the 
problem. Otherwise, the customer shall be responsible for the legal risks caused 
or PIXELHUE has the right to claim compensation. 
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3 Terms and Definitions 

PVW PVW is an abbreviation for Preview. The PVW area displays the pre-
editing content before it is sent to PGM. 

PGM PGM is an abbreviation for Program. The PGM area displays the real-
time output image. 

Take Take is an action of sending the PVW content to PGM with a transition 
effect. 

Cut Cut is an action of sending the PVW content to PGM directly, without 
any transition effect. 

FTB FTB (Fade to Black) is an action of making the screen fade to black. 

T-Bar T-bar is a lever that manually controls the progress of sending PVW to 
PGM. 

LOGO LOGO is a special layer with the highest priority and is displayed in 
front of all other layers. LOGO consumes no processing resources and 
displays an unscaled image on the screen. 

BKG BKG is an abbreviation for background. BKG is a special layer that has 
the lowest priority and is displayed beneath all other layers. BKG 
consumes no processing resources and fills the whole screen. 

MVR MVR is an abbreviation for Multiviewer. An MVR connector is used to 
connect a confidence monitor for displaying the specific input or 
output content, such as the presenter's laptop. 

AUX AUX is an abbreviation for auxiliary. An AUX connector is used to 
output the input source, PVW or PGM, to a specified monitor, such as 
a teleprompter. 

AOI AOI is an acronym for Area of Interesting. AOI allows users to view a 
specific output area they are interested in. 

Aspect Ratio Aspect ratio is the ratio of a layer/image width to its height. It is 
commonly expressed as two numbers separated by a colon, as in 16:9. 

Contrast  Contrast defines the difference between the darkest and brightest 
areas of an image displayed on the screen. The greater this value is, 
the bigger this difference will be. 

Gamma Gamma defines the degree of distortion of the image color. The 
greater this value is, the more distorted the color will be. 
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Hue Hue defines the gradation or variety of the image color. The greater 
this value is, the more intense the color will be. 

Saturation Saturation defines the purity or vividness of the image color. The 
greater this value is, the purer the color will be. 

Color Space Color space is a mathematical model that maps the colors that can be 
reproduced by a device to a standard color model, usually the RGB 
model. 

Bit Depth Bit depth refers to the color information stored in an image. The higher 
the bit depth of an image, the more colors it can store. 

Frame Rate Frame rate (expressed in frames per second, or FPS) is the frequency 
(rate) at which consecutive images called frames to appear on a 
display. Frame rate may also be called the frame frequency, and be 
expressed in hertz. 

DSK DSK (Downstream Keying) is an effect allowing one video signal to be 
keyed on top of another video signal. The lightest portions of the DSK 
signal replace the source video leaving the dark areas showing the 
original video image. 

Luma Key Luma key refers to a process to composite a foreground clip over a 
background clip based on the luma levels in a video or image. This is 
most often useful for still images, such as a picture of a logo over a 
black background. 

Chroma Key Chroma key refers to a process that a specific color is removed from 
an image, allowing that portion of the image to be replaced. This color 
can be any solid color, most commonly blue or green. 

HDCP HDCP stands for High-Bandwidth Digital Content Protection, a copy 
protection scheme to eliminate the possibility of intercepting digital 
data midstream between the source and the display. HDCP 1.4 is 
designed for full HD content, while HDCP 2.2 relates to ultra HD 4K 
media. 
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4 Overview  

About This Chapter 

This chapter is designed to introduce you to PIXELHUE event presentation switching 
solution. 

Overview 

 Solution Overview 

 Control Overview 

 Initial Inspection
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Solution Overview 
The event presentation switching solutions include two parts basically: seamless 
switchers and event controllers/PixelFlow (PC). The solutions are specifically 
designed for easy management of multi-display for small/medium/large-sized events 
or visual management systems. 

P80+U5/U5 Pro+PixelFlow 

The P80 can work with the U5 or U5 Pro event controller. The following takes the U5 
as an example for illustration. 

 P80+U5+PixelFlow 

In copy mode, one of the connectors within a group copies the other’s output content 
and the output resolution is up to 4K. In split mode, both connectors within a group 
collaborate to output content and the output resolution of each connector is half of 
the content resolution. The output resolution per connector is up to DL. 
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P20/P20-DS+U5/U5 Pro+PixelFlow 

The P20/P20-DS can work with the U5 or U5 Pro event controller. The following takes 
the U5 as an example for illustration. 

 Switcher mode (P20/P20-DS+U5+PixelFlow) 

When the output capacity is 4K, two output connectors work as primary and the other 
six work as backup. When the output capacity is DL, four output connectors work as 
primary and the other four work as backup. 

 

 PGM only mode (P20/P20-DS+U5+PixelFlow) 

When the output capacity is 4K, four output connectors work as primary and the 
other four work as backup. When the output capacity is DL, four output connectors 
work as primary and the other four work as backup. 

 

P10+U5/U5 Pro+PixelFlow 

The P10 can work with the U5 or U5 Pro event controller. The following takes the U5 
as an example for illustration. 
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 Switcher mode (P10+U5+PixelFlow) 

When the output capacity is 4K, one HDMI 2.0 connector works as primary and the 
other works as backup. When the output capacity is SL, four output connectors work 
as primary and the other four work as backup. SL output capacity is used as an 
example for illustration of projection 

 

 

 PGM only mode (P10+U5+PixelFlow) 

When the output capacity is 4K, two HDMI 2.0 connectors are used for 4K output. 
When the output capacity is SL, eight connectors are used for 2K output. 4K output is 
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used as an example for illustration of projection
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Q8+U5/U5 Pro+PixelFlow 

 Q8+U5/U5 Pro+PixelFlow 

 

P80 

The P80 is PIXELHUE's new presentation switcher featuring versatile 4K connectivity 
including HDMI 2.0, DP 1.2 and 12G-SDI. With 12x fixed concurrent 4K inputs and a 
swappable input card that supports P_HDMI2.0_DP1.2_OPT Link Card, 
Q8_HDMI2.0+DP1.2+12G-SDI Input Card, and Q8_8xHDMI2.0+12G-SDI Input Card, it 
delivers exceptional input flexibility. The P80 comes with 8x HDMI 2.0 main output 
connectors allowing for up to 4x 4K concurrent main outputs (copy mode) or 8x DL 
concurrent main outputs (split mode). It also supports 4x 4K flex outputs, 4x 12G-SDI 
matrix outputs, and 2x dedicated Multiviewer outputs. Additionally, 8x 10G SFP 
optical ports are offered to copy the HDMI 2.0 outputs, enabling long-distance 4K 
signal transmission without fiber converters. The P80 supports up to 8x 4K mixing 
main layers and 4x 4K mixing PIP layers. Up to 256 presets and 256 layer presets can 
be saved for easy recall. This powerful multi-screen and multi-layer presentation 
switcher is ideal for medium to large-scale live events such as summit meetings, 
annual meetings, launch events, concerts, music festivals and exhibitions, and 
permanent video wall installations in hotels, shopping malls, airports, etc. 
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P20/P20-DS/P10 

The P20, P20-DS and P10 are PIXELHUE's all-new 4K seamless switchers fully 
featured in a compact form factor. Featuring high-quality 4K processing, the P20, 
P20-DS and P10 switchers are designed with a wide variety of 4K connectors, 
including HDMI 2.0, DP 1.2, and 12G-SDI.The P20, P20-DS and P10 can work in 
switcher mode or PGM only mode. In switcher mode, a single P20/P20-DS supports 
up to two 4K×2K@60Hz outputs and a single P10 supports one 4K×2K@60Hz output. 
In PGM only mode, the output resolution per P20/P20-DS is up to 8K×4K@60Hz and 
P10 is up to 8K×2K@60Hz. Additionally, the P20, P20-DS and P10 come with 
dedicated AUX outputs connecting to auxiliary devices such as teleprompters, and a 
dedicated Multiviewer output is provided for live view of all the inputs and outputs 
from one display. High-performance image deinterlacing is supported. 

Q8 

PIXELHUE's Q8 is a seamless switcher that operates at a full 4K standard and 
supports 8K video processing. It adopts a modular design with a plug-in structure 
and allows users to flexibly configure input and output cards according to their 
needs, accommodating various live video inputs with stable performance. Working 
with the professional intelligent management software PixelFlow and the event 
controller U5 or U5 Pro, it can easily achieve a wide array of visual effects. Thank to 
that, the Q8 can be employed in various settings, including stage performances, high-
end auto shows, business conferences, television production, product launches, and 
large exhibitions. 

The Q8 is built on a powerful hardware FPGA system architecture with a modular 
design, combining the stability and efficiency of a purely hardware-based approach 
with flexible input and output card configurations. It supports full 4K ultra-high-
definition video inputs and outputs, multi-screen and multi-layer management, 
irregular screen loading, edge blending, input EDID management and output timing 
management, as well as image monitoring and input view. This provides a rich visual 
construction experience. 

Event Controller U5/U5 Pro 

The U5 is a brand new compact-sized event controller and the U5 Pro is a flagship, 
large-scale event controller developed by PIXELHUE. Compared to their 
predecessors, they feature more innovative design highlights and more convenient, 
powerful and friendly operation and control over multiple different devices in the 
field, which will further facilitate your events today, such as corporate conferences, 
interactive live events or shows, music tours, immersive art exhibitions, and more. 

Control Overview 
The P80, P20, P20-DS, P10 and Q8 are exceptionally easy to operate. Various control 
options are supported: 

 Front panel buttons and graphical LCD 

 Event management software PixelFlow 

 Event controller U5/U5 Pro 
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 Third-party control system Stream Deck (Companion integrated into the seamless 
switcher) 

Front Panel 

The front panel of the P80 comes with a 7-inch graphical touchscreen allowing for 
basic device configuration from the touchscreen. The front panels of the P20, P20-DS 
and P10 come with a 5-inch graphical LCD, a knob and a variety of function buttons 
that allow for menu operations by pressing buttons. A USB port is provided on the 
front panel for updating device firmware, import and export files. For more 
information about the P80, P20, P20-DS and P10 front panels, please refer to 5 
Hardware Introduction. 

The front panel of the Q8 comes with a 7-inch graphical touchscreen that allows for 
menu operations. A USB port is provided on the front panel for cascading a second 
Q8 device. For more information about the Q8 front panels, please refer to 5 
Hardware Introduction. 

PixelFlow 

The event management software PixelFlow allows you to manage and control the 
seamless switchers uniformly. The software consists of several menus and tabs that 
allow you to configure the devices, inputs, outputs, screens and layers, as well as 
manage the presets and Multiviewer. 

Event Controller U5/U5 Pro 

With the design concept of increasing operational efficiency and satisfying the 
various changing needs that may arise from event scenarios, the U5/U5 Pro event 
controllers come with all the crucial functionalities that you may need. Convenient 
control over multiple seamless switchers and media servers greatly simplifies your 
on-site deployment and brings more convenience and ease to your events. 

Stream Deck 

The Q8, P10, P20, P20-DS, and P80 support control through a third-party device 
(Stream Deck). Stream Deck control enhances productivity and streamlining of tasks 
by providing easy access to shortcuts, commands, and actions with just a press of a 
button. For detailed operations, see 9 Companion Configuration. 

Initial Inspection  

General 

Before shipment, the devices were inspected and found to be free of mechanical and 
electrical defects. As soon as the devices are unpacked, inspect for any damage that 
may have occurred in transit, and make sure there are no broken parts and the unit is 
free of dents. Save all packing material until the inspection is completed. If any 
damage is found, please contact PIXELHUE or your local distributor immediately. 

After unpacking, please always place the device on a stable, flat and insulated 
support for handling or using. 
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Unpacking 

After the unpacking, it is recommended you check carefully to see whether all 
accessories are included according to the provided packing list. 
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5 Hardware Introduction 

About This Chapter 

This chapter is designed to introduce you to the hardware configuration of the 
seamless switchers in detail. 

Overview 

 P80 Hardware Introduction 

− Front Panel 

− Rear Panel 

 P20/P20-DS Hardware Introduction 

− Front Panel 

− Rear Panel 

 P10 Hardware Introduction 

− Front Panel 

− Rear Panel 

 Q8 Hardware Introduction 

− Front Panel 

− Rear Panel 

 Note:  

All product pictures shown in this chapter are for illustration purposes only. Actual 
product may vary.  
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P80 Hardware Introduction 

Front Panel 

 

Name Description 

Power 
Button 

Press the button to power on/off the device. To power off the device, 
press the button and select OK from the confirmation dialog box 
displayed on the LCD screen. 

Button LED status: 

 Breathing: The power supply is connected. 

 Solid on: The device is powered on. 

USB 2.0 A USB 2.0 (Type A) port used to update the firmware, import and 
export files such as logs, projects and images, connect to Stream 
Deck, etc. 

LCD Screen  A 7-inch graphical touchscreen for displaying all the menus, 
submenus and messages 

 The device is configurable from the touchscreen. 
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Rear Panel 

 

No. Name Qty Description 

1 Fixed input connectors 

For an input that contains an HDMI 2.0 and a DP 1.2, only one can be 
selected as the input source at the same time. 

HDMI 2.0 8 Max 
resolution 

4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Dynamic 
range 

HDR10/HLG/SDR 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced 
signal 

Not supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

DP 1.2 4 Max 
resolution 

4096×2160@60Hz 10bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 
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No. Name Qty Description 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.3 compliant 

Interlaced 
signal 

Not supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

12G-SDI 4 Standard  Support for ST-2082 (12G), ST-2081 
(6G), ST-424 (3G), ST-292 (HD), and 
ST-259 (SD) video inputs 

 Compatible with SD-SDI, HD-SDI, 3G-
SDI and 6G-SDI 

Max 
resolution 

4096×2160@60Hz 10bit 4:2:2 

EDID 
management 

Not supported 

Interlaced 
signal 

Supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

2 Swappable input card:  

Currently, P_HDMI2.0_DP1.2_OPT Link Card, Q8_HDMI2.0+DP1.2+12G-SDI 
Input Card, and Q8_8xHDMI2.0+12G-SDI Input Card are supported. 

P_HDMI2.0_DP1.2_OPT Link Card 

For an input that contains an HDMI 2.0 and a DP 1.2, only one type of connector 
can be selected as the input source at the same time. 

HDMI 2.0 4 Max 
resolution 

4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Dynamic 
range 

HDR10/HLG/SDR 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 
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No. Name Qty Description 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced 
signal 

Not supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

DP 1.2 2 Max 
resolution 

4096×2160@60Hz 10bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.3 compliant 

Interlaced 
signal 

Not supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

OPT 
(100G) 

2 Link to another P80 device to share input sources. 

Q8_HDMI2.0+DP1.2+12G-SDI Input Card 

The 12G-SDI connectors are not available. 

HDMI 2.0 4 Max 
resolution 

4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Dynamic 
range 

HDR10/HLG/SDR 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced 
signal 

Supported 
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No. Name Qty Description 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

DP 1.2 4 Max 
resolution 

4096×2160@60Hz 10bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.3 compliant 

Interlaced 
signal 

Not supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

Q8_8xHDMI2.0+12G-SDI Input Card 

The 12G-SDI connectors are not available. 

HDMI 2.0 8 Max 
resolution 

4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Dynamic 
range 

HDR10/HLG/SDR 

Quantization 
range 

Full/Limited 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced 
signal 

Supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

3 Main output connectors 
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No. Name Qty Description 

HDMI 2.0 8 8x HDMI 2.0 connectors are divided into four groups: 

 Group 1: HDMI 1 and HDMI 2 

 Group 2: HDMI 3 and HDMI 4 

 Group 3: HDMI 5 and HDMI 6 

 Group 4: HDMI 7 and HDMI 8 

The two connectors within a group can work in copy 
mode or split mode.  

 In copy mode, one of the connectors within a group 
copies the other’s output content and the output 
resolution is up to 4K. 

− Group 1: HDMI 2 copies HDMI 1. 

− Group 2: HDMI 4 copies HDMI 3. 

− Group 3: HDMI 6 copies HDMI 5. 

− Group 4: HDMI 8 copies HDMI 7. 

 In split mode, both connectors within a group 
collaborate to output content and the output 
resolution of each connector is half of the content 
resolution. The output resolution per connector is up 
to DL. 

− Group 1: HDMI 1 outputs the left half and HDMI 2 
outputs the right half. 

− Group 2: HDMI 3 outputs the left half and HDMI 4 
outputs the right half. 

− Group 3: HDMI 5 outputs the left half and HDMI 6 
outputs the right half. 

− Group 4: HDMI 7 outputs the left half and HDMI 8 
outputs the right half. 

Max 
resolution 

4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Bit depth 8bit/10bit/12bit 

Sampling 4:4:4/4:2:2 

Color space YCbCr/RGB 

Dynamic 
range 

HDR10/HLG/SDR 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced Supported 
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No. Name Qty Description 

signal 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

OPT 8 10G SFP optical ports are offered to copy HDMI 2.0 
outputs. 

 Copy mode 

− OPT 1 copies the left half of the HDMI 1 output 
image. 

− OPT 2 copies the right half of the HDMI 1 output 
image. 

− OPT 3 copies the left half of the HDMI 3 output 
image. 

− OPT 4 copies the right half of the HDMI 3 output 
image. 

− OPT 5 copies the left half of the HDMI 5 output 
image. 

− OPT 6 copies the right half of the HDMI 5 output 
image. 

− OPT 7 copies the left half of the HDMI 7 output 
image. 

− OPT 8 copies the right half of the HDMI 7 output 
image. 

 Split mode 

− OPT 1 copies HDMI 1. 

− OPT 2 copies HDMI 2. 

− OPT 3 copies HDMI 3. 

− OPT 4 copies HDMI 4. 

− OPT 5 copies HDMI 5. 

− OPT 6 copies HDMI 6. 

− OPT 7 copies HDMI 7. 

− OPT 8 copies HDMI 8. 

Each port supports up to 4K output and the transmission 
distance is up to 10 km. 

4 Flex and matrix output connectors 

HDMI 2.0 4 Flex output connectors 

Max resolution 4096×2160@60Hz 8bit 4:4:4 

Max 
width/height 

Max width: 8192 pixels 
(8192×1080@60Hz) 

Max height: 7680 pixels 
(1080×7680@60Hz) 

Bit depth 8bit/10bit/12bit 

Sampling 4:4:4/4:2:2 

Color space YCbCr/RGB 
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No. Name Qty Description 

Dynamic range HDR10/HLG/SDR 

EDID 
management 

Support for standard resolutions up to 
8192×1080@60Hz 

Support for custom resolutions 

HDCP HDCP 2.2 and HDCP 1.4 compliant 

Interlaced 
signal 

Supported 

Embedded 
audio 

Support for 8-channel embedded audio 
(24bit/48kHz) 

12G-SDI 4  Matrix outputs of the input sources, Multiviewer, main 
outputs, and flex outputs. 

 Compatible with HD-SDI, 3G-SDI and 6G-SDI 

 No support for bit depth and color space settings 

 Support for 8-channel embedded audio (24bit/48kHz) 

5 Control connectors 

ETHERNE
T 

2  Gigabit Ethernet ports for device control and input 
view (transmission at 10fps) 

 One works as primary and the other as backup. 

MVR 2  HDMI 2.0 connectors for Multiviewer.  

 Two output modes are supported:  

 Copy mode: 1x 4K output and 1x copying output are 
supported. 

 Independent mode: 2x concurrent DL outputs are 
supported. 

 The output resolution and frame rate can be changed. 

 HDCP 2.2 and HDCP 1.4 compliant 

TYPE-C 1 USB 3.0 Type-C port for USB device connection (*to be 
implemented in future updates) 

USB 1 USB 3.0 Type-A port used to update the firmware, import 
and export files such as logs, projects and images, 
connect to Stream Deck, etc. 

Dante 2 Dual redundant Gigabit Ethernet ports for 48kHz 64x64 
Dante audio networking 

LTC IN 1 For timecode input (*to be implemented in future 
updates) 

GENLOCK 2 Genlock synchronization signal connectors, supporting 
tri-level sync for input and output 

 IN: Synchronization signal input 

 OUT: Synchronization signal output (with support for 
loop-through) 

6 Power connectors 



All-New Event Presentation Switching Solutions 

User Manual 5 Hardware Introduction 

 

www.pixelhue.com 33 
 

No. Name Qty Description 

100-
240V~, 
50/60Hz 

2  2x AC power connectors (100-240V, 50/60Hz) 

 One for primary power supply and the other as backup 

P20/P20-DS Hardware Introduction 

Front Panel 

The P20/P20-DS front panel is designed with a 5-inch graphical LCD, a knob and a 
variety of function buttons that allow for menu operations by button presses. A USB 
port is provided on the front panel for updating device firmware, import and export 
files. 

 P20/P20-DS front panel 

 

1 Chassis handles (L+R) 5 LCD screen 

2 Power button 6 Knob 

3 USB port 7 BACK button 

4 Source buttons 8 Layer and function buttons 

Chassis Handles 

Two handles are provided for easy installation and transportation. 

Power Button 

Press the button to turn on/off the device. To turn off the device, press the button 
and select OK from the dialog box displayed on the LCD screen to confirm your 
operation. 

 Breathing dim white: The power supply is connected. 

 Bright white: The device is turned on. 
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USB Port 

A Type-A USB 2.0 port is provided for updating device firmware, importing and 
exporting project files, EDID files, BKG files, LOGO files and logs via USB drive. 

Source Buttons 

Press a button to access the input settings menu or select the source. These buttons 
can also be used to enter numbers. 

Button LED color and source status (INPUT 1 to 14): 

 Dim white: No signal and not in use 

 Breathing blue: Signal accessed and not in use 

 Blue: Signal accessed and in use 

AUDIO: The audio function will be implemented in future updates. 

LCD Screen 

A 5-inch graphical LCD screen is designed for displaying all the menus, submenus 
and messages. 

After startup, the screen displays the home screen. For detailed information on the 
home screen, refer to 6.2 P20/P20-DS/P10 Menu Operations. 

Knob 

Rotate the knob to scroll up or down through the menus. 

 Rotate the knob clockwise to scroll down. 

 Rotate the knob counter-clockwise to scroll up. 

Press the knob to select menu items. 

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or 
unlock the front panel buttons. 

Back Button 

Press the BACK button to exit a menu without making changes, to cancel an 
operation, or to return to the home screen. Each press takes you back up the menu 
tree one level. 

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or 
unlock the front panel buttons. 

Layer and function buttons 

 LAYER 1 to 7: Press a button to open the layer and access the layer menu. Press 
and hold the button to close the layer. 

Button LED color and source status: 

− Dim white: The layer is closed. 

− Bright blue: The layer is open. 
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− Blinking blue: The layer is in edit mode. 

 PRESET: Press the button to access the preset settings menu. 

− Dim white: The preset settings menu is not displayed. 

− Blinking blue: The preset settings menu is displayed. 

 SCALE: Press the button to enable the full screen scaling of the layer at the back 
of the Z-order. 

− Blinking blue: Full screen scaling is enabled successfully. 

 BKG: Press the button to turn on BKG (there are pictures in the gallery). Press and 
hold the button to turn off BKG. 

Button LED color and source status: 

− Dim white: BKG is disabled. 

− Bright blue: BKG layer is enabled. 

 FN: This is a custom shortcut button and users can assign a function to the FN 
button. 

When Freeze, FTB (Fade to Black) or Genlock synchronization is assigned, press 
the button to enable or disable the assigned function. 

Button LED color and source status: 

− Dim white: The function is disabled. 

− Blue: The function is enabled. 

 When Capture is assigned, press the button to access the Capture menu. 

− Dim white: The Capture menu is displayed. 

− Blinking blue: Capturing… 

 TAKE: Press the button to switch content from PVW to PGM with a specified 
transition effect. 

− Dim white: Content is not switched. 

− Blinking blue: Content is being switched. 

Rear Panel 

The P20/P20-DS rear panel provides a variety of 4K I/O connectors including 12x 4K 
inputs (HDMI 2.0, DP1.2, 12G-SDI), 4x HDMI 2.0 outputs, 8x 10G optical fiber ports, 
and 4x 12G-SDI outputs (P20-DS). 
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 P20/P20-DS rear panel 

 

1 P_4K_12G SDI Audio-OPT Combo Card (P20) 

P_12G SDI_DANTE Audio-OPT Combo Card (P20-DS) 

2 Inputs 1 to 8 6 Control connectors 

3 Outputs 1 to 4 7 Power connector and switch 

4 Multiviewer output 8 LED work light 

5 AUX outputs 9 LED work light switch 

P_4K_12G SDI Audio-OPT Combo Card (P20) 

The P20 is designed with a P_4K_12G SDI Audio-OPT Combo Card which offers the 
following input and output connectors. 

 4x 12G-SDI IN & LOOP (INPUT 9 to 12) 

 8x optical fiber output ports (OPT) 

4K: 

Switcher mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 

− OPT 3 copies the left half of the output image of HDMI 1. 

− OPT 4 copies the right half of the output image of HDMI 1. 

− OPT 5 copies the left half of the output image of HDMI 5. 

− OPT 6 copies the right half of the output image of HDMI 5. 

− OPT 7 copies the left half of the output image of HDMI 5. 
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− OPT 8 copies the right half of the output image of HDMI 5. 

PGM only mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 

− OPT 3 copies the left half of the output image of HDMI 3. 

− OPT 4 copies the right half of the output image of HDMI 3. 

− OPT 5 copies the left half of the output image of HDMI 5. 

− OPT 6 copies the right half of the output image of HDMI 5. 

− OPT 7 copies the left half of the output image of HDMI 7. 

− OPT 8 copies the right half of the output image of HDMI 7. 

DL: 

Switcher and PGM only modes 

− OPT 1 copies HDMI 1. 

− OPT 2 copies HDMI 1. 

− OPT 3 copies HDMI 3. 

− OPT 4 copies HDMI 3. 

− OPT 5 copies HDMI 5. 

− OPT 6 copies HDMI 5. 

− OPT 7 copies HDMI 7. 

− OPT 8 copies HDMI 7. 

 4x 3.5 mm audio jacks (AUDIO) including 2x line in & 2x line out (The audio 
function will be implemented in future updates.) 

P_4K_12G SDI Audio-OPT Combo Card (P20-DS) 

The P20-DS is designed with a P_4K_12G SDI Audio-OPT Combo Card which offers 
the following input and output connectors. 

 4x 12G-SDI inputs (INPUT 9 to 12) 

 4x 12G-SDI outputs for copying HDMI outputs (OUTPUT) 

 8x optical fiber output ports (OPT) 

4K: 

Switcher mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 

− OPT 3 copies the left half of the output image of HDMI 1. 

− OPT 4 copies the right half of the output image of HDMI 1. 

− OPT 5 copies the left half of the output image of HDMI 5. 

− OPT 6 copies the right half of the output image of HDMI 5. 

− OPT 7 copies the left half of the output image of HDMI 5. 

− OPT 8 copies the right half of the output image of HDMI 5. 

PGM only mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 
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− OPT 3 copies the left half of the output image of HDMI 3. 

− OPT 4 copies the right half of the output image of HDMI 3. 

− OPT 5 copies the left half of the output image of HDMI 5. 

− OPT 6 copies the right half of the output image of HDMI 5. 

− OPT 7 copies the left half of the output image of HDMI 7. 

− OPT 8 copies the right half of the output image of HDMI 7. 

DL: 

Switcher and PGM only modes 

− OPT 1 copies HDMI 1. 

− OPT 2 copies HDMI 1. 

− OPT 3 copies HDMI 3. 

− OPT 4 copies HDMI 3. 

− OPT 5 copies HDMI 5. 

− OPT 6 copies HDMI 5. 

− OPT 7 copies HDMI 7. 

− OPT 8 copies HDMI 7. 

 4x 3.5 mm audio jacks (AUDIO) including 2x line in & 2x line out 

 2x Dante connectors for Dante audio networking 

− Dual redundancy Gigabit Ethernet ports (AES67 compliant) 

− Audio de-embedding/embedding on every input & output (raw audio) 

− De-embedded audio channels can be routed directly to the Dante network 

− Audio channels from external Dante audio processor can be re-embedded for 
sending to display, streaming or recording device 

− 32×32 Dante channels @48 kHz 

Inputs 1 to 8 

Each includes a DP 1.2/HDMI 2.0. When two connectors have signals, only one can 
be used as the input source at the same time. 

Outputs 1 to 4 

Each includes two HDMI 2.0: 

 4K 

− In switcher mode, connectors 1 and 5 work as primary. Connectors 2, 3 and 4 
copy connector 1, and connectors 6, 7 and 8 copy connector 5. The 
resolutions of connectors 1 and 5 can be set independently. 

− In PGM only mode, connectors 1, 3, 5 and 7 work as primary and connectors 
2, 4, 6 and 8 copy connectors 1, 3, 5 and 7, respectively. Connector 1 and 3 
are in the same group and connectors 5 and 7 are in the same group. 
Connectors in the same group have the same resolution. 

 DL 

− In both switcher and PGM only modes, connectors 1, 3, 5 and 7 work as 
primary and connectors 2, 4, 6 and 8 copy connectors 1, 3, 5 and 7, 
respectively. Connector 1 and 3 are in the same group and connectors 5 and 
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7 are in the same group. Connectors in the same group have the same 
resolution. 

The output connectors of the P20-DS are divided into four groups and each group 
include two HDMI 2.0 connectors, one 12G-SDI connector, and two OPT ports: 

 Group 1: HDMI 2.0 connectors 1 and 2, 12G-SDI connector 1, OPT ports 1 and 2 

 Group 2: HDMI 2.0 connectors 3 and 4, 12G-SDI connector 2, OPT ports 3 and 4 

 Group 3: HDMI 2.0 connectors 5 and 6, 12G-SDI connector 3, OPT ports 5 and 6 

 Group 4: HDMI 2.0 connectors 7 and 8, 12G-SDI connector 4, OPT ports 7 and 8 

Connectors within the same group copy the output of one another. When the 
HDMI 2.0 connector is set to a custom resolution, the 12G-SDI connector does not 
output. 

Multiviewer output 

The P20/P20-DS is designed with an HDMI 1.3 for Multiviewer output. A Multiviewer 
display can be connected, allowing for live monitoring of all the inputs and outputs 
from one display. The output resolution defaults to 1920×1080@60Hz and the frame 
rate can be changed. 

AUX Outputs 

The P20/P20-DS comes with four HDMI 1.3 for AUX outputs with support for 
interlaced video signal. Auxiliary devices such as teleprompters can be connected. 
The default output resolution is 1920×1080@60Hz and the maximum output 
resolution is 2048×1152@60Hz. 

Ethernet Ports 

 Two Ethernet ports are provided for control and live input view.  

 One works as primary and the other as backup.  

 They have the same function and share the same IP address.  

Genlock IN & LOOP 

Genlock synchronization signal connectors are provided. 

 GENLOCK IN: Synchronization signal input 

 GENLOCK LOOP: Synchronization signal loop output 

Power Connector and Switch 

 Power connector and rocker switch 

 100-240V~, 50/60Hz 

LED Work Lights and Switches 

At some event venues, the lights may be very dim. For users’ convenience, the 
P20/P20-DS is designed with two LED work lights to provide adequate light for 
rear panel operations. The LED work lights come with pushbutton switches (red) 
next to them. 
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Specifications of input and output video connections 

Inputs 

 DP 1.2 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 240 Hz 

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 1.3 compliant 

− No support for interlaced video signal 

− (P20-DS) Support for dual-channel embedded audio (24bit/48kHz) 

 HDMI 2.0 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 240 Hz 

− Support for HDR  

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 2.2 compliant and downward compatible 

− Support for interlaced video signal 

− (P20-DS) Support for dual-channel embedded audio (24bit/48kHz) 

 12G-SDI 

− Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD) 

− Maximum resolution: 4096×2160@60Hz 

− Maximum frame rate: 60 Hz 

− Support for interlaced video signal 

− (P20-DS) Support for dual-channel embedded audio (24bit/48kHz) 

Outputs 

 HDMI 2.0 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 120 Hz 

− Support for HDR  

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 2.2 compliant and downward compatible 

− Support for interlaced video signal 
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− (P20-DS) Support for dual-channel embedded audio (24bit/48kHz) 

 12G-SDI (P20-DS) 

− Copying HDMI outputs 

− Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI 

− Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD) 

− Maximum resolution: 4096×2160@60Hz 

− Support for interlaced video signal 

− Support for dual-channel embedded audio (24bit/48kHz) 

 

P10 Hardware Introduction 

Front Panel 

The P10 front panel is designed with a 5-inch LCD, a knob and a variety of function 
buttons that allow for menu operations by button presses. A USB port is provided on 
the front panel for updating device firmware, import and export files.  

 P10 front panel 

 

1 Chassis handles (L+R) 6 LCD screen 

2 Power button 7 Knob 

3 USB port 8 BACK button 

4 Source buttons 9 Function buttons 

5 Layer buttons   

Chassis Handles 

Two handles are provided for easy installation and transportation. 

Power Button 

Press the button to turn on/off the device. To turn off the device, press the button 
and select OK from the dialog box displayed on the LCD screen to confirm your 
operation.  
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 Breathing dim white: The power supply is connected. 

 Bright white: The device is turned on. 

USB Port 

A Type-A USB 2.0 port is provided for updating device firmware, importing and 
exporting project files, EDID files, BKG files, LOGO files and logs via USB drive. 

Source Buttons 

Press a button to access the input settings menu or select the source. These buttons 
can also be used to enter numbers. 

Button LED color and source status (INPUT 1 to 6): 

 Dim white: No signal and not in use 

 Breathing blue: Signal accessed and not in use 

 Blue: Signal accessed and in use 

Layer Buttons 

LAYER 1 to 6: Press a button to open the layer and access the layer menu. Press and 
hold the button to close the layer. 

Button LED color and source status: 

 Dim white: The layer is closed. 

 Bright blue: The layer is open. 

 Blinking blue: the layer is in edit mode. 

LCD Screen 

A 5-inch LCD screen is designed for displaying all the menus, submenus and 
messages. 

After startup, the screen displays the home screen. For detailed information on the 
home screen, see 6.2 P20/P20-DS/P10 Menu Operations. 

Knob 

Rotate the knob to scroll up or down through the menus. 

 Rotate the knob clockwise to scroll down. 

 Rotate the knob counter-clockwise to scroll up. 

Press the knob to select menu items. 

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or 
unlock the front panel buttons.  
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Back Button 

Press the BACK button to exit a menu without making changes, to cancel an 
operation, or to return to the home screen. Each press takes you back up the menu 
tree one level. 

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or 
unlock the front panel buttons. 

Function buttons 

 PRESET: Press the button to access the preset settings menu. 

− Dim white: The preset settings menu is not displayed. 

− Blinking blue: The preset settings menu is displayed. 

 SCALE: Press the button to enable the full screen scaling of the layer at the back 
of the Z-order. 

− Blinking blue: Full screen scaling is enabled successfully. 

 FN: This is a custom shortcut button and users can assign a function to the FN 
button. 

When Freeze, FTB (Fade to Black), or Genlock synchronization is assigned, press 
the button to enable the assigned function. 

Button LED color and source status: 

− Dim white: The function is disabled. 

− Blue: The function is enabled. 

When Capture is assigned, press the button to access the Capture menu. 

− Dim white: The Capture menu is displayed. 

− Blinking blue: Capturing… 

 TAKE: Press the button to switch content from PVW to PGM with a specified 
transition effect. 

− Dim white: Content is not switched. 

− Blinking blue: Content is being switched. 

Rear Panel 

The P10 rear panel provides a variety of I/O connectors including 6x 4K inputs (4x 
DP1.2/HDMI 2.0 and 2x 12G-SDI), 8x outputs (2x HDMI 2.0 and 6x HDMI 1.3), and 4x 
10G optical fiber ports. 
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 P10 rear panel 

 

1 Inputs 5 and 6 6 AUX outputs 

2 Inputs 1 to 4 7 Outputs 1 to 8 

3 OPT outputs 1 to 4 8 Control connectors 

4 Audio jacks 9 Power connector and switch 

5 Multiviewer output   

Inputs 5 and 6 

Two 12G-SDI IN & LOOP connectors are provided. 

Inputs 1 to 4 

Each includes a DP 1.2 and HDMI 2.0. When both have signals, only one can be used 
as the input source at the same time. 

OPT Outputs 1 to 4 

Four optical fiber ports are provided for copying the output of the HDMI connectors. 

4K: 

 Switcher mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 

− OPT 3 copies the left half of the output image of HDMI 1. 

− OPT 4 copies the right half of the output image of HDMI 1. 

 PGM only mode 

− OPT 1 copies the left half of the output image of HDMI 1. 

− OPT 2 copies the right half of the output image of HDMI 1. 

− OPT 3 copies the left half of the output image of HDMI 5. 

− OPT 4 copies the right half of the output image of HDMI 5. 

SL: 

 Switcher mode 



All-New Event Presentation Switching Solutions 

User Manual 5 Hardware Introduction 

 

www.pixelhue.com 45 
 

− OPT 1 copies HDMI 1 and HDMI 2. 

− OPT 2 copies HDMI 3 and HDMI 4. 

− OPT 3 copies HDMI 1 and HDMI 2. 

− OPT 4 copies HDMI 3 and HDMI 4. 

 PGM only mode 

− OPT 1 copies HDMI 1 and HDMI 2. 

− OPT 2 copies HDMI 3 and HDMI 4. 

− OPT 3 copies HDMI 5 and HDMI 6. 

− OPT 4 copies HDMI 7 and HDMI 8. 

Audio Jacks (The audio function will be implemented in future updates.) 

Four 3.5 mm dual-channel audio jacks are provided, including two line in jacks and 
two line out jacks. 

Multiviewer Output 

The P10 is designed with an HDMI 1.3 for Multiviewer output. A Multiviewer display 
can be connected, allowing for live monitoring of all the inputs and outputs from one 
display. The output resolution defaults to 1920×1080@60Hz and the frame rate can 
be changed. 

AUX Outputs 

The P10 comes with two HDMI 1.3 connectors for AUX outputs with support for 
interlaced video signal output. Auxiliary devices such as teleprompters can be 
connected. The default output resolution is 1920×1080@60Hz and the maximum 
output resolution is 2048×1152@60Hz. 

Outputs 1 to 8 

The P10 provides eight HDMI output connectors including two HDMI 2.0 and six 
HDMI 1.3. 

4K: 

 In switcher mode, connector 1 works as primary connector for 4K output and 
connector 5 copies connector 1. 

 In PGM only mode, connectors 1 and 5 can work as primary connectors and have 
the same resolution. 

SL: 

 In switcher mode, connectors 1 to 4 work as primary and connectors 5 to 8 copy 
connectors 1 to 4, respectively. Connectors 1, 2, 3 and 4 have the same resolution. 

 In PGM only mode, eight connectors work as primary. All the connectors have the 
same resolution. 

Control Connectors 

The P10 provides two Ethernet ports and a Genlock connector with loop-through. 
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Ethernet 

Two Ethernet ports are used for control and live input view (One works as primary 
and the other as backup. They share the same IP address.). 

Genlock IN & LOOP 

Genlock synchronization signal connectors are provided. 

 GENLOCK IN: Synchronization signal input 

 GENLOCK LOOP: Synchronization signal loop output 

Power Connector and Switch 

 Power connector: 100-240V~, 3.0-1.5A, 50/60Hz 

 Power switch: 

− ON: Power on 

− OFF: Power off 

 

Specifications of input and output video connections 

Inputs: 

 DP 1.2 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 240 Hz 

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 1.3 compliant 

− No support for interlaced video signal 

 HDMI 2.0 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 240 Hz 

− Support for HDR 

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 2.2 compliant and downward compatible 

− Support for interlaced video signal 

 12G-SDI 

− Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD) 

− Maximum resolution: 4096×2160@60Hz 

− Maximum frame rate: 60 Hz 

− Support for interlaced video signal 
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Outputs: 

 HDMI 2.0 

− Maximum resolution: 4096×2160@60Hz/8192×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 8192 pixels (8192×1080@60Hz) 

− Maximum height: 7680 pixels (1080×7680@60Hz) 

− Maximum frame rate: 240 Hz 

− Support for HDR 

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 2.2 compliant and downward compatible 

− Support for interlaced video signal 

 HDMI 1.3 

− Maximum resolution: 1920×1080@60Hz/2048×1080@60Hz 

− Minimum resolution: 800×600@60Hz 

− Maximum width: 2048 pixels (2048×1080@60Hz) 

− Maximum height: 2048 pixels (1080×2048@60Hz) 

− Maximum frame rate: 240 Hz 

− EDID management (support for standard resolutions and custom resolutions) 

− HDCP 2.2 compliant and downward compatible 

− Support for interlaced video signal 
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Q8 Hardware Introduction 

Front Panel 

 Q8 front panel 

 

No. Type Description 

1 Power button  Power on: Press the button to turn on the device. 

 Power off: Press the button, and a shutdown prompt 
window appears on the LCD screen. Tap Yes to shut 
down the device. 

2 LED strip Indicate the device running status. 

 Blue: The device is operating normally. The strip 
supports breathing and flashing effects. 

 Off: The device is either not powered or is 
malfunctioning. 

3 LCD screen Display the device status, menus, submenus and 
messages for parameter settings. 

4 USB 3.0 1x USB 3.0 (Type-A) port 

 Update device firmware via USB drive. 

 Export logs, and import and export projects. 

5 LINK port Link two Q8 units for cascading and control. 

 8x QSFP ports 

− They enable the sharing of input sources between 
two devices. 

− Each port can share up to two 4K input sources, 
allowing up to 16 4K input sources to be shared 
across all eight ports. 
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No. Type Description 

 1x LINK IN 

It accepts the synchronization control signal in 
scenarios where a single event controller or control 
software controls multiple switchers. 

 1x LINK OUT 

It loops the synchronization control signal in scenarios 
where a single event controller or control software 
controls multiple switchers. 

 1x OPT, 10 optical port (reversed) 

Note: 

The LINK IN and LINK OUT ports are designed to enable 
control cascading among switchers in scenarios where 
they are controlled by a single event controller or control 
software. In these scenarios, one switcher should be set 
as the master and the others as slaves. By connecting 
the LINK IN and LINK OUT ports among the switchers 
using Ethernet cables, control commands can be 
synchronized effectively. 

6 LINK port cover Cover the LINK ports. 

Rear Panel 

 Q8 rear panel 
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 Note 

 The picture above is the rear panel of the device when it is fully loaded. Users 
can configure input and output cards as needed. 

 The input and output cards do not support hot-swappable installation. The 
system must be powered off before installation, and only powered back on after 
the installation is complete. Additionally, input and output cards must be 
installed in ascending order based on their slot numbers, with no empty slots 
between adjacent cards. 

 The input and output cards are replaceable. Up to 6 input cards and 4 output 
cards can be installed.  

 

Table 5-1 Rear panel description 

Input Card 

Q8_HDMI2.0+DP1.2+
12G-SDI Input Card 

 

 8x 4K×2K@60Hz concurrent inputs per input card 

 Deinterlacing for up to 4 inputs per input card 

 Providing up to 4 sync sources per input card 

4x HDMI 2.0 

 Up to 4K×2K@60Hz 8bit 4:4:4, 4K×2K@60Hz 12bit 4:2:2, or 
4K×2K@60Hz 12bit 4:2:0 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:0, 4:2:2 and 4:4:4 inputs 

 Support for processing of Full and Limited range videos 

 Support for HDR and 3D inputs 

 HDCP 1.4 and HDCP 2.2 compliant 

 Support for deinterlacing processing 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

4x DP 1.2 

 Up to 4K×2K@60Hz 10bit 4:4:4 or 4K×2K@60Hz 12bit 4:2:2 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:2 and 4:4:4 inputs 

 Support for processing of Full and Limited range videos 

 Support for HDR and 3D inputs 

 HDCP 1.3 and HDCP 2.2 compliant 

 No support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 
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 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

4x 12G-SDI 

 Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-
292 (HD) and ST-259 (SD) standard video inputs 

 Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI 

 Support for interlaced video signal 

 No support for EDID management or bit depth settings 

 Support for 8-channel embedded audio (24bit/48kHz) 

Status LEDs 

Each input connector has a status LED which indicates source 
access status. 

 On: The source is accessed. 

 Off: The source is not accessed or it is abnormal. 

Q8_ST2110_4xSFP25
G Input Card_I 

 
 25G OPT for video source transmission, control, and 

synchronous clock input. 

 The video interface and control interface are combined into 
one. 

 Simultaneous input of primary and backup video sources, 
enabling seamless transition when necessary. 

4x 25G OPT 

 2 primaries and 2 backups per input card 

 Up to 4K×2K@60Hz 12bit 4:4:4 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:2 and 4:4:4 inputs 

 Standard: Support SMPTE ST 2110 (-10, -20) and SMPTE 
2059 (-1, -2). 

 Backup: Support the SMPTE 2022-7 standard. 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

 PixelFlow control: Support loading video stream 
configuration by SDP file or directly inputting. 

Support setting the resolution when managing ST 2110 
source in PixelFlow. 

− Support standard resolutions up to 4096×2160@60Hz. 

− Allow for custom input resolutions. 

 Color gamut: Rec.601/Rec.709/Rec.2020/DCI-P3 

 PTP settings: Support the IEEE 1588-2008 standard, 
enabling high-precision synchronization across different 
input sources when Lock Input to PTP is activated. 
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 IP address: IPv4 DHCP and static IP 

 Ethernet: 

− 25 GbE IEEE 802.3cc (25GBASE-LR) 

− 25 GbE IEEE 802.3by (25GBASE-SR) 

 Port configuration 

You can configure the port information through the 
following two methods: 

− Import the SDP file in PixelFlow for configuration. 

− Directly input the video stream configuration in 
PixelFlow: Video stream destination IP 
(primary/backup), port (primary/backup), video source 
IP (primary/backup), and video source details 
(resolution, frame rate, color/sample, bit depth) 

Q8_ST2110 
(100G)+HDMI2.1+DP
1.4 Input Card 

 
 100G OPT for video source transmission, control, and 

synchronous clock input. 

 The video interface and control interface are combined into 
one. 

 Simultaneous input of primary and backup video sources, 
enabling seamless transition when necessary. 

2x 100G OPT 

 1 primary and 1 backup per input card 

 Up to 4x 4K×2K@60Hz 12bit 4:4:4 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:2 and 4:4:4 inputs 

 Standard: Support SMPTE ST 2110 (-10, -20) and SMPTE 
2059 (-1, -2). 

 Backup: Support the SMPTE 2022-7 standard. 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

 PixelFlow control: Support loading video stream 
configuration by SDP file or directly inputting. Exporting SDP 
file is also supported. 

Support setting the resolution when managing ST 2110 
source in PixelFlow. 

− Support standard resolutions up to 4096×2160@60Hz. 

− Allow for custom input resolutions. 

 Color gamut: Rec.601/Rec.709/Rec.2020/DCI-P3 

 PTP settings: Support the IEEE 1588-2008 standard, 
enabling high-precision synchronization across different 
input sources when Lock Input to PTP is activated. 
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 FEC configuration: With parameters set at the card level, this 
feature can automatically detect and correct errors during 
data transmission, enhancing the reliability of video signal 
transfer. Support RS-FEC and NO-FEC encoding methods. 
This feature requires configuration on the switch before it 
can be used. 

 IP address: IPv4 DHCP and static IP 

 Multicast protocol: IGMPv3 

 Ethernet: 

− 100 GbE IEEE 802.3ba (100GBASE-LR) 

− 100 GbE IEEE 802.3ba (100GBASE-SR) 

− 100 GbE IEEE 802.3ba (100GBASE-CR) 

 Port configuration 

You can configure the port information through the 
following two methods: 

− Import the SDP file in PixelFlow for configuration. 

− Directly input the video stream configuration in 
PixelFlow: Video stream destination IP 
(primary/backup), port (primary/backup), video source 
IP (primary/backup), and video source details 
(resolution, frame rate, color/sample, bit depth) 

2x HDMI 2.1 

 One HDMI 2.1 and one DP 1.4 form a group, with only one 
usable at a time 

 Up to 8K×4K@30Hz 10bit 4:4:4 (Currently limited to 
4K×2K@60Hz 8bit 4:4:4) 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:0, 4:2:2 and 4:4:4 inputs 

 Support for processing of Full and Limited range videos 

 Support for HDR and 3D inputs 

 HDCP 1.4 and HDCP 2.3 compliant 

 Support for deinterlacing processing 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

2x DP 1.4 

 One HDMI 2.1 and one DP 1.4 form a group, with only one 
usable at a time 

 Up to 8K×4K@30Hz 10bit 4:4:4 (Currently limited to 
4K×2K@60Hz 10bit 4:4:4) 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:2 and 4:4:4 inputs 

 Support for processing of Full and Limited range videos 

 Support for HDR and 3D inputs 

 HDCP 1.3 and HDCP 2.3 compliant 
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 No support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

Status LEDs 

Each input connector has a status LED which indicates 
source access status. 

 On: The source is accessed. 

 Off: The source is not accessed or it is abnormal. 

Q8_8xHDMI2.0+12G-
SDI Input Card 

 

 8x 4K×2K@60Hz concurrent inputs per input card 

8x HDMI 2.0 

 Up to 4K×2K@60Hz 8bit 4:4:4, or 4K×2K@60Hz 10bit 4:2:2 

 Support for processing of 8-bit, 10-bit and 12-bit inputs 

 Support for 4:2:0, 4:2:2 and 4:4:4 inputs 

 Support for processing of Full and Limited range videos 

 Support for HDR inputs 

 HDCP 1.4 and HDCP 2.2 compliant 

 Support for deinterlacing processing 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

4x 12G-SDI 

 Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-
292 (HD) and ST-259 (SD) standard video inputs 

 Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI 

 Support for interlaced video signal 

 No support for EDID management or bit depth settings 

 Support for 8-channel embedded audio (24bit/48kHz) 

Status LEDs 

Each input connector has a status LED which indicates source 
access status. 

 On: The source is accessed. 

 Off: The source is not accessed or it is abnormal. 
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Output Card 

Q8_HDMI2.0+12G-
SDI+Fiber Output Card 

 

The 4x HDMI 2.0 and 4x 12G-SDI connectors are divided into 4 
groups. Each group includes 1x HDMI 2.0 and 1x 12G-SDI, and 
connectors within the same group copy each other's output. 
The 12G-SDI connector supports only standard resolutions 
under the protocol. When the HDMI 2.0 connector is set to a 
custom resolution, the 12G-SDI connector does not output. 

 Connector 1 (HDMI 2.0) and connector 5 (12G-SDI) form 
Group 1. 

 Connector 2 (HDMI 2.0) and connector 6 (12G-SDI) form 
Group 2. 

 Connector 3 (HDMI 2.0) and connector 7 (12G-SDI) form 
Group 3. 

 Connector 4 (HDMI 2.0) and connector 8 (12G-SDI) form 
Group 4. 

4x HDMI 2.0 

 Up to 4K×2K@60Hz 8bit 4:4:4, or 4K×2K@60Hz 12bit 4:2:2 
output 

 Support for 8-bit, 10-bit and 12-bit output settings 

 Support for 4:2:2 and 4:4:4 output settings 

 Support for YCbCr and RGB color space settings 

 Support for HDR outputs 

 Support for color gamut adjustment 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

4x 12G-SDI 

 Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

8x 10G OPT 

 Support for single-mode and multi-mode optical outputs 

 Transmission distance up to 10km in single mode 

 Support for 8-channel embedded audio (24bit/48kHz) 

 OPT ports copy outputs on video connectors 

− OPT 1 and OPT 2 copy the output from Group 1. 

− OPT 3 and OPT 4 copy the output from Group 2. 

− OPT 5 and OPT 6 copy the output from Group 3. 

− OPT 7 and OPT 8 copy the output from Group 4. 
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Status LEDs 

Each HDMI output connector has a status LED which indicates 
the connection status of backend device. The 12G-SDI and 
optical port do not have status LEDs. 

 On: The output connection is normal. 

 Off: The output connection is abnormal. 

Q8_HDMI2.0x4+ 

DP1.2x4+SFPx8 
Output Card 

 

The 4x HDMI 2.0 and 4x DP 1.2 connectors are divided into 4 
groups. Each group includes 1x HDMI 2.0 and 1x DP 1.2, and 
connectors within the same group copy each other's output. 

 Connector 1 (HDMI 2.0) and connector 5 (DP 1.2) form 
Group 1. 

 Connector 2 (HDMI 2.0) and connector 6 (DP 1.2) form 
Group 2.  

 Connector 3 (HDMI 2.0) and connector 7 (DP 1.2) form 
Group 3.  

 Connector 4 (HDMI 2.0) and connector 8 (DP 1.2) form 
Group 4.  

4x HDMI 2.0 

 Up to 4K×2K@60Hz 8bit 4:4:4 or 4K×2K@60Hz 12bit 4:2:2 
output 

 Support for 8-bit, 10-bit and 12-bit output settings 

 Support for 4:2:2 and 4:4:4 output settings 

 Support for YCbCr and RGB color space settings 

 Support for HDR outputs 

 Support for color gamut adjustment 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

4x DP 1.2 

 Up to 4K×2K@60Hz 10bit 4:4:4 or 4K×2K@60Hz 12bit 4:2:2 
output 

 Support for 8-bit, 10-bit and 12-bit output settings 

 Support for 4:2:2 and 4:4:4 output settings 

 Support for YCbCr and RGB color space settings 

 Support for 3D outputs 

 No support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 
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8x 10G OPT 

 Support for single-mode and multi-mode optical outputs 

 Transmission distance up to 10km in single mode 

 Support for 8-channel embedded audio (24bit/48kHz) 

 OPT ports copy outputs on video connectors 

− OPT 1 and OPT 2 copy the output from Group 1. 

− OPT 3 and OPT 4 copy the output from Group 2. 

− OPT 5 and OPT 6 copy the output from Group 3. 

− OPT 7 and OPT 8 copy the output from Group 4. 

Status LEDs 

Each HDMI and DP output connector has a status LED which 
indicates the connection status of backend device. The optical 
port does not have status LEDs. 

 On: The output connection is normal. 

 Off: The output connection is abnormal. 

Q8_1xST2110(100G)+
4x12G-SDI Output 
Card 

 
 100G OPT for video source transmission, control, and 

synchronous clock input. 

 Simultaneous input of primary and backup video sources, 
enabling seamless transition when necessary. 

 Support for edge blending, output rotation, 3D, virtual pixel 
configuration, and LCD bezel compensation. 

 No support for creating screens with other output cards or 
HDCP settings. 

2x 100G OPT 

 1 primary and 1 backup per output card 

 Up to 4x 4K×2K@60Hz 12bit 4:4:4 

 Support for processing of 8-bit, 10-bit and 12-bit outputs 

 Support for 4:2:2 and 4:4:4 outputs 

 No support for interlaced video signal 

 Standard: Support SMPTE ST 2110 (-10, -20) and SMPTE 
2059 (-1, -2). 

 Backup: Support the SMPTE 2022-7 standard. 

 Custom resolutions 

− Maximum width: 8192 pixels 

− Maximum height: 7680 pixels 

 PixelFlow control: Support loading video stream 
configuration by SDP file or directly inputting. Exporting SDP 
file is also supported. 

Support setting the resolution. 

− Support standard resolutions up to 4096×2160@60Hz or 
7680×1080@60Hz. 

− Allow for custom output resolutions. 
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 PTP settings: Support the IEEE 1588-2008 standard, 
enabling high-precision synchronization across different 
video streams when Lock to PTP is activated. 

 FEC configuration: With parameters set at the card level, this 
feature can automatically detect and correct errors during 
data transmission, enhancing the reliability of video signal 
transfer. Support RS-FEC and NO-FEC encoding methods. 
This feature requires configuration on the switch before it 
can be used. 

 IP address: IPv4 DHCP and static IP 

 Multicast protocol: IGMPv3 

 Ethernet: 

− 100 GbE IEEE 802.3ba (100GBASE-LR) 

− 100 GbE IEEE 802.3ba (100GBASE-SR) 

− 100 GbE IEEE 802.3ba (100GBASE-CR) 

 Port configuration 

You can configure the port information through the following 
two methods: 

− Import the SDP file in PixelFlow for configuration. 

− Directly input the video stream configuration in 
PixelFlow. 

4x 12G-SDI 

 These connectors copy the 4x 4K outputs of the 100G OPT 
ports 

 Up to 4K×2K@60Hz 10bit YCbCr 4:2:2 outputs 

 Support for YCbCr 4:2:2 output settings 

 Support for interlaced video signal 

 Support for 8-channel embedded audio (24bit/48kHz) 

 No support for standard or custom resolutions 

Status LEDs of 100G OPT 

 On: The output connection is normal. 

 Off: The output is not connected or it is abnormal. 

Control Card 

 

ETHERNET 

2x Neutrik Gigabit Ethernet ports 

 The two Ethernet ports work as a copy channel for each other. 

 Connect to the U5, U5 Pro or control computer. 

 Transmit the input view information to the control computer or U5/U5 Pro event 
controller. 

 Support control by central control command. 
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MVR 

2x HDMI 2.0 

Connect to the monitor to display the Multiviewer image in copy or independent 
mode. 

 In independent mode, the two HDMI connectors are used to display two different MVR 
images. 

 In copy mode, HDMI 2 copies the output on HDMI 1. 

USB 3.0 

1x USB 3.0 

 Export device logs. 

 Update the device and perform system repairs. 

AUDIO 

1x 3.5mm audio input, 1x 3.5mm audio output 

 IN for external audio input connection. 

 OUT for audio output. 

Dante 

2x digital network audio ports for audio input and output. 

 RJ45 port 

 Support network audio input and output. 

 Support 8-channel audio. 

 Support 64x64 audio swapping. 

GENLOCK 

1x GENLOCK IN, 1x GENLOCK LOOP 

Support Bi-Level and Tri-Level. 

 GENLOCK IN: Accept the external sync signal. 

 GENLOCK LOOP: Loop the sync signal. 

Power Connector 

Support 2 primary and 1 backup power supplies. Before powering on the device, connect 
at least two power supplies. 

Power specifications: 100-240V~, 50/60Hz, 10A-5A 
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6 Menu Operations  

About This Chapter 

This chapter introduces you to the system menus of the P80/P20/P20-DS/P10/Q8, 
including how the menus are accessed and the available functions and parameters. 
The menu pictures are presented throughout the chapter. 

Overview 

 P80 Menu Operations 

− Startup and Shutdown 

− Home Screen 

− Network Settings 

− Device Information 

− Advanced Settings 

− Language 

− About Us  

 P20/P20-DS/P10 Menu Operations 

− Startup and Shutdown 

− Home Screen 

− Input 

− Output 

− Screen 

− Layer 

− Transition 

− Preset 

− Multiviewer (MVR) 

− Network 

− Advanced 

− Mode 

− About Us 

− Language 

 Q8 Menu Operations 
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− Startup and Shutdown 

− Home Screen 

 Note:  

All menu pictures shown in this chapter are for illustration purposes only. Actual 
product may vary.  
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P80 Menu Operations 
The 7-inch touchscreen on the front panel of the P80 allows for pretty darn simple 
operations. The following sections will introduce the operations in detail. 

Startup and Shutdown 

To turn on the P80, connect all the necessary cables and power cords properly, and 
press the power button on the front panel. 

To turn off the P80, press the power button, and a shutdown prompt window appears 
on the LCD screen. Tap OK to shut down the device. 

Home Screen 

After the startup, the home screen is displayed. 

 Home screen 

 

Table 6-1 Home screen description 

No. Content Description 

1 Information 
bar 

 : Logo of PIXELHUE 

 P80: Device model 

 System1: Device name, which can be modified in PixelFlow 

 2025-11-11 10:03:26: System time 

 Front panel LCD lock status: 

− : Locked 

− : Unlocked 

 192.168.100.100: Device IP address, which can be modified 
on the device LCD or in PixelFlow.  
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No. Content Description 

 : Tap the button, and a shutdown prompt window appears 
on the LCD screen. Tap OK to shut down the device. 

2 Input 
connectors  

Show the input connector status. 

 Green: A source is connected to the connector and the source 
is normal. 

 White: No source is connected to the connector. 

 Gray: The connector is unavailable. 

 Blue: The source connected to the connector is unstable. 

 Orange: The source connected to the connector is abnormal. 

 Red: The connector is overloaded. 

3 Output 
connectors 

Show the output connector status. 

 Green: The connector is connected to a device. 

 White: The connector is not connected to a device. 

 Gray: The connector is unavailable. 

 Red: The connector is overloaded. 

 Orange border: Copy. 

4 Flex output 
connectors 

Show the flex output connector status. 

 Green: The connector is connected to a device. 

 White: The connector is not connected to a device. 

 Gray: The connector is unavailable. 

 Red: The connector is overloaded. 

 Orange border: Copy. 

5 Control 
connectors 

Show the control connector status. 

 Green: A device is connected and the connector is functioning 
normally. 

 Gray: No device is connected. 

 Red: The connector is overloaded. 

 Orange border: Copy. 

6 Power 
connector 

Show the power supply connection status. 

 Green: A power supply is connected. 

 White: No power supply is connected. 

7 Front panel 
USB port 

Show the front panel USB port status. 

 Green: A USB drive is connected and the connector is 
functioning normally. 

 Gray: No USB drive is connected. 

8 Voltage 
status 

Show the device working voltage status. 

 Normal: The voltage of each module in the device is normal. 

 Abnormal: The voltage of one or some modules in the device 
is abnormal, and the device needs troubleshooting. 

9 Temperature 
status 

Show the device working temperature status. 

 Normal: The temperature of each module in the device is 
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No. Content Description 

normal. 

 Abnormal: The temperature of one or some modules in the 
device is too high, and the device needs troubleshooting. 

10 Fan status Indicate whether the fan speed is normal when the device is 
working. 

 Normal: The speed of each fan in the device is normal. 

 Abnormal: The speed of one or more fans in the device is 
abnormal, and the device needs troubleshooting. 

11 Settings Tap to enter the device settings menu where you can do the 
following: 

 Network settings: Configure the device IP address. 

 Device information: Check the device’s chassis and card 
versions, and fan status. 

 Advanced settings: Perform factory reset settings, firmware 
update, project file import and export, log export, AC back 
settings, fan mode settings, time to return to home, antistatic 
settings, plugin update, lock screen. 

 Language: Set the user interface language. 

 About us: Check the firmware version of the device, contact 
email address and official website of PIXELHUE. 

On the home screen, swipe left to go to the Preset screen. The presets saved in 
PixelFlow or the event controller will be displayed. Tap a preset to load it to the PVW 
screen and tap TAKE or CUT to send it to the PGM screen. Users can tap +/- under 
Duration to set the effect duration. 

 Preset 

 

To go back to the home screen, swipe right on the Preset screen. 
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Network Settings 

 On the home screen, tap  located at the bottom right corner to enter the settings 
screen. 

 Select Network to enter the network settings screen. 

 Configure the device IP address information. 

 IP address settings 

 

The device supports both automatic (DHCP) and manual IP configuration. When the 
device is connected via router or switch, DHCP is recommended. The router or switch 
will automatically assign an IP address to the device. When the network mode is set 
to Manual, you need to set IP Address, Subnet Mask and Gateway. 

 Note 

When you manually set the IP address, the device IP address and the control 
computer IP address must be on the same network segment.  

 Tap Apply to complete the settings. 

Device Information 

On the Device screen, you can check the power voltage status, card temperature, 
version and serial number (SN), and fan running status of the device.  
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 Device information 

 

Two ways to enter the Device screen: 

 On the home screen, tap  located at the bottom right corner to enter the 
settings screen. Then, tap Device on the left. 

 On the home screen, tap the icon in the status bar on the right to enter the 
corresponding screen under Device. 

− : Displays the voltage status of the connected power supply. Tap this icon 
to enter the Voltage screen under Device, where you can check the 
connection status of the power supplies and whether the power connector 
voltage is normal. 

− : Displays the device card temperature. Tap this icon to enter the Cards 
screen under Device, where you can check the card temperature, version and 
SN. 

− : Displays whether the device fans are running normally. Tap this icon to 
enter the Fans screen under Device, where you can check the status of all the 
fans. 

Advanced Settings 

In advanced settings, you can do the following operations: 

 Factory reset 

 Update firmware 

 Import and export project files 

 Export log files 

 Set the device status after AC power back 

 Select a fan mode 

 Set the time to return to home 
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 Configure electrostatic protection 

 Update the plugin 

 Set the time to lock the front panel LCD 

On the home screen, tap  located at the bottom right corner to enter the settings 
screen. Then, tap Advanced to enter the advanced settings screen. 

 Advanced settings 

 

Factory Reset 

This function is used to quickly clear the data saved in the device. All parameters will 
be restored to the default values. 

 Keep User Data: During factory reset, the network configuration, EDID files, gallery, 
device name and language settings will be kept, while other parameters will be 
restored to the default values.  

 Reset All: All device parameters will be restored to the default values. 

Update Firmware 

The P80 supports firmware update via USB drive. To do that, save the update file in 
the root directory of the USB drive and then insert the drive into the USB port on the 
P80. 

On the Advanced screen, tap Update to enter the firmware update screen and the 
system will automatically detect and read the update file in the USB drive. 



All-New Event Presentation Switching Solutions 

User Manual 6 Menu Operations 

 

www.pixelhue.com 68 
 

 Firmware update 

 

Select the target update file, tap Update, and the system will automatically update the 
device. 

The device will automatically restart during the update. 

Import and Export Project Files 

The P80 supports import and export of configured project information via USB drive, 
allowing you to quickly complete device configuration. 

 To import project files, save the files in the root directory of the USB drive and then 
insert the drive into the USB port on the P80. 

 To export project files, insert the USB drive that is used to save the files into the 
USB port on the P80. 

On the Advanced screen, tap Projects to enter the project file import and export 
screen. 
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 Importing and exporting project file 

 

 Import a project files: Tap Import File, and the system will automatically read the 
project files in the USB drive. After selecting the target file, tap OK, and the system 
will automatically import the file to the device. After the import is complete, the 
device will automatically restart. 

 Export a project file: Tap Export File, and the system will automatically export the 
current configured project file to the selected USB drive. 

Export Logs 

The P80 supports export of the device running logs via USB drive. When the device 
has an exception, the logs can be used for quick troubleshooting. 

To export logs, insert the USB drive that is used to save the logs into the USB port on 
the P80. 

On the Advanced screen, tap Logs to enter the log export screen. 
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 Exporting logs 

 

Tap Log Export to export the device logs to the selected USB drive.  

Set Device Status After AC Back 

Set whether the device automatically powers on after the power is supplied. 

 AC back 

 

 Power On: After the power is supplied, the device automatically powers on. 

 Power Off: After the power is supplied, the device remains powered off. To power 
on the device, press the power button on the device front panel. 

 Last State: After the power is supplied, the device remains in the last state. 
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Fan Mode 

On the Fan Mode screen, select the appropriate mode based on the different 
operating scenarios of the device. 

 Fan mode 

 

 Silent Mode: Achieves a quieter operating environment. 

 Power Mode: Provides enhanced heat dissipation. 

 Note 

In performance mode, the device noise level may become higher.  

Return to Home 

The P80 allows users to set to return to the home screen automatically after a 
specified period of inactivity. 

On the Advanced screen, tap Return to Home to access the settings. 
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 Return to home 

 

Drag the slider or tap -/+ to adjust the duration. The duration ranges from 30s to 
3600s and defaults to 30s. 

You can tap Reset to set the duration to the default value (30s). 

 Notes: 

When there is a pop-up window on the LCD, the home screen will not be displayed 
automatically even if the set time has elapsed. 

 

Electrostatic Protection 

The P80 provides an electrostatic protection feature, effectively preventing issues 
such as unstable input or frequent input disconnection due to static electricity. 

On the Advanced screen, tap Electrostatic Protection to access the antistatic 
settings. 
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 Electrostatic protection 

 

Choose to turn on or off the antistatic switch (off by default) and set the antistatic 
duration. 

 On: If the primary source fails, it will freeze on the last frame before the failure 
throughout the specified protection duration. The backup source will become 
active if the failure of the primary source remains beyond this duration. 

 Off: Upon the failure of the primary source, the backup source will become active 
immediately. 

Plugin 

The P80 can run the Companion plugin, enabling the third-party device Stream Deck 
to intelligently control the P80 through simple configuration. 

On the Advanced screen, tap Plugin to enter the plugin screen. 

 Plugin 
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The P80 supports plugin update via USB drive. To do that, first save the update file in 
the root directory of the USB drive, and then insert the USB drive into the USB port on 
the P80. 

 Update: Tap Update, and the system will automatically read the plugin files from 
the USB drive. Select the desired plugin file and tap OK to proceed with the plugin 
update. 

 Plugin update 

 

 Companion: Tap the Companion icon to launch the Companion plugin. The plugin 
status will update from Inactive to Running, indicating that the plugin has been 
activated. 

Lock Screen 

The P80 offers a front panel LCD lock feature, including automatic and scheduled 
lock modes. Once enabled, it helps prevent accidental operations due to unintended 
touches, enhancing the device’s security and stability. 
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 Lock screen 

 

 Manual lock: Tap the  icon in the upper right corner of the home screen to 
lock the screen. 

 Automatic lock: On the Lock Screen interface, tap to enable Auto Lock, and set 
the lock screen time. 

 Auto lock 

 

 Notes: 

When performing an automatic lock, ensure all interface pop-ups are closed; 
otherwise, the screen will not lock automatically even if the set time has elapsed. 
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 Unlock: Tap the screen on the home screen, and when the slide button appears, 
swipe up to unlock. 

Language 

The P80 supports both Chinese and English UI languages. You can choose your 
preferred language on the Language screen. 

 Language 

 

After a language is selected, ✓ appears at the bottom right. 

About Us 

On the About Us screen, you can check the device firmware version and the contact 
information of PIXELHUE. 
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 About us 

 

P20/P20-DS/P10 Menu Operations 
The 5-inch LCD and a variety of buttons on the front panel of the P20/P20-DS/P10 
allow for pretty darn simple operations. The following sections will introduce the 
operations in detail. 

Startup and Shutdown 

Connect all the necessary cables and power cords properly, locate and turn on the 
rocker switch on the rear panel. The startup screen appears, as shown in Figure 6-19. 
The P20/P20-DS/P10 front panel provides a 5-inch LCD screen allowing for more 
intuitive operations. 

 Startup screen 
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To turn off the P20/P20-DS/P10, press the power button on the front panel and 
select OK from the dialog box displayed on the LCD screen. 

Home Screen  

After the startup, the home screen is displayed. The following descriptions use the 
P20/P20-DS home screen as an example, as show in Figure 6-20 and Table 6-2. 

 Home screen (P20) 

 

Table 6-2 Home screen description 

No. Description 

1 Displays the device information. 

 
Logo of PIXELHUE 

P20 Device model 

SYSTEM Device name 

 Front panel lock 

 When this icon is displayed, the front panel buttons are 
locked. 

 When this icon is not displayed, the front panel buttons 
are unlocked. 

Press and hold the knob and BACK button simultaneously 
for 3s or longer to lock or unlock the front panel buttons. 

192.168.100.100 Device IP address 

For details, see 6.2.10 Network. 

 
Connection status of the Ethernet port on the rear panel 

 : An Ethernet cable is connected. 
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No. Description 

 : No Ethernet cable is connected. 

 
Connection status of the USB drive on the front panel 

 : A USB drive is inserted. 

 : No USB drive is inserted. 

2 SCREEN 1 Displays the information of common and AUX screens. 

When there are multiple screens, you can rotate the knob to 
switch between the screens. 

 When Test Pattern, FTB or Freeze is turned on, Test 
Pattern FTB or FRZ is displayed at the top of this section. 

 The screen resolution is displayed on the right of this 
section. 

 The layer resource usage is displayed at the bottom of 
this section. 

Layer source status: 

 When an input source name is displayed, it indicates that 
the source is selected. When the source name is in green, 
the source is normal. When the source name is in gray, it 
indicates no signal. M denotes that it is a MAIN layer. 

 When N/A is displayed, no input source is selected and 
the layer is blank. 

3 GENLOCK Signal synchronization status 

For details, see 6.2.11.1 Set Synchronization Signal Source. 

BACKUP Device backup on/off 

MODE Working mode of the device 

 Switcher 

 PGM Only 

For details, see 6.2.12 Mode. 

EFFECTS Transition effect 

 Cut 

 Fade 

For details, see 6.2.7 Transition. 

4 OUTPUT Displays the output connector statuses. 

 When an output connector icon is in green, an output 
device is connected. 

 When an output connector icon is in blue, no output 
device is connected. 

 When the border of an output connector icon is in orange, 
the connector is used for copying output. 

On the home screen, press the knob to access the main menu screen and complete 
relevant settings. The following sections will describe menu operations in detail. 
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 Main menu (P20) 

 

Input 

The Input menu allows you to do the following: 

 Select Connector Type 

 Select Connector Capacity 

 Set EDID 

 Set Mac EDID Compatibility and Mosaic 

 Import and Export EDID 

 Set Input Color 

 Set InfoFrame Override 

 Set HDCP 

 View HDCP Status 

Select Connector Type 

Select the desired input connector to use it as the input source. 

Prerequisites 

 For a DP 1.2/HDMI 2.0 input, only one connector can be selected as the input 
source at the same time.  

 Connector type selection is not available for the 12G-SDI connectors. 

Notes: 

After the input connector is changed: 

 The layers on the common screen and AUX screen become blank. 

 The connector properties such as the resolution and color settings are reset to the 
defaults. 
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Menu Orientation 

On the main menu screen, scroll to and select Input > Connector. 

 Input connector selection (P20) 

 

Description 

Menu Item Description 

Input Source  Select an input source. 

 P20/P20-DS 

Includes 12x input sources. Inputs 1 to 8 contain 8x DP 1.2/HDMI 2.0 
and Inputs 9 to 12 contain 4x 12G-SDI. 

 P10 

Includes 6x input sources. Inputs 1 to 4 contain 4x DP 1.2/HDMI 2.0 
and Inputs 5 to 6 contain 2x 12G-SDI. 

Connector Select the type of the input connector. Either DP 1.2 or HDMI 2.0 can be 
selected.  

Select Connector Capacity 

Select a connector capacity so that the device can calculate the number of layers 
that can be added on the common screen according to the selected connector 
capacity. 

Prerequisites 

An input source and connector type are selected. Connector type selection is not 
available for 12G-SDI. 

Notes 

After the connector capacity is changed: 
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 The layers on the common screen become blank and the DSK function is turned 
off. 

 The connector properties such as the resolution and color settings are reset to the 
defaults. 

Menu Orientation 

On the main menu screen, scroll to and select Input > Capacity. 

 Connector capacity selection (P20) 

 

Description 

Menu Item Description 

Capacity Resource usage of the input connector 

 DL: 4K×1K 

 4K: 4K×2K 

Set EDID 

Set input resolution and frame rate. You can either choose a standard resolution 
provided by the system or customize a resolution, and set advanced parameters. 

Prerequisites 

 The video source is output by graphics card. 

 An input source and connector type (DP 1.2/HDMI 2.0) are selected. EDID settings 
are not available for the 12G-SDI connectors. 

Notes 

Advanced settings must be done by trained professionals. 
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Menu Orientation 

On the main menu screen, scroll to and select Input > Input Resolution. 

 Input resolution settings (P20) 

 

Description 

Menu Item Submenu Item Description 

Current Resolution - Current input resolution: Pixel width and 
height of the input source 

Standard Resolution Commonly used resolution 

Frame Rate Commonly used frame rate 

Frames per second (Hz) 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the audio 
function cannot be enabled. 

Custom Width Pixel width of the input source 

Height Pixel height of the input source 

Frame Rate Frames per second (Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration 
of the horizontal and vertical blanking 
intervals in the video signal to ensure 
synchronized image display 

Options include Standard, CVT-RBv1, CVT-
RBv2, and CVT-RBv3. 

HBlank (P20-DS 
only) 

Horizontal blanking parameter to complete 
the current line scan and prepare for the next 
one. 

 When Standard is selected for Reduced 
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Menu Item Submenu Item Description 

Blanking, HBlank is displayed but cannot 
be adjusted. 

 When CVT-RBv1 is selected for Reduced 
Blanking, HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced 
Blanking, HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced 
Blanking, HBlank is adjustable, ranging 
from 80 to 200. 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the 
audio function cannot be enabled. 

Advanced Frame Rate Frames per second (Hz) 

H Total The total number of pixels per line 

Width Pixel width of the active area 

H Front Porch The offset between the end of the active area 
and the beginning of H sync 

H Sync H sync width in pixels 

H Polarity Polarity (active high or low) of the horizontal 
sync pulse 

V Total The total number of pixels per frame 

Height Pixel height of the active area 

V Front Porch The offset in lines between the end of the 
output active area and the beginning of V 
sync 

V Sync V sync width in lines 

V Polarity Polarity (active high or low) of the vertical 
sync pulse 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the 
audio function cannot be enabled. 

After the settings are completed, select Apply for the settings to take effect. 

Set Mac EDID Compatibility and Mosaic 

Turn on Mac EDID Compatibility when the P20/P20-DS/P10 is not compatible with 
the EDID on Mac. When a Mac is used as the input source, set Mac mosaic to enable 
automatic image mosaic. 

Notes 

 Ensure the connector timing is the same as the input source before enabling Mac 
mosaic. 
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 A mosaic group can be used by up to two input sources. 

Menu Orientation 

On the main menu screen, scroll to and select Input > Mac Settings. 

 Mac settings (P20) 

 

Description 

Menu Item Description 

Mac EDID 
Compatibility 

Set EDID compatibility with Mac. 

 : Compatible with EDID on Mac 

 : Off 

Mac Mosaic Set Mac mosaic method, including None, Left, and Right. 

Mosaic Group Set Mac mosaic group (1~16). When the mosaic method is set to 
None, Mosaic Group is unavailable. 

Import and Export EDID 

When there is something wrong with the input connector compatibility, import EDID 
files without compatibility problems into the device. Or export EDID files from the 
device and provide the files for other devices or input connectors to solve 
compatibility problems. 

Prerequisites 

 Before importing an EDID file, copy the file (.bin and .dat) to the root directory of a 
USB drive and insert the USB drive into the USB port on the front panel of the 
P20/P20-DS/P10. 

 Before exporting an EDID file, insert a USB drive into the front panel of the 
P20/P20-DS/P10. 

 An input source and connector type are selected. EDID import and export are not 
available for 12G-SDI. 

Notes 

 The USB port on the P20/P20-DS/P10 front panel does not support USB HUB. 

 Only one EDID file can be imported for an input connector and the file must be 
less than 1 MB. 
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Menu Orientation 

On the main menu screen, scroll to and select Input > Input Resolution > Import 
EDID/Export EDID. 

 EDID import/export (P20) 

 

Description 

 Import EDID 

a. Scroll to and select Import EDID to access the EDID file screen. 

b. Select the file to be imported. 

c. In the dialog box that appears, select OK. 

 Export EDID 

a. Scroll to and select Export EDID to access the submenu. 

b. From the drop-down options, select a file format (.bin or .dat). 

c. Select Apply. 

 Note:  

If you want to modify the content of an imported EDID file, modify the file, import it 
again and overwrite the original one.  

Set Input Color 

Set the color parameters of an input connector so that the color effect can be applied 
to all the video sources accessed from this connector. 

Prerequisites 

An input source and connector type are selected. Input color settings are not 
available for the 12G-SDI connectors. 

Menu Orientation 

On the main menu screen, scroll to and select Input > Input Color. 
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 Input color settings (P20) 

 

Description 

Menu Item Description 

Brightness Brightness is the shading of lights in the image. When the brightness 
increases, viewers will be dazzled. When the brightness decreases, the 
image becomes dark. 

Contrast Contrast is the ratio of the luminance of the brightest color to that of 
the darkest color. Generally, the higher the contrast, the clearer and 
more colorful the image. On the contrary, the entire image becomes 
gloomy. Contrast affects the exposure level of the entire image. It 
makes the bright part brighter and the dark part darker. 

Saturation Saturation is the colorfulness of the image. The higher the contrast, 
the more vivid the image. 

Hue Hue is the relative degree of how bright or dark the image is. 

If you want to reset the parameters to their default values, select Apply. 

Set InfoFrame Override 

Set the override parameters of the input source. The parameters can be used by the 
device for calculation. This operation does not change the original parameter values 
of the input source. 

Prerequisites 

 An input source and connector type (DP 1.2/HDMI 2.0) are selected. InfoFrame 
override settings are not available for the 12G-SDI connectors. 

 To set dynamic range conversion, make sure the device is P20/P20-DS, the 
connector is HDMI 2.0. 

Menu Orientation 

On the main menu screen, scroll to and select Input > InfoFrame Override. 
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 InfoFrame override (P20) 

 

Description 

Menu Item Description 

Color/Sample Set the input color space and sampling rate 

Bit Depth Set the input bit depth 

Bit depth refers to the color information stored in an image. The higher 
the bit depth of an image, the more colors it can store. 

Quantization 
Range 

Set the input quantization range 

Dynamic 
Range 

Set the dynamic range format of the signal. 

Color Gamut Set the input color gamut standard 

Luminance Peak luminance. This menu item is displayed when Dynamic Range is 
HDR10 or HLG. 

Ambient 
Brightness 

Ambient brightness. This menu item is displayed when Dynamic 
Range is HDR10 or HLG. 

When you set a parameter value to AUTO, the device will get the actual value from 
the properties of the input source automatically. 

Set HDCP 

HDCP (High-Bandwidth Digital Content Protection) is a coding scheme used to 
protect audio and video signals traveling through DVI, HDMI, and DP from being 
copied and illegally intercepted during a streaming session. Users can turn on/off 
HDCP for input connectors. HDCP is turned on by default. 

Prerequisites 

An input source and connector type are selected. 
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Note 

SDI does not support HDCP. If 12G-SDI is selected as the input source, the HDCP 
function will be unavailable. 

Menu Orientation 

On the main menu screen, scroll to and select Input > HDCP. 

 HDCP (P20) 

 

Description 

Select On or Off to turn on or off HDCP function for the input source. 

View HDCP Status 

View the HDCP status of the selected video source. 

Prerequisites 

An input source and connector type are selected. This is not available for 12G-SDI. 

Menu Orientation 

On the main menu screen, scroll to and select Input > HDCP Status. 
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 HDCP status (P20) 

 

Description 

Menu Item Description 

HDCP Status HDCP status of the selected video source 

 Encrypted: The video source is encrypted by HDCP. 

 Not Encrypted: The video source is not encrypted by HDCP. 

 Unknown: The HDCP encryption status is not obtained. 

Output 

The Output menu allows you to do the following: 

 Select Output Capacity 

 Set Output Resolution 

 Export EDID 

 Set Output Color 

 Set Output Information 

 Set HDCP 

Select Output Capacity 

Set the output capacity of the common screen. 

Prerequisites 

An output is selected. Output capacity selection is not available for AUX outputs. 

Menu Orientation 

On the main menu screen, scroll to and select Output > Output Capacity. 
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 Output capacity (P20) 

 

Description 

Menu Item Description 

Output Select an output for settings. 

 OUTPUT: Primary output 

 AUX: AUX output 

Output Capacity Select the output capacity of the common screen. 

 P20/P20-DS 

− DL: 4K×1K 

− 4K: 4K×2K 

 P10 

− SL: 2K×1K 

− 4K: 4K×2K 

Set Output Resolution 

Set the resolution and frame rate of the common screen. You can select a standard 
resolution provided by the system or customize a resolution, and complete advanced 
settings. 

Prerequisites 

 The EDID information of the connected device is obtained. 

 An output connector is selected. 

Note 

 Advanced settings must be done by trained professionals. 

 After the output resolution is changed, the AOI parameters related to the 
connector are reset to defaults. 
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Menu Orientation 

On the main menu screen, scroll to and select Output > Output Resolution. 

 Output resolution settings (P20) 

 

Description 

Menu Item Submenu Item Description 

Current Resolution - Current resolution: Pixel width and height of 
the output image 

Standard Resolution Commonly used resolution 

Frame Rate Commonly used frame rate, 

Frames per second (Hz) 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the 
audio function cannot be enabled. 

Custom Width Pixel width of the output image 

Height Pixel height of the output image 

Frame Rate Frames per second (Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration 
of the horizontal and vertical blanking 
intervals in the video signal to ensure 
synchronized image display 

Options include Standard, CVT-RBv1, CVT-
RBv2, and CVT-RBv3. 

HBlank (P20-DS 
only) 

Horizontal blanking parameter to complete 
the current line scan and prepare for the next 
one. 

 When Standard is selected for Reduced 
Blanking, HBlank is displayed but cannot 
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Menu Item Submenu Item Description 

be adjusted. 

 When CVT-RBv1 is selected for Reduced 
Blanking, HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced 
Blanking, HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced 
Blanking, HBlank is adjustable, ranging 
from 80 to 200. 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the audio 
function cannot be enabled. 

Advanced Frame Rate Frames per second (Hz) 

H Total The total number of pixels per line 

Width Pixel width of the active area 

H Front Porch The offset between the end of the active area 
and the beginning of H sync 

H Sync H sync width in pixels 

H Polarity Polarity (active high or low) of the horizontal 
sync pulse  

V Total The total number of pixels per frame 

Height Pixel height of the active area 

V Front Porch The offset in lines between the end of the 
output active area and the beginning of V 
sync 

V Sync V sync width in lines 

V Polarity Polarity (active high or low) of the vertical 
sync pulse 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the 
audio function cannot be enabled. 

After the settings are completed, select Apply for the settings to take effect. 

Export EDID 

When the input connectors of the connected device has good EDID compatibility, the 
P20/P20-DS/P10 can learn the EDID of the connected device via the output 
connectors and the EDID information can be exported to a USB drive so that other 
input connectors of the connected device can use the EDID information. 

Prerequisites 

 A USB drive is inserted into the USB port on the front panel of the P20/P20-
DS/P10. 
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 The output connectors and the connected device are connected correctly. 

 An output is selected. 

Note 

The USB port on the front panel of the P20/P20-DS/P10 does not support USB HUB. 

Menu Orientation 

On the main menu screen, scroll to and select Output > Output Resolution > Export 
EDID. 

 Exporting EDID (P20) 

 

Description 

Select Export EDID to access the submenu, then select a file format (.bin or .dat) and 
output connector, and select Apply to export the EDID information to the root 
directory of the USB drive. 

Set Output Color 

Set output color parameters. The final output color is the combination of layer color, 
input color and output color. 

Prerequisites 

An output is selected. 

Menu Orientation 

On the main menu screen, scroll to and select Output > Output Color. 
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 Output color settings (P20) 

 

Description 

Menu Item Description 

Brightness Brightness is the shading of lights in the image. When the brightness 
increases, viewers will be dazzled. When the brightness decreases, the 
image becomes dark. 

Contrast Contrast is the ratio of the luminance of the brightest color to that of 
the darkest color. Generally, the higher the contrast, the clearer and 
more colorful the image. On the contrary, the entire image becomes 
gloomy. Contrast affects the exposure level of the entire image. It 
makes the bright part brighter and the dark part darker. 

Saturation Saturation is the colorfulness of the image. The higher the contrast, 
the more vivid the image. 

Hue Hue is the relative degree of how bright or dark the image is. 

Set Output Information 

Set the parameters relating to the output signal. 

Prerequisites 

 An output is selected. 

 To set dynamic range conversion, make sure the device is P20/P20-DS and a 
primary output is selected. 

 To configure the OPT port transmission mode, simultaneously press LAYER 
1+LAYER 5+BACK to enter developer mode. To exit developer mode, press LAYER 
1+LAYER 4+BACK. 

Menu Orientation 

On the main menu screen, scroll to and select Output > Output Information. 
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 Output information (P20) 

 

Description 

Menu Item Description 

Color/Sample Set output color space and sampling rate. 

Bit Depth Set output bit depth. 

Bit depth refers to the color information stored in an image. The 
higher the bit depth of an image, the more colors it can store. 

Dynamic 
Range 

Set the dynamic range format of the signal. 

Gamma Set gamma value. This menu item is displayed only when Dynamic 
Range is SDR. 

Color Gamut Set output color gamut standard. 

Luminance Peak luminance. This menu item is displayed when Dynamic Range 
is HDR10 or HLG. 

OPT 1 to 4 Set OPT port transmission mode, including Default, Single Mode, and 
Multimode. 

Set HDCP 

HDCP (High-Bandwidth Digital Content Protection) is a coding scheme used to 
protect audio and video signals traveling through DVI, HDMI, and DP from being 
copied and illegally intercepted during a streaming session. Users can select an 
HDCP version for the output connector or turn off the HDCP function. HDCP is turned 
on by default. 

Prerequisites 

An output is selected. 
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Menu Orientation 

On the main menu screen, scroll to and select Output > HDCP. 

 HDCP (P20) 

 

Description 

Select an HDCP version, or select Off to turn off HDCP. 

Screen 

The Screen menu allows you to do the following: 

 Set Screen Status 

 Set Connector Resolution 

 Set Mosaic 

 Set Edge Blending 

 Set Screen Color 

 Set Output Information 

 Set PGM Edit 

 Set Display Status 

Set Screen Status 

Enable or disable the screen. 

Prerequisites 

The screen is a common screen or AUX screen. 
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Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1/AUX 1 > Screen 
Status. 

 Screen status (P20) 

 

Description 

Set Screen Status to  (on) or  (off). 

Set Connector Resolution 

Set the connector resolution and frame rate. Users can select a standard resolution 
or customize a resolution and set advanced parameters. 

Prerequisites 

 The EDID of the connected display device is obtained. 

 The screen is a common screen or AUX screen and Screen Status is set to . 

Notes 

 The advanced parameters must be set by the trained personnel. 

 After the output resolution is changed, the AOI parameters of the connector is 
reset automatically. 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1/AUX 1 > Connector 
Resolution. 

 Connector resolution (P20) 
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Description 

Menu Item Submenu Item Description 

Current Resolution - Current resolution: Pixel width and height of 
the output image 

Standard Resolution Commonly used resolution 

Frame Rate Commonly used frame rate, 

Frames per second (Hz) 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the audio 
function cannot be enabled. 

Custom Width Pixel width of the output image 

Height Pixel height of the output image 

Frame Rate Frames per second (Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration 
of the horizontal and vertical blanking 
intervals in the video signal to ensure 
synchronized image display 

Options include Standard, CVT-RBv1, CVT-
RBv2, and CVT-RBv3. 

HBlank (P20-DS 
only) 

Horizontal blanking parameter to complete 
the current line scan and prepare for the next 
one. 

 When Standard is selected for Reduced 
Blanking, HBlank is displayed but cannot 
be adjusted. 

 When CVT-RBv1 is selected for Reduced 
Blanking, HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced 
Blanking, HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced 
Blanking, HBlank is adjustable, ranging 
from 80 to 200. 

Audio (P20-DS 
only) 

Turn on or off audio. 

Note: When HBlank is less than 110, the 
audio function cannot be enabled. 

Advanced Frame Rate Frames per second (Hz) 

H Total The total number of pixels per line 

Width Pixel width of the active area 

H Front Porch The offset between the end of the active area 
and the beginning of H sync 

H Sync H sync width in pixels 

H Polarity Polarity (active high or low) of the horizontal 
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Menu Item Submenu Item Description 

sync pulse  

V Total The total number of pixels per frame 

Height Pixel height of the active area 

V Front Porch The offset in lines between the end of the 
output active area and the beginning of V 
sync 

V Sync V sync width in lines 

V Polarity Polarity (active high or low) of the vertical 
sync pulse 

After the settings are completed, select Apply for the settings to take effect. 

Set Mosaic 

Set screen mosaic by using easy mode or advanced mode. 

Prerequisites 

The screen is a common screen and Screen Status is set to . 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > Mosaic Settings. 

 Mosaic settings (P20) 

 

Description 

Menu Item Description 

Mode Select a mode for mosaic settings 

 Easy: Set the total screen width and height. The P20/P20-DS/P10 
will generate a mosaic solution automatically. 

 Advanced: Select a mosaic layout template (the number of rows 
and columns of the output connectors). 

Total Width Pixel width of the screen 

This parameter is displayed when the Easy mode is selected. 

After you select Apply, this parameter value keeps the same as the 
value in the mosaic plan. 
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Menu Item Description 

Total Height Pixel height of the screen 

This parameter is displayed when the Easy mode is selected. 

After you select Apply, this parameter value keeps the same as the 
value in the mosaic plan. 

Connector 
Layout 

Horizontal and vertical start positions of the connector 

After the settings are completed, select Apply for the settings to take 
effect. 

Mosaic Layout Rows and columns of output connectors on the screen 

This menu item is displayed only when Advanced is selected as the 
mosaic mode. 

Number of output connectors that can be used for mosaic: 

 P20/P20-DS 

− In PGM only mode, four output connectors can be used for 
mosaic. 

− In switcher mode, two output connectors can be used for 
mosaic. 

 P10 

− 4K: In PGM only mode, two connectors can be used for 
mosaic. In switcher mode, one connector can be used. 

− SL: In PGM only mode, eight connectors can be used for 
mosaic. In switcher mode, four connectors can be used. 

Replace 
Connector 

If an output connector used on the mosaic layout fails, you can 
replace the connector with another normal connector via menu 
operations. 

Procedure: 

Select Replace Connector, select the connector to be replaced on the 
right, scroll to and select another normal connector. 

If the selected normal connector is in use, the normal connector and 
the failed connector will be swapped. 

AOI Settings Set the pixel width and height and start position of the output 
connector on the mosaic screen.  

This menu item is displayed only when Advanced is selected as the 
mosaic mode. 

When the resolution of the output connector is higher than the actual 
screen resolution, AOI settings allow the output connector to meet 
the mosaic requirements without changing the original resolution of 
the connector. 

Submenu description: 

 Connector: Select the connector for AOI settings. 

 Width: Set the pixel width. 

 Height: Set the pixel height 

 H Position: Set the horizontal start position. 

 V Position: Set the vertical start position. 

LCD Bezel Set the parameters related to LCD bezel compensation. 
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Menu Item Description 

Compensation  Status: Turn on ( ) or off ( ) LCD bezel compensation. 

 H Spacing: Total width of bezels 

 V Spacing: Total height of bezels 

After the settings are completed, select Apply for the settings to take effect. 

Set Edge Blending 

Edge blending is a technique used when using multiple projectors to display different 
regions of a single image. To display a single seamless image, adjacent projectors 
need to overlap edges slightly and compensate for the double brightness created in 
different regions.  

Prerequisites 

 The screen is a common screen and Screen Status is set to . 

 The offset angles of the projectors have been adjusted. 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > Edge Blending. 

 Edge blending (P20) 

 

Description 

Menu Item Description 

Connector Select a connector for edge blending settings. 

Edge Select an edge for blending. 

Feathering Turn on or off Feathering. 

 : On 

 : Off 

Gamma The feathering gamma for the blending area 

Width The feathering width for the blending area 

The blending area is inside the projector image and facing inward. 

Set Screen Color 

Set the color parameters of the screen. 
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Prerequisites 

The screen is a common screen and Screen Status is set to . 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > Screen Color. 

 Screen color (P20) 

 

Description 

Menu Item Description 

Brightness Brightness is the shading of lights in the image. When the 
brightness increases, viewers will be dazzled. When the brightness 
decreases, the image becomes dark. 

Contrast Contrast is the ratio of the luminance of the brightest color to that 
of the darkest color. Generally, the higher the contrast, the clearer 
and more colorful the image. On the contrary, the entire image 
becomes gloomy. Contrast affects the exposure level of the entire 
image. It makes the bright part brighter and the dark part darker. 

Saturation Saturation is the colorfulness of the image. The higher the contrast, 
the more vivid the image. 

Hue Hue is the relative degree of how bright or dark the image is. 

Brightness Brightness is the shading of lights in the image. When the 
brightness increases, viewers will be dazzled. When the 
brightness decreases, the image becomes dark. 

Set Output Information 

Set the parameters of the output signal. 

Prerequisites 

 The screen is a common screen and Screen Status is set to . 

 Dynamic range conversion is available for P20/P20-DS only. 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > Output 
Information. 
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 Output information (P20) 

 

Description 

Menu Item Description 

Color/Sample Set output color space and sampling rate. 

Bit Depth Set output bit depth. 

Bit depth refers to the color information stored in an image. The 
higher the bit depth of an image, the more colors it can store. 

Dynamic 
Range 

Set the dynamic range format of the signal. 

Gamma Gamma value 

This menu item is displayed only when Dynamic Range is SDR. 

Color Gamut Set output color gamut standard. 

This menu item is displayed only when Dynamic Range is HDR10 
or HLG. 

Luminance Peak luminance.  

This menu item is displayed when Dynamic Range is HDR10 or 
HLG. 

Set PGM Edit 

Turn on or off PGM edit. 

Prerequisites 

 The device is in switcher mode. In PGM only mode, PGM Edit cannot be set and 
turned on by default. 

 The screen is a common screen or AUX screen and Screen Status is set to . 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > PGM Edit. 
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 PGM edit (P20) 

 

Description 

Menu Item Description 

PGM Edit Turn on or off PGM edit. 

 : On 

The edits you make on the LCD menu modify the layers on PGM 
and the edit process is displayed on the screen in real time. 

 : Off 

The edits you make on the LCD menu modify the layers on PVW. 

Set Display Status 

Make the screen display content normally, fade to black, freeze the current frame of 
the input source, or display test patterns. 

Prerequisites 

The screen is a common screen or AUX screen and Screen Status is set to . 

Menu Orientation 

On the main menu screen, scroll to and select Screen > Screen 1 > Display. 

 Display status (P20) 

 

Description 

 Common Screen 

Set Display to Normal, FTB, Freeze or Test Pattern. 

 AUX Screen 

Set Display to Normal, FTB, or Freeze. 
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After Test Pattern is selected for a common screen, users can set the following 
parameters in the sub-menu. 

Menu Item Description 

Pure Color Test pattern color 

Gradient Gradient style of the test pattern  

Grid Grid style of the test pattern 

Brightness Test pattern brightness 

Spacing Level Spacing between different colors 

This option is displayed only when the test pattern contains multiple 
colors. 

Spacing (px) Spacing between grid lines 

This option is displayed only when the grid style is specified. 

Line Width Width of grid lines 

This option is displayed only when the grid style is specified. 

Speed Moving speed of grid lines 

This option is displayed only when the grid style is specified. 

Layer 

The Layer menu allows you to do the following: 

 Set Regular Layers 

 Set Basic Information 

 Manage LOGO 

 Set AUX Layers 

Set Regular Layers 

6.2.6.1.1 Create and Delete Layers 

Create, delete and clear regular layers. The LCD menus of P20/P20-DS are used as 
examples in this section for illustration.  

Menu Orientation 

On the main menu screen, scroll to and select Layer. 

Description 

Select a common screen, set Layer Type to Regular, and then do the following as 
required. 

 Create a regular layer 

Select Create Layer. 
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 Delete a regular layer 

Select the layer to be deleted to access the sub-menu and then select Delete 
Layer. 

 

 Clear regular layers 

Select Clear All Layers. 

 

Note: If PGM is displayed next to Select Screen, it denotes that PGM Edit is turned 
on. If not, PGM Edit is turned off. 

6.2.6.1.2 Set Basic Information 

Set the basic information of regular layers. 

Prerequisites 

A common screen and regular layer are selected. 

Note 

If the layer source bandwidth is exceeded, the layer displays a black screen. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name. 
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 Basic layer information (P20) 

 

Description 

Menu Item Description 

Input Source Select an input source for the layer 

Lock Aspect Ratio Lock or unlock the aspect ratio of the layer resolution. 

 : Locked 

 : Unlocked 

Aspect Ratio Set the ratio of the layer width to the layer height. 

After the aspect ratio is changed, the layer height keeps 
unchanged and the layer width is calculated automatically. 

Width Specify the layer width. 

Height Specify the layer height. 

H Position Specify the horizontal start position of the layer on the common 
screen. The coordinates of the pixel at the top left of the main 
screen is (0, 0). 

V Position Specify the vertical start position of the layer on the common 
screen. The coordinates of the pixel at the top left of the main 
screen is (0, 0). 

Scaling Mode Set the scaling mode of the layer. 

 Custom: The layer is scaled according to your settings. 

 Pixel to Pixel: The layer resolution is the same as the input 
resolution. If the input source is cropped, the layer resolution is 
the same as the resolution after cropping. 

 Full Screen: The layer fills the entire screen. 

Z-Order Set the priority order of the layer. 

 Bring Forward 

 Send Backward 

 Bring to Front 

 Send to Back 

6.2.6.1.3 Set Input Crop 

When there are black borders or unnecessary information on the input source, input 
crop allows you to crop the input source and display the desired area. 
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Prerequisites 

 A common screen and regular layer are selected. 

 The layer source is accessed. 

Note 

The input source status and capacity after cropping is the same as the original. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Input Crop. 

Description 

Menu Item Description 

Status Turn on/off input crop. 

 : On 

 : Off 

H Position Set the horizontal start position of the cropped area. 

V Position Set the vertical start position of the cropped area. 

Width Set the pixel width of the cropped area. 

Height Set the pixel height of the cropped area. 

Crop Effect Example 

 

6.2.6.1.4 Set Layer Color 

Set layer color parameters. 

Prerequisites 

A common screen and regular layer are selected. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Layer Color. 
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Description 

Menu Item Description 

Brightness Brightness is the shading of lights in the image. When the brightness 
increases, viewers will be dazzled. When the brightness decreases, the 
image becomes dark. 

Contrast Contrast is the ratio of the luminance of the brightest color to that of 
the darkest color. Generally, the higher the contrast, the clearer and 
more colorful the image. On the contrary, the entire image becomes 
gloomy. Contrast affects the exposure level of the entire image. It 
makes the bright part brighter and the dark part darker. 

Saturation Saturation is the colorfulness of the image. The higher the contrast, 
the more vivid the image. 

Hue Hue is the relative degree of how bright or dark the image is. 

Monochrome Turn on/off monochrome. 

 : On. The layer image is in black and white. 

 : Off 

Invert Colors Turn on/off color inversion. 

 : On. The colors of the layer image is inverted. 

 : Off 

Opacity Set color opacity. 

6.2.6.1.5 Set Cut & Fill 

Set the parameters related to Cut & Fill. The original layer serves as the Fill layer, and 
the output will display the Cut layer that overlaps with the Fill layer, allowing users to 
define the output shape and effect more flexibly. 

Prerequisites 

A common screen and regular layer are selected. 

Notes 

 When the Cut & Fill function is enabled, the DSK function is disabled. 

 The total resources for the Cut layer are 2x DL (1x 4K), and the Cut layer capacity 
must be less than or equal to that of the Fill layer. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > CUT & FILL. 

Description 

Menu Item Description 

Status Turn on or turn off the function. 

 : On 

 : Off 



All-New Event Presentation Switching Solutions 

User Manual 6 Menu Operations 

 

www.pixelhue.com 111 
 

Menu Item Description 

CUT Source 
Type 

The input source type of the Cut layer 

CUT Source The input source of the Cut layer 

Negative Turn on or turn off the invert colors function. 

 : On, allowing black areas to be transparent and white areas to 
be cut 

 : Off, allowing white areas to be transparent and black areas to 
be cut 

X The horizontal initial position of the Cut layer relative to the Fill layer 

Y The vertical initial position of the Cut layer relative to the Fill layer 

Width The horizontal pixels of the Cut layer 

Height The vertical pixels of the Cut layer 

6.2.6.1.6 Set DSK 

Use luma key, chroma key or smart key for input sources. 

Prerequisites 

 A common screen and regular layer are selected. 

 The layer source is accessed. 

Notes 

After DSK is turned on, the layer capacity changes to 4K automatically. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > DSK. 

Description 

Menu Item Description 

Status Turn on/off DSK. 

 : On 

 : Off 

Mode DSK mode 

 Luma key: Suitable for keying scenarios where 
the brightness of the background is significantly 
smaller than that of the foreground. The result of 
luma key is that the background becomes 
transparent and the foreground is keyed out. 

 Chroma key: Suitable for keying scenarios with a 
single background color, such as blue/green 
screen matting. 

 Smart key: Suitable for common keying 
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Menu Item Description 

scenarios, which reduces parameter adjustments 
and allows the keying requirements of users to be 
satisfied in an easier way. 

Luma Clip Distinguish between the foreground and 
background. 

Smooth Set the smoothness of the transition area between 
foreground and background. 

The greater the value, the smoother the transition. 

Foreground 
Color 

Turn on or turn off foreground color adjustment. 

 : On. The RGB of the related parameter can 
be set to adjust the keying effect. 

 : Off 

RGB Specify the RGB values of the foreground color. 

Chroma Pick Hue Set the RGB values of the pick point 

 Method 1: Specify the coordinates of the pick 
point on the input source, and the RGB values of 
the point will be displayed. 

 Method 2: Specify the RGB values. 

After the settings, select Apply. You can also adjust 
the following parameters to optimize the keying 
effect. 

Hue Ramp Distinguish between the foreground and 
background. 

Hue Clip Hue range 

The greater the value, the larger the removal area. 
The maximum value is the current value of Hue 
Ramp. 

Saturation 
Clip 

Distinguish between the foreground and 
background. 

Saturation 
Gain 

Adjust overall image brightness. 

Spill Remove the overflow from the foreground image 
edges and semi-transparent areas. 

Shadow Remove the shadow areas. 

Highlight Remove the highlight areas. 

Smart Pick Hue Set the RGB values of the pick point 

 Method 1: Specify the coordinates of the pick 
point on the input source, and the RGB values of 
the point will be displayed. 

 Method 2: Specify the RGB values. 

After the settings, select Apply. You can also adjust 
the following parameters to optimize the keying 
effect. 
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Menu Item Description 

Matting 
Strength 

Adjust the intensity of background processing. 

Gain Adjust Adjust the shadow/noise areas present in the 
foreground. 

If you want to reset the parameters to their default values, select Reset. 

6.2.6.1.7 Set Layer Mask 

Set parameters related to layer mask. The masked area will be transparent and 
invisible. The layer resolution keeps unchanged. 

Prerequisites 

A common screen and regular layer are selected. 

Note 

Enabling layer mask will disable the layer border. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Mask. 

Description 

Menu Item Description 

Status Turn on/off layer mask. 

 : On 

 : Off 

Mask Top Set the area to be masked on the top of the layer. 

Mask Bottom Set the area to be masked on the bottom of the layer. 

Mask Left Set the area to be masked on the left of the layer. 

Mask Right Set the area to be masked on the right of the layer. 

Mask Effect Example 

 



All-New Event Presentation Switching Solutions 

User Manual 6 Menu Operations 

 

www.pixelhue.com 114 
 

6.2.6.1.8 Set Layer Borders 

Set the border of a layer. 

Prerequisites 

A common screen and regular layer are selected. 

Note 

Enabling layer mask will disable the layer border. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Border. 

Description 

Menu Item Description 

Status Turn on/off layer border. 

 : On 

 : Off 

Border Set the layer border type. 

Width Set the width of the left and right borders. 

Height Set the height of the top and bottom borders. 

Color Set the RGB of the border color. 

Border Effect Example 

 

6.2.6.1.9 Set Border Shadow 

Set the layer shadow position, size, opacity, edge blur and color. 

Prerequisites 

A common screen and regular layer are selected. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Shadow. 
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Description 

Menu Item Description 

Status Turn on/off layer shadow. 

 : On 

 : Off 

X The horizontal initial position of shadow on the common screen. 
The coordinates of the pixel at the top left of the common screen 
is (0, 0). 

Y The vertical initial position of shadow on the common screen. The 
coordinates of the pixel at the top left of the common screen is (0, 
0). 

Width Set the shadow width. 

Height Set the shadow height. 

Opacity Set the shadow opacity. 

Edge Blue Set the shadow edge blur. 

Color Set the shadow color. 

6.2.6.1.10 Set Layer Flipping 

Flip layers horizontally, vertically, or horizontally and vertically. 

Prerequisites 

A common screen and regular layer are selected. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Flip. 

Description 

Menu Item Description 

Flip  None: Don’t flip the layer. 

 Flip Horizontally: Flip the layer horizontally. 

 Flip Vertically: Flip the layer vertically. 

 Flip Horizontally and Vertically: Flip the layer horizontally and 
vertically 



All-New Event Presentation Switching Solutions 

User Manual 6 Menu Operations 

 

www.pixelhue.com 116 
 

Flipping Effect Example 

 

Manage BKG 

Apply, export, delete, resize, reposition and import BKG files, and save captured 
images as BKG files. 

Prerequisites 

 Before importing a BKG file, copy the file (.png, .bmp, .jpg, .jpeg) to the root 
directory of a USB drive and insert the USB drive into the USB port on the front 
panel of the P20/P20-DS/P10. 

 Before exporting a BKG file, insert a USB drive into the USB port on the front 
panel of the P20/P20-DS/P10. 

Notes 

 The USB port on the front panel of the P20/P20-DS/P10 does not support USB 
HUB. 

 The BKG does not use the layer resources. 

 The BKG image automatically fits to the screen and is always at the back of the 
layer order. 

 When you are importing a BKG file using the event controller or PixelFlow, you 
are not able to import BKG images using the P20/P20-DS/P10. 

 The total number of BKG and LOGO files cannot exceed 255 and the total 
storage space for BKG and LOGO files is up to 512 MB. 

 The maximum resolution of a single BKG file is 65536×65536 pixels. 

Menu Orientation 

On the main menu screen, scroll to and select Layer. 
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 BKG (P20) 

 

Description 

Select a common screen, set the layer type to BKG, and then do the following as 
required. 

 Apply BKG 

a. Turn on BKG. ( ) 

b. Select BKG to open the BKG file screen. 

c. Select a BKG file. In the dialog box that appears, select Apply to use the BKG 
file as the background image of the common screen. 

 Export BKG 

a. Turn on BKG. ( ) 

b. Select BKG to open the BKG file screen. 

c. Select a BKG file. In the dialog box that appears, select Export. 

d. In the dialog box that appears, select OK to export the BKG file to the root 
directory of the USB drive. 

 Delete BKG 

a. Turn on BKG. ( ) 

b. Select BKG to open the BKG file screen. 

c. Select a BKG file. In the dialog box that appears, select Delete. 

d. In the dialog box that appears, select OK to delete the BKG file. 

 Set BKG size 

Turn on/off Lock Aspect Ratio, specify Aspect Ratio, Width and Height to resize 
BKG. 

 Set BKG position 

Specify H Position and V Position to reposition BKG. 

 Import BKG 

a. Select BKG Import to open the BKG file list screen. 
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b. Select a BKG file. In the dialog box that appears, select OK to import the BKG 
file. 

 Capture 

a. Select Capture to access the submenu. 

b. From the drop-down options, select PGM or an input source for capture. 

c. Select Capture. 

d. After an image is captured successfully, select Save to save the captured 
image as a BKG file. 

Manage LOGO 

Apply, export, delete and import LOGO files. 

Prerequisites 

 Before importing a LOGO image, copy the LOGO file (.png, .bmp, .jpg, .jpeg) to 
the root directory of a USB drive and insert the USB drive into the USB port on the 
front panel of the P20/P20-DS/P10. 

 Before exporting a LOGO image, insert a USB drive into the USB port on the front 
panel of the P20/P20-DS/P10. 

Notes 

 The USB port on the front panel of the P20/P20-DS/P10 does not support USB 
HUB. 

 LOGO does not use the layer resources. 

 The LOGO image is always at the front of the layer order and cannot be resized. 
You can change the position of the BKG image. 

 When you are importing a LOGO file using the event controller or PixelFlow, you 
are not able to import LOGO files using the P20/P20-DS/P10. 

 The total number of BKGs and LOGOs cannot exceed 255 and the total storage 
space for BKG and LOGO files is up to 512 MB. 

 The maximum resolution of a single LOGO file is 512×512 pixels. 

Menu Orientation 

On the main menu screen, scroll to and select Layer. 
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 LOGO (P20) 

 

Description 

Select a common screen, set Layer Type to LOGO, and then do the following as 
required. 

 Apply LOGO 

a. Turn on LOGO. ( ) 

b. Select LOGO to open the LOGO file screen. 

c. Select a LOGO file. In the dialog box that appears, select Apply to use the 
LOGO file as the LOGO of the common screen. 

d. Go back to the previous menu. 

e. Specify H Position and V Position to set the position of the LOGO on the 
screen, that is the horizontal and vertical start position relative to the top left 
(0,0) of the screen. 

 Export LOGO 

a. Turn on LOGO. ( ) 

b. Select LOGO to open the LOGO file screen. 

c. Select a LOGO file. In the dialog box that appears, select Export. 

d. In the dialog box that appears, select OK to export the LOGO file to the root 
directory of the USB drive. 

 Delete LOGO 

a. Turn on LOGO. ( ) 

b. Select LOGO to open the LOGO file screen. 

c. Select a LOGO file. In the dialog box that appears, select Delete. 

d. In the dialog box that appears, select OK to delete the LOGO file. 

 Import LOGO 

a. Select LOGO Import to open the LOGO file screen. 

b. Select a LOGO file. In the dialog box that appears, select OK to import the 
LOGO file. 
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Set AUX Layers 

6.2.6.4.1 Create and Delete Layers 

Create, delete and clear AUX layers. The LCD menus of P20/P20-DS are used as 
examples in this section for illustration. 

Menu Orientation 

On the main menu screen, scroll to and select Layer. 

Description 

Select an AUX screen, set Layer Type to AUX, and then do the following as required. 

 Create an AUX layer 

Select Create Layer. 

 

 Delete an AUX layer 

Select the layer to be deleted to access the sub-menu and then select Delete 
Layer. 

 

 Clear AUX layers 

Select Clear All Layers. 

 

6.2.6.4.2 Set Basic Information 

Set the basic information of AUX layers. 
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Prerequisites 

An AUX screen is selected. 

Note 

If the layer source bandwidth is exceeded, the layer displays a black screen. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name. 

 Basic layer information (P20) 

 

Description 

Menu Item Description 

Input Source Select an input or PGM as the source of the layer. 

Lock Aspect Ratio Lock or unlock the aspect ratio of the layer resolution. 

 : Locked 

 : Unlocked 

Aspect Ratio Set the ratio of the layer width to the layer height. 

After the aspect ratio is changed, the layer height keeps 
unchanged and the layer width is calculated automatically. 

Width Specify the layer width. 

Height Specify the layer height. 

H Position Specify the horizontal start position of the layer on the AUX 
screen. The coordinates of the pixel at the top left of the main 
screen is (0, 0). 

V Position Specify the vertical start position of the layer on the AUX screen. 
The coordinates of the pixel at the top left of the main screen is (0, 
0). 

Scaling Mode Set the scaling mode of the layer. 

 Custom: The layer is scaled according to your settings. 

 Pixel to Pixel: The layer resolution is the same as the input 
resolution. If the input source is cropped, the layer resolution is 
the same as the resolution after cropping. 

 Full Screen: The layer fills the entire screen. 
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6.2.6.4.3 Set Input Crop 

When there are black borders or unnecessary information on the input source, input 
crop allows you to crop the input source and display the desired area. 

Prerequisites 

 An AUX screen is selected. 

 The layer source is accessed. 

Note 

The input source status and capacity after cropping is the same as the original. 

Menu Orientation 

On the main menu screen, scroll to and select Layer > Layer Name > Input Crop. 

Description 

Menu Item Description 

Status Turn on/off input crop. 

 : On 

 : Off 

H Position Set the horizontal start position of the cropped area. 

V Position Set the vertical start position of the cropped area. 

Width Set the pixel width of the cropped area. 

Height Set the pixel height of the cropped area. 

Crop Effect Example 

 

 

Transition 

Select a mode to switch content from PVW to the PGM. 

Prerequisites 

The device is in switcher mode. This menu is not available in PGM only mode. 
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Menu Orientation 

On the main menu screen, scroll to and select Transition. 

 Switching (P20) 

 

Description 

Menu Item Description 

Switching 
Mode 

Select a mode to switch content from PVW to PGM. 

 SWAP: Swap the contents on the PVW screen and PGM screen. 

 COPY: Copy the content on the PVW screen to the PGM screen. 

Transition 
Effect 

Select a transition effect. 

 Cut: Switch content from PVW to PGM with no transition effect. 

 Fade: Switch content from PVW to PGM with a fade effect. 

Duration Duration of the transition effect. 

Selected 
Screens 

Screens selected for switching, including common screens and AUX 
screens. Multiple screens can be selected. 

Preset 

Save the content on PVW or PGM as a preset, load and delete presets. 

Note 

A maximum of 128 presets can be saved. 

Menu Orientation 

On the main menu screen, scroll to and select Preset. 
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 Preset (P20) 

 

Description 

 Save a preset 

− In switcher mode, select a blank preset and then select Save from PVW or 
Save from PGM from the window that appears. 

− In PGM only mode, select a blank preset and then select Save Preset from 
the window that appears. 

After the preset is saved successfully, the status of the preset changes to Saved. 

 Load a preset 

Select a saved preset and select Load from the dialog box that appears to use the 
preset on the screen. 

 Delete a preset 

Select a saved preset and select Delete from the dialog box that appears to clear 
the content in the preset. 

Multiviewer (MVR) 

Set the layout on the Multiviewer screen. 

Note 

 The resolution of the Multiviewer screen is fixed at 1920×1080@60Hz and the 
frame rate can be changed. 

 If the input source exceeds the bandwidth limit, the Multiviewer monitor will 
display a black screen. 

Menu Orientation 

On the main menu screen, scroll to and select MVR. 
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 Multiviewer (P20) 

 

Description 

Menu Item Description 

Frame Rate Select a frame rate for the Multiviewer connector. 

MVR Layout Select a layout for the Multiviewer screen. 

After a Multiviewer layout is selected, all the accessed input sources 
are displayed on the Multiviewer windows automatically. 

HDCP Select an HDCP version or turn off HDCP. 

Network 

Manually specify a static IP address for the device or set the device to obtain an IP 
address automatically. 

Menu Orientation 

On the main menu screen, scroll to and select Network. 
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 Network settings (P20) 

 

Description 

Menu Item Description 

MAC Address Display the physical address of the device. 

Network Mode Select an IP address configuration method. 

 Manual: Specify a static IP address for the device manually. 

 Auto: The device obtains an IP address automatically. 

IP Address IP address of the device 

Subnet Mask Subnet mask of the device 

Default Gateway Default gateway address of the current device 

If you want to reset the parameters to their default values, select Reset. 

Advanced 

The Advanced menu allows you to do the following: 

 Set Synchronization Signal Source 

 Set Input Backup 

 Return to Home 

 Lock Aspect Ratio 

 Set Fn Button 

 Set HDCP 

 Reset to Factory Settings 

 Run Diagnostics 

 Import and Export Project Files 

 Update Firmware 
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 Export Logs 

 Set Antistatic 

 Manage Third-Party Plugins 

Set Synchronization Signal Source 

Select a synchronization signal source for the output signal. 

Prerequisites 

Before Genlock settings, the synchronization signal source is connected to the 
Genlock connector on the rear panel of the P20/P20-DS/P10. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Synchronization. 

 Synchronization signal source (P20) 

 

Description 

Menu Item Description 

Status Turn on/off synchronization. 

 : On 

 : Off 

Source Select a synchronization source. 

 Genlock: Sync to the frame frequency of the Genlock input signal. 

 Input X: Sync to the frame frequency of the selected input source. 
X stands for the input source number. 

When synchronization fails, select Sync to retry. 

Set Input Backup 

Turn on/off input backup and configure input backup relationships. 
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Prerequisites 

The input sources are common sources, mosaic sources and cropped sources. 

Note 

 One source can be configured as the backup of one or multiple primary sources, 
but indirect backup relationships are not supported. 

 The primary and backup sources can be used to create layers independently. 

 Backup relationships can be established between input connectors with the same 
capacity. 

 A backup relationship cannot be established between a cropped source and its 
original source. 

 An input source can be configured as the primary source only in one backup 
relationship. 

 After a backup relationship is established, changing the connector capacity or 
type will cancel the backup relationship. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Input Backup. 

 Input backup (P20) 

 

Description 

Menu Item Description 

Status Turn on/off input backup. 

 : On 

 : Off 

Primary 
Preferred 

Turn on/off primary source preferred. 

 : On 
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Menu Item Description 

 : Off 

Add Backup Add backup relationships. 

Select Add Backup to add a backup relationship and then select a 
primary source and backup source from the drop-down options on the 
left and right. 

If Auto is displayed between the primary source and the backup 
source, the signal switches according to the following rules when the 
primary source recovers. If Manual is displayed, regardless of the 
presence or absence of the signal, only the specified source is used. 

 If Primary Preferred is turned on, the signal automatically switches 
to the primary source after the primary source recovers. 

 If Primary Preferred is turned off, the signal does not switch to the 
primary source after the primary source recovers. 

Reset All Reset Primary Preferred and all backup relationships to the default 
settings. 

Return to Home 

Set the period during which the system stays at the current screen before returning to 
the home screen automatically when no operation is performed. 

Note 

If a dialog box is displayed, the system will not return to the home screen 
automatically after the specified period of time. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Return to Home. 

 Return to Home (P20) 
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Description 

Scroll to Return to Home and press the knob to make the parameter value editable. 
Rotate the knob to adjust the parameter to the desired value and press the knob to 
apply the parameter. 

Lock Aspect Ratio 

Lock or unlock aspect ratio. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Lock Aspect Ratio. 

 Lock aspect ratio 

 

Description 

Lock Aspect Ratio Lock/unlock aspect ratio. 

 : Locked. The aspect ratio is locked when new layers are 
being resized. 

 : Unlocked 

Set Fn Button 

Assign a function to the FN shortcut button on the front panel of the P20/P20-
DS/P10 so that users can quickly access the assigned function. Functions that can 
be assigned to the FN button include turning on/off Genlock synchronization, freeze 
and FTB. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Fn. 
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 FN button settings (P20) 

 

Description 

Select Fn to access the submenu. Select Synchronization, Freeze or FTB to assign 
the selected function to the FN button. 

Set HDCP 

HDCP (High-Bandwidth Digital Content Protection) is a coding scheme used to 
protect audio and video signals traveling through DVI, HDMI, and DP from being 
copied and illegally intercepted during a streaming session. Users can turn on/off 
HDCP for all inputs (including HDMI and DP) or outputs (including output connectors, 
MVR connector and AUX connectors) with one switch. Input and output HDCP are 
turned off by default. 

Note 

SDI does not support HDCP. Output HDCP includes the HDCP for all output 
connectors, MVR connector and AUX connectors. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > HDCP. 
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 HDCP (P20) 

 

Description 

Input HDCP Turn on/off HDCP for all inputs including HDMI and DP. 

 Off (Input HDCP is turned off by default.) 

 On 

Partially On is displayed when HDCP is turned on for some inputs. 

Output HDCP Turn on/off HDCP for all outputs including output connectors, MVR 
connector and AUX connectors. 

 Off (Output HDCP is turned off by default.) 

 On 

Partially On is displayed when HDCP is turned on for some outputs. 

Reset to Factory Settings 

Reset the P20/P20-DS/P10 parameter settings to the factory defaults. 

Note 

 This action does not change the firmware version of the device. 

 Do not disconnect the power supply during the process. 

 After factory reset, the device restarts automatically. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Factory Reset. 
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 Factory reset (P20) 

 

Description 

 Keep User Data 

Reset all the parameters to their default values except the network parameters, 
project files, EDID files, gallery files, and display language. 

a. Select Factory Reset to access the submenu. 

b. Select Keep User Data. 

c. Select OK in the dialog box that appears. 

 Reset All 

Reset all the parameters to default values, except network parameters and project 
files. 

a. Select Factory Reset to access the submenu. 

b. Select Reset All. 

c. Select OK in the dialog box that appears. 

Run Diagnostics 

Run diagnostics for the P20/P20-DS/P10 to identify and troubleshoot problems. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Diagnostics. 
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 Diagnostics (P20) 

 

Description 

Select Diagnostics to access the submenu and select Run. After the diagnostics, 
view the result. 

Import and Export Project Files 

Import project files from a USB drive to the P20/P20-DS/P10 and export project files 
from the P20/P20-DS/P10 to a USB drive. A project file contains configuration files 
and data. 

Prerequisites 

 Before importing a project file, copy the file (.uprj) to the root directory of a USB 
drive and insert the USB drive into the USB port on the front panel of the P20/P20-
DS/P10. 

 Before exporting a project file, insert a USB drive into the USB port on the front 
panel of the P20/P20-DS/P10. 

Notes 

 The USB port on the front panel of the P20/P20-DS/P10 does not support USB 
HUB. 

 The project files for the P20 and P20-DS are not compatible. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Project File. 
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 Project file (P20) 

 

Description 

 Import a project file 

a. Select Project File to access the submenu. 

b. Select Import Project File to open the project file screen. 

c. Select a project file. 

d. In the dialog box that appears, select OK to import the project file in the root 
directory of the USB drive. 

 Export a project file 

a. Select Project File to access the submenu. 

b. Select Export Project File. 

c. In the dialog box that appears, select OK to export the project file to the root 
directory of the USB drive. 

Update Firmware 

Update the firmware of the P20/P20-DS/P10. 

Prerequisites 

Before firmware update, copy the update file (.img) in the root directory of a USB 
drive and insert the USB drive into the USB port on the front panel of the P20/P20-
DS/P10. 

Notes 

 The USB port on the front panel of the P20/P20-DS/P10 does not support USB 
HUB. 

 After firmware update, the device restarts automatically. 
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Menu Orientation 

On the main menu screen, scroll to and select Advanced > Update. 

 Firmware update (P20) 

 

Description 

Select Update to open the update file screen. Select a file and select OK in the dialog 
box that appears. 

Export Logs 

Export logs from the P20/P20-DS/P10 to a USB drive. 

Prerequisites 

A USB drive is inserted into the USB port on the front panel of the P20/P20-DS/P10. 

Notes 

The USB port on the front panel of the P20/P20-DS/P10 does not support USB HUB. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Log Export. 
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 Exporting logs (P20) 

 

Description 

Select Log Export to access the submenu. Select Apply to export the log files to the 
root directory of the USB. 

Set Antistatic 

The P20/P20-DS/P10 support antistatic settings. Users can set the antistatic 
duration according to the actual static electricity, ensuring the display remains 
normal to keep events smooth and successful. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Antistatic. 

 Antistatic 
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Description 

On Turn on/off antistatic. 

 : On 

If the primary source fails, it will freeze on the last frame 
before the failure throughout the specified protection duration. 
The backup source will become active if the failure of the 
primary source remains beyond this duration. 

 : Off 

Upon the failure of the primary source, the backup source will 
become active immediately. 

Duration Set the antistatic duration. The maximum duration is 2s. 

Manage Third-Party Plugins 

The P20/P20-DS/P10 can be controlled from the third-party device Stream Deck. The 
Companion plugin can be updated, turned on/off from the front panel LCD of the 
P10/P20/P20-DS. 

Prerequisites 

The Companion plugin file has been placed in the root directory of the USB drive, and 
the USB drive has been inserted into the USB port on the front panel of the 
P10/P20/P20-DS. 

Notes 

The USB port on the front panel of the P20/P20-DS/P10 does not support USB HUB. 

Menu Orientation 

On the main menu screen, scroll to and select Advanced > Third-Party Plugins. 

 Third-party plugins 
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Description 

Update Plugin 1. Select Update Plugin to access the file list. 

2. Select an update file and select OK in the dialog box that 
appears. 

Companion Turn on/off the Companion plugin. 

 : On 

 : Off 

Mode 

Switch the working mode and layer specification of the device as needed. 

Notes 

 Layer specification switching is only available for the P20/P20-DS. 

 Under both the Switcher and PGM Only modes, the layer specification switching is 
supported. 

 Changing the layer specification will clear the current layer data, but not for AUX 
and MVR. 

 When you switch to 4xMAIN+4xPIP, only two out of the four MAIN layers support 
the cut & fill function. 

 When you switch to 4xMAIN+4xPIP, dynamic range conversion is not supported. 

Menu Orientation 

On the main menu screen, scroll to and select Mode. 

 Mode (P20) 
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Description 

Working Mode Select a working mode for the device. 

 Switcher 

 PGM Only 

Layers 

(P20/P20-DS only) 

Select a layer specification option for the device. 

 2×MAIN+10×PIP 

 4×MAIN+4×PIP 

After an option is selected, ✓ appears at the bottom right, as shown in Figure 6-66. 

About Us 

View the P20/P20-DS/P10 firmware version, the email address and official website 
of PIXELHUE. 

Menu Orientation 

On the main menu screen, scroll to and select About Us. 

 About us (P20) 

 

Language 

Set the display language of the menu. English and Simplified Chinese are available. 

Menu Orientation 

On the main menu screen, scroll to and select Language. 
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 Language (P20) 

 

Description 

Select简体中文 or English. After a language is selected, ✓ appears at the bottom 
right, as shown in Figure 6-68. 

Q8 Menu Operations 

Startup and Shutdown 

To turn on the Q8, connect all the necessary cables and at least two power cords 
properly, and press the power button on the front panel. 

To turn off the Q8, press the button, and a shutdown prompt window appears on the 
LCD screen. Tap Yes to shut down the device. 

Home Screen 

After the startup, the home screen is displayed. 
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 Home screen 

 

Table 6-3 Home screen description 

No. Content Description 

1 Information bar 
 : Device manufacturer logo. 

 Q8: Device model. 

 SYSTEM: Device name, which can be modified on the 
control computer. 

 Device lock status: 

− : The device is locked. 

− : The device is unlocked. 

 192.168.100.100: Device IP address, which can be 
modified on the device LCD or the control computer.  

 : Press the button, and a shutdown prompt window 
appears on the LCD screen. Tap Yes to shut down the 
device. 

2 Input card 
information  

Show the input card and its connector status. 

 Green: The connector is accessed with a source and the 
source is normal. 

 White: The connector is not accessed with source. 

 Gray: The connector is unavailable. 

 Orange: The connector’s accessed source is abnormal. 

 Red: The connector does not support standard resolutions 
or the bandwidth limit is exceeded. 

 Orange box: Copy. 

3 Output card 
information 

Show the output card and its connector status. 

 Green: The connector is connected to the backend device. 
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No. Content Description 

 White: The connector is not connected to the backend 
device. 

 Gray: The connector is unavailable. 

 Red: The connector does not support standard resolutions 
or the bandwidth limit is exceeded. 

 Orange box: Copy. 

4 FRONT PANEL Show the connection status of the Link port on the front 
panel. 

 Green: The connector is connected and working normally. 

 Gray: The connector is not connected. 

5 Power 
connector 

Show the power supply connection status. 

 Green: The connector is connected with a power supply. 

White: The connector is not connected with a power supply 
and the power is not supplied. 

6 Control card 
connector 

Show the card connector status. 

 Green: The connector is connected and works normally. 

 Gray: The connector is not connected. 

 Red: The connector does not support standard resolutions 
or the bandwidth limit is exceeded. 

 Orange box: Copy. 

7 Voltage status Show the device working voltage status. 

 Normal: The voltage of each module in the device is 
normal. 

 Abnormal: The voltage of one or some modules in the 
device is abnormal, and the device needs troubleshooting. 

8 Temperature 
status 

Show the device working temperature status. 

 Normal: The temperature of each module in the device is 
normal. 

 Abnormal: The temperature of one or some modules in the 
device is too high, and the device needs troubleshooting. 

9 Fan status Indicate whether the fan speed is normal when the device is 
working. 

 Normal: The speed of each fan in the device is normal. 

 Abnormal: The speed of one or some fans in the device is 
abnormal, and the device needs troubleshooting. 

10 Settings Tap to enter the device menu where you can perform the 
following device operations. 

 Network settings: Configure the device IP address. 

 Device information: Check the device’s chassis and card 
versions, and fan status. 

 Advanced settings: Perform factory reset settings, 
firmware update, project file import and export, log export, 
AC back settings, fan mode settings, antistatic settings, 
plugin update, lock screen. 
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No. Content Description 

 Language: Set the user interface language. 

 About us: Check the official website and technical support 
email address of the device manufacturer. 

Network Settings 

 On the home screen, tap  located at the bottom right corner to enter the settings 
screen. 

 Select Network to enter the network settings screen. 

 Configure the device IP address information. 

 IP address settings 

 

The device supports both automatic (DHCP) and manual IP configuration. When the 
device is connected via router or switch, DHCP is recommended. The router or switch 
will automatically assign IP address to the device. When the network mode is set to 
Manual, you need to set IP Address, Subnet Mask and Gateway. 

 Note 

When manually configuring the IP address, the device IP address and the control 
computer IP address must be on the same network segment.  

 Tap Apply to complete the settings. 

Device Information 

On the Device screen, you can check the power voltage status, card temperature, 
version and serial number (SN), and fan running status of the device.  
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 Device information 

 

Two ways to enter the Device screen: 

 On the home screen, tap  located at the bottom right corner to enter the 
settings screen. Then, tap Device on the left. 

 On the home screen, tap the icon in the status bar on the right to enter the 
corresponding screen under Device. 

− : Displays the voltage status of the connected power supply. Tap this icon 
to enter the Voltage screen under Device, where you can check the 
connection status of the three power supplies and whether the power 
connector voltage is normal. 

− : Displays the device card temperature. Tap this icon to enter the Card 
screen under Device, where you can check the card temperature, version and 
SN. 

− : Displays whether the device fans are running normally. Tap this icon to 
enter the Fans screen under Device, where you can check the status of all the 
device fans. 

Advanced Settings 

In advanced settings, you can do the following operations: 

 Factory reset 

 Update firmware 

 Import and export project files 

 Export log files 

 Set the device status after AC power back 

 Select a fan mode 

 Configure electrostatic protection 
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 Update the plugin 

 Set device lock 

On the home screen, tap  located at the bottom right corner to enter the settings 
screen. Then, tap Advanced to enter the advanced settings screen. 

 Advanced settings 

 

Factory Reset 

This function is used to quickly clear the data saved in the device. All parameters will 
be restored to the default values. 

 Keep User Data: During factory reset, the network configuration, EDID files, gallery, 
device name and language settings will be kept, while other parameters will be 
restored to the default values.  

 Reset All: All device parameters will be restored to the default values. 

Update Firmware 

The Q8 supports firmware update via USB drive. To do that, save the update file in the 
root directory of the USB drive and then insert the drive into the USB port on the 
control card of the Q8. 

On the Advanced screen, tap Update to enter the firmware update screen and the 
system will automatically detect and read the update file in the USB drive. 
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 Firmware update 

 

Select the target update file, tap Update, and the system will automatically update the 
device. 

The device will automatically restart during the update. 

Import and Export Project Files 

The Q8 supports import and export of configured project information via USB drive, 
allowing you to quickly complete device configuration. 

 To import project files, save the files in the root directory of the USB drive and then 
insert the drive into the USB port on the control card of the Q8. 

 To export project files, insert the USB drive that is used to save the files into the 
USB port on the control card of the Q8. 

On the Advanced screen, tap Projects to enter the project file import and export 
screen. 
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 Importing and exporting project file 

 

 Importing project file: Tap Import File, and the system will automatically read the 
project files in the USB drive. After selecting the target file, tap OK, and the system 
will automatically import the file to the device. After the import is complete, the 
device will automatically restart. 

 Exporting project file: Tap Export File, and the system will automatically export the 
current configured project file to the selected USB drive. 

Export Logs 

The Q8 supports export of the device running logs via USB drive. When the device 
has an exception, the logs can help you quickly troubleshoot the problem. 

To export logs, insert the USB drive that is used to save the logs into the USB port on 
the control card of the Q8. 

On the Advanced screen, tap Logs to enter the log export screen. 
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 Exporting logs 

 

Tap Log Export to export the device logs to the selected USB drive.  

Set Device Status After AC Back 

Set whether the device automatically powers on after the power is supplied. 

 AC back 

 

 Power On: After the power is supplied, the device automatically powers on. 

 Power Off: After the power is supplied, the device remains in the power-off state. 
To power on the device, press the power button on the device front panel. 

 Last State: After the power is supplied, the device remains in the last state. 
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Fan Mode 

On the Fan Mode screen, select the appropriate mode based on the different 
operating scenarios of the device. 

 Fan mode 

 

 Silent Mode: Achieves a quieter operating environment. 

 Power Mode: Provides enhanced heat dissipation. 

 Note 

When operating in power mode, the device noise level may be higher, potentially 
reaching up to 55 dB (A).  

Electrostatic Protection 

The Q8 provides an electrostatic protection feature, effectively preventing issues 
such as unstable input or frequent input disconnection due to static electricity. 

On the Advanced screen, tap Electrostatic Protection to access the settings. 
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 Electrostatic protection 

 

Choose to turn on or off the switch (off by default) and set the electrostatic 
protection duration. 

 On: If the primary source fails, it will freeze on the last frame before the failure 
throughout the specified protection duration. The backup source will become 
active if the failure of the primary source remains beyond this duration. 

 Off: Upon the failure of the primary source, the backup source will become active 
immediately. 

Plugin 

The Q8 can run the Companion plugin, enabling the third-party device Stream Deck to 
intelligently control the Q8 through simple configuration. 

On the Advanced screen, tap Plugin to enter the plugin screen. 
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 Plugin 

 

The Q8 supports plugin update via USB drive. To do that, first save the update file in 
the root directory of the USB drive, and then insert the USB drive into the USB port on 
the control card of the Q8. 

 Update: Click Update, and the system will automatically read the plugin files from 
the USB drive. Select the desired plugin file and click OK to proceed with the plugin 
update. 

 Companion: Click the Companion icon to launch the Companion plugin. The plugin 
status will update from Inactive to Running, indicating that the plugin has been 
activated. 

Lock Screen 

The Q8 offers a front panel LCD screen lock feature, including automatic and 
scheduled lock modes. Once enabled, it helps prevent accidental operations due to 
unintended touches, enhancing the device’s security and stability. 
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 Lock screen 

 

 Manual lock: Tap the  icon in the upper right corner of the home screen to 
lock the screen. 

 Automatic lock: On the Lock Screen interface, tap to enable Auto Lock, and set 
the lock screen time. 

 Auto lock 

 

 Notes: 

When performing an automatic lock, ensure all interface pop-ups are closed; 
otherwise, the screen will not lock automatically even if the set time has elapsed. 
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 Unlock: Tap the screen on the home screen, and when the slide button appears, 
swipe up to unlock. 

 Unlock 

 

Language 

The Q8 supports both Chinese and English UI languages. You can change the 
language on the Language screen. 

About Us 

On the About Us screen, you can check the device system version and the device 
manufacturer related information. 
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7 Event Management Software PixelFlow 

About This Chapter 

This chapter provides a detailed description of each section of the event 
management software PixelFlow, as well as a step-by-step approach to configure the 
projects, devices, screens, layers, Multiviewer, presets and more. 

Overview 

 Software Installation and Connection 

 Project Management 

 Device Management 

 Screen Configuration 

 Layer Operations 

 Multiviewer (MVR) 

 Audio Matrix 

 Tools 

 Simulation Event Controller 

 Software Settings 

 Notes: 

 The device in this chapter refers to the P80, P20, P20-DS, P10 or Q8 seamless 
switcher. 

 The software pictures given in this chapter are used for illustration purposes 
only. The actual user interface may vary slightly due to product enhancement. 
The content of the pictures can be slightly different from reality, such as the 
form and position of the software windows, input source images and more. 

 



All-New Event Presentation Switching Solutions 

User Manual 7 Event Management Software PixelFlow 

 

www.pixelhue.com 156 
 

Software Installation and Connection 

Software Installation 

Prerequisites 

 The software package is obtained. 

 A computer meeting the following requirements is prepared: 

Windows: 

− Operating System: Windows 10 (64-bit) or above 

− CPU: 12th Generation Intel i7 processor or above 

− Memory: 16 GB or above 

Mac OS:  

Mac OS 10.14 or above 

Installation Method 

Run the .exe file and follow the setup wizard to complete the installation. If a firewall 
prompt appears, choose to allow the installation. 

Installation Result 

After a successful installation, the PixelFlow software icon  is displayed on the 
desktop. Double click this icon to open the PixelFlow software. 

Software Connection 

The PixelFlow software is installed on the control computer. The control computer 
can connect to the device in the following two ways: 

 Via Ethernet cable 

Connect the device and the control PC directly via Ethernet cable and set a static 
IP address for the device to let it and the control PC be on the same network 
segment. 

 Via LAN 

Connect the device and the control PC to the same LAN via a router and set the 
device to automatically obtain an IP address. 

Project Management 
Create, edit, and dissolve projects. Project files (.uprj) can be exported from the 
current device and imported into others, promptly applying device parameters and 
resource files. 
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Create New Projects 

Devices of the same series on a local network are automatically added to a default 
project. Users can create additional projects and move online devices from the 
default project to new ones. Furthermore, simulation projects can be created to 
simulate real device configurations and understand the product better. 

 Open the software and access the main interface. 

 Project 

 

 Create an online project or simulation project. 

 Online Project: Create a project for online devices. Select the Online Project tab in 
the top left and click New Project in the top right. Enter the project name in the 
popup window and click OK. 

 New projects 
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 New online projects 

 

 Simulation Project: Create a project for simulation devices. Select the Simulation 
Project tab in the top left and click New Project in the top right. Enter the project 
name in the popup window and click OK. 

Click Add simulation devices, set the device name, model, and IP address in the 
dialog, then click OK to add it to the list. 

 New simulation devices 

 

For online projects, devices of the same series are automatically grouped under one 
project. When adding simulation devices, only devices of the same series can be 
included in a single project. 
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 Devices of same series in a single project 

 

 Note 

 In the project list area, you can perform the project-related operations. 

− Edit project: Click Edit to rename the project. 

− Export project: Click Export to export the online project file. Simulation 
projects do not support exporting. 

− Dissolve project: Click Dissolve to delete the current project. In a simulation 
project, all simulation devices are automatically deleted; in an online project, 
all online devices are moved to the default project. 

− Enter project: Click Enter to enter the device configuration interface. 

 Due to hardware design differences, the P80 cannot be included in the same 
project with the P10, P20, or P20-DS devices. 

 

 Move devices between projects. 

Expand the project list, hover over the target device, and click Move or manually drag 
it to another project. 

 Move: Choose the target project in the popup window, then click OK. 

 Moving devices 

 

 Manual drag: Manually drag to another project and click Yes in the popup. 
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 Moving devices 

 

 Note 

Devices of the same series can only be added into one project.  

Import Projects 

Import the local project files (.uprj) to the device. 

 Select the Online Projects or Simulation Projects tab, and click Enter access the 
device configuration interface. 

 Navigate to File > Import from the menu bar. 

 In the dialog box that appears, select a project file (.uprj) and click OK. 

 Note 

Simulation project files can be imported into online projects.  

 In the displayed Import Project File window, select Online Projects or Simulation 
Projects. 

 Import project files 

 

 After successful device matching, select the data to be imported and click OK. 

The software matches the SN, name, IP address, model, and firmware version from 

the file with the online or simulation device. Click  to modify the match: 

 For online devices, select other online devices from the drop-down menu. 
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 For simulation devices, choose to create a new simulation device. Ignore the 
current device, or select another simulation device from the drop down menu. 

Export Projects 

Export the device project files to your local computer. 

 Select the Online Projects or Simulation Projects tab, and click Enter access the 
device configuration interface. 

 In the menu bar, navigate to File > Export. 

 In the displayed dialog box, select the desired data. 

 Export project files 

 

 Click Export. 

 In the displayed dialog box, select a file path and click Save. 

Device Management 

Enter Device Configuration Page 

Online Devices 

 Select the Online Projects tab. 
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 Online device list 

 

 If the device is not logged in, click Login. In the dialog box that appears, simply click 
Login (keeping the default values for username and password). If the device is 
already logged in, skip this step. 

 After logging in, view the device name, IP address, and model. Double click the device 
front panel image or click Enter on the right side of the project list to access the 
device configuration interface. 

Simulation Devices 

Simulation devices, without any physical connections, simulate real device 
configurations, enabling users to easily utilize and understand the software. 

 Select the Simulation Projects tab. 

 Click Add simulation devices. 

 Simulation device list 

 

 In the pop-up dialog, set the device name, model, and IP address, and click OK.  

Once created, the device will be displayed in the list and will be in the default started 
state. 

 : The device is started. 

 : The device is off. 

 Note 

For devices in the project list, you can perform the following operations: 

 Start all devices: Click Start All. 

 Shut down all devices: Click Shut Down All. 
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 Shut down device: Click Shut Down. 

 Start device: Click Start. 

 Edit device: Click Edit. Once the simulation device is started, editing is not 
allowed. To make changes, you must shut down the device first. 

 Move device: For an active device, click Move, choose the target project in the 
popup, and click OK. 

 Delete device: Click Delete. 
 

 Add simulation devices 

 

 After creation, you can view the device status, name, IP address, and model. 

 Double click the device front panel image or click Enter on the right side of the 
project list to access the device configuration interface. 

 Hover over the device information to start, shut down, edit (modify device name, 
IP address), move, or delete the device. 

 

Configure Device Properties 

Select the device on the left side of the device configuration interface, and then 
configure the device-related properties on the right pane. 
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 Device properties (P20) 

 

 Note 

 The Q8 online devices will also display CXP/QSFP, LINK IN, LINK OUT, and OPT 
ports, which the virtual devices do not show. 

 For the P80, click Front Panel located at the top right of the rear panel to view 
USB 2.0 port status.  

Rename Device 

Change the device name. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 
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Description 

Enter a name for the device in the text box next to Device Name. 

 Note 

In the device list on the left side of the interface, you can also right click the device 
name and select Rename from the context menu to change the device name as well.  

Switch Working Mode 

When the device supports dual working modes (Switcher and PGM Only), you can 
switch to either mode that satisfies your actual needs. 

Applicable Products 

P20, P20-DS, P10 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

Select Switcher or PGM Only from the drop-down list. 

Switch Layer Specification 

The device supports dual layer specification options, and you can switch to either 
specification that satisfies your actual needs. 

Applicable Products 

P20, P20-DS 

Prerequisites 

None 

Notes 

 Under both the Switcher and PGM Only modes, the layer specification switching is 
supported. 
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 Changing the layer specification will clear the current layer data, but not for AUX 
and MVR. 

 When you switch to 4xMAIN+4xPIP, only two out of the four MAIN layers support 
the cut & fill function. 

 When you switch to 4xMAIN+4xPIP, the HDR format conversion function is not 
supported. 

Interface Example (P20) 

 

Description 

Select 2xMAIN+10xPIP or 4xMAIN+4xPIP from the drop-down list. 

Configure IP Address 

Manually set a static IP address for the device or let the device to automatically 
obtain an IP address. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

Configure the following parameters and click Apply to make the settings take effect. 
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Parameter Description 

Network Mode Select the IP configuration method. 

 Manual: Manually set a static IP address for the device. 

 DHCP: The device automatically obtains an IP address. 

IP Address The device IP address 

Subnet Mask The subnet mask of the IP address 

Gateway The default gateway 

Configure Sync Source 

Enable the sync function and configure the sync source for the output. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 Before enabling the Genlock sync function, make sure the sync signal has been 
connected to the Genlock connector of the device. 

 If the device model is Q8, make sure the screen has already been created. 

Notes 

If the device model is Q8, manual setting of the output frame rate is supported. 

Interface Example (Q8 and P80) 
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Description (Q8) 

Parameter Description 

Sync To Turn off the sync function; or turn on the function and then 
select the sync source. 

 Freerun: Turn off the sync function. 

 Genlock: Sync with the frame rate of the accessed Genlock 
signal. 

 IN-X: Sync with the frame rate of the selected input source.  

When the function is enabled, the frame rate of the sync 
source will be displayed. 

Multiplier Select the frame rate multiplier. 

 ×1: Final synchronized frame rate = Sync source frame rate 
× 1 

 ×2: Final synchronized frame rate = Sync source frame rate 
× 2 

Description (P80) 

Parameter Description 

Internal Frame Rate Select the desired internal frame rate from the drop-down list. 

Genlock Out Select to sync to Genlock or the selected internal frame rate. 

Screen 1/2/3/4 Sync To Turn off the sync function; or turn on the 
function and then select the sync source. 

 Freerun: Turn off the sync function. 

 Genlock: Sync to the frame rate of the 
accessed Genlock signal. 

 Internal Frame Rate: Sync to the selected 
internal frame rate. 

 IN-X: Sync to the frame rate of the selected 
input source. 

When the function is enabled, the frame rate of 
the sync source will be displayed. 

Multiplier Select the frame rate multiplier. 

 ×1: Final synchronized frame rate = Sync 
source frame rate × 1 

 ×2: Final synchronized frame rate = Sync 
source frame rate × 2 

Configure Output Mapping 

Turn on or turn off the output mapping function. If turned on, each output displays its 
slot number in the loading area of the screen. 
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Applicable Products 

Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (Q8) 

 

Description 

Parameter Description 

Mapping Turn on or turn off the function. 

 : On 

 : Off 

 Note 

In the device list on the left side of the interface, you can also right click the device 
name and select Mapping from the context menu to enable or disable the mapping 
function as well.  

Configure HDCP 

Configure the global HDCP settings for all connectors of the device. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 
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Description 

Parameter Description 

Input/Output Turn on or turn off the function. 

 : On 

 : Off 

 Note 

The HDCP function is disabled by default. 
 

Configure Date and Time 

Configure the time zone, date and time of the device. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

Click Edit and the parameters become editable. Set the time zone, date and time 
respectively, and then click Apply. 

Configure Device Backup 

Enable the device backup function for the screen. 

For screens with the device backup function turned on, when a layer's input source 
has no signal or does not exist, all output connectors of the screen will immediately 
stop outputting any signal, and switch to the backup link together with the sending 
cards and receiving cards. 
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

The Multiviewer signal is not affected by device backup function. 

Interface Example (P20) 

 

Description 

Parameter Description 

Device Backup Turn on or turn off the function. 

 : On 

− All: Select all screens. 

− Specific screen name: Select the desired screen. 

 : Off 

Electrostatic Protection 

Configure the antistatic duration according to the actual static electricity, ensuring 
the display remains normal to keep events smooth and successful. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 
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Interface Example (P20) 

 

Description 

Parameter Description 

Electrostatic 
Protection 

Turn on or turn off the function. 

 : On 

If the primary source fails, it will freeze on the last frame 
before the failure throughout the specified protection 
duration. The backup source will become active if the 
failure of the primary source remains beyond this duration. 

 : Off 

Upon the failure of the primary source, the backup source 
will become active immediately. 

Duration Set the antistatic duration. 

Fan Mode 

Select the appropriate mode based on the different operating scenarios of the 
device. 

Applicable Products 

P80, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P80) 

 

Description 

Parameter Description 

Silent Mode For a quieter operating environment 
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Parameter Description 

Power Mode For enhanced heat dissipation 

Configure Display Effect Sync 

The function ensures the MVR, SDI matrix and PGM display accurately mirrors the 
output's visual state in real-time, enabling users to make precise decisions. Crucially, 
it maintains a stable preview feed during output anomalies, allowing users to monitor 
recovery and swiftly restore normal operation. 

Applicable Products 

P80 

Prerequisites 

None 

Notes 

None 

Interface Example (P80) 

 

Description 

Once enabled, the MVR, SDI matrix and PGM display will mirror all output effects, 
including color, test pattern, FTB, and edge blending, allowing operators to monitor 
image in real time. 

Parameter Description 

Display Effect Sync Turn on or turn off the function. 

 : On 

 : Off 

Reset to Factory Settings 

Reset the device data and settings to factory default values. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 
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Notes 

 Please do this with great caution. 

 The reset action does not affect the device firmware version. 

 Power-off is not allowed during the reset process. 

 The device will restart automatically after the reset is completed. 

Interface Example (P20) 

 

Description 

Select Retain user data, Retain IP only, Reset all, and then click Apply. 

 Retain user data 

Retain the device IP address, input connector EDID, gallery files, language settings, 
device name and belonged project. 

 Retain IP only 

Retain the device IP address only. 

 Reset all 

Retain the device IP address and belonged project. 

Shut Down or Restart Device 

Shut down the device, or restart the device. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 
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Description 

Click Restart or Shut Down, and then click Yes in the displayed dialog box. 

Configure Input Source Backup 

Establish a backup relation for two input sources. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The input sources include common input sources, mosaic sources, and cropped 
sources. 

Notes 

 Supports one-to-one and many-to-one backup between primary and backup 
sources. Cross-level backup (i.e., indirect backup relationships) is not supported. 

 Primary and backup sources can be independently used to open layers. 

 Backup can only be set when the input connector capacities are the same. 

 A cropped source and its parent source are not allowed to establish a backup 
relationship. 

 The same input source can act as the primary source in one backup relationship 
only. 

 After setting up a backup relationship, changing the connector capacity or 
connector type will terminate the backup relationship. 

Interface Example (P20) 

 

Description 

 Select the Input Backup tab. 

 Toggle the Backup Status switch to . 

 Click Add. 
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 Select a primary source and a backup source respectively from two drop-down lists 
to establish a backup relationship. 

The green dot  indicates the source is accessed normally and ready for use. 

 To delete a backup pair, click  next to the pair and click Delete.  

 To delete all backup pairs, click . 

 Click  on the right and configure the status of Primary Source Preferred or Auto 
Switch as needed. 

When Auto Switch is enabled, the following principles apply when the primary source 
transitions from no signal to having a signal; when disabled, the system will use the 
specified source regardless of whether there is a signal or not. 

 If Primary Source Preferred is enabled, the system will automatically switch to the 
primary source once it is restored. 

After manually switching to an online backup source, Primary Source Preferred 
will automatically be disabled. 

 If Primary Source Preferred is disabled, the system will not automatically switch 
when the primary source is restored and will continue using the backup source. 

 Note 

For input sources with backup configured, in the Programming interface, hover the 
mouse over the input source and then click . In the pop-up dialog box, you can set 
the status of Auto Switch and manually switch the input source.  

Configure Input Properties 

Click the target input connector on the graphical device rear panel (if you need to 
configure the card properties, please click the desired card on the rear panel), and 
then set the input-related properties in the property area on the right pane. 

 Input properties (P20) 
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View Input Card Info 

View the input card related information. 

Applicable Products 

P80, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (Q8) 

 

Description 

None 

Configure Input Card Properties 

Configure the input connectors to be used, connector capacity (resource usage) and 
deinterlacing function. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The connector capacity is available on the P20, P20-DS and P10. 

 The deinterlace configuration is applicable to Q_4xHDMI2.0+4xDP1.2+4x12G-SDI 
Input Card of the Q8. 

 The PTP configuration is applicable to Q_2xST2110(25G) Input Card of the Q8. 

 The connector selection and deinterlaced signal distribution is applicable to 
Q_1xST2110(100G)+2xHDMI2.1/DP1.4 Input Card of the Q8. 

Notes 

 If the connector is set to be NOT used: 
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− The corresponding layers on the main, flex and AUX screens will become 
empty layers. 

− Some connector properties will be restored to defaults, such as resolution 
and color parameters. 

 If the connector capacity is switched: 

− The corresponding layers on the main screens will become empty layers, and 
the DSK function will be turned off. 

− Some connector properties will be restored to defaults, such as resolution 
and color parameters. 

 For the P80, each input card is configured to choose between the HDMI and DP 
connectors. 

Interface Example (Q8) 

   

Description 

 Switch the connector capacity. 

Select the desired connector capacity the drop-down list. 

 Select the connectors to be used. 

The connector status descriptions are as follows: 

− : Selected 

− : Not selected 

If an MVR connector is selected, an MVR source can be added to the screen when 
adding a layer. 

 Set the deinterlacing function. 

Click the Deinterlace icon. 

− : On 

− : Off 
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 PTP settings 

Configure PTP for OPT ports 1-2 or 3-4 on Q_2xST2110(25G) Input Card. 

− : Enable PTP synchronization. 

− : Disable PTP synchronization. 

− Domain: Set the PTP domain number. 

After the settings, click Apply. 

View Input Source Info 

View the basic properties of the input connector and change the input connector 
name. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

A fine signal is connected to the input connector. 

Notes 

None 

Interface Example (Q8) 

 

Description 

On the Basic tab interface, change the connector name as required. 

Configure Input HDCP 

Enable or disable the input HDCP encryption.  
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

Parameter Description 

HDCP Turn on or turn off the function. 

 : On 

 : Off 

 Note 

The input HDCP is disabled by default. 
 

Configure InfoFrame Override Parameters 

Configure the InfoFrame override parameters of the input source, so that the device 
can use it when doing some calculations. This action does not change the parameter 
values that come with the input source. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 When setting HDR format conversion parameters, the device models must be P20, 
P20-DS and Q8, and the connector type must be HDMI 2.0. 

 Only Q8 supports configuring 3D video source format. 

Notes 

When Color Space/Sample is set to YCbCr, Gamut cannot be selected as DCI-P3. 
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Interface Example (Q8) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Type Parameter Description 

General 
parameters 

Color 
Space/Sample 

The sampling format of the input 

Bit Depth The bit depth of the input, i.e., the binary digits to 
represent a single color 

Quantization 
Range 

The quantization range of the input 

HDR parameters Dynamic Range The HDR format of the input  

Gamut The color gamut standard of the input 

Peak Brightness When the Dynamic Range parameter is set to 
HDR10 or HLG, this parameter is available.  

Ambient 
Illuminance 

When the Dynamic Range is set to HDR10 or 
HLG, this parameter is available. 

3D parameters Video Source 
Format 

The format of the 3D video source 

Select the appropriate format based on the 
actual situation. The options include Frame 
Sequential, Top-and-Bottom, Side-by-Side, Auto 
and None. 

Eye Priority This parameter is displayed when Video Source 
Format is set to Frame Sequential. 

Select From Input and the device will read the attribute values that come with the 
input source. 

Configure Input Gain 

In instances where DP/HDMI cable degradation is excessive, adjusting the gain 
parameters can enhance connector performance. 
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Applicable Products 

Q8 

Prerequisites 

This feature is accessible by entering the developer mode, activated by 
simultaneously pressing Ctrl+Shift+Alt+D. 

Notes 

The HDMI connector only supports adjustment of the EQ Compensation parameter, 
while the DP connector allows all parameter adjustments. 

Interface Example (Q8) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Swing/Pre-emphasis The options include Adaptive and Drive Enhance. 

 Adaptive: Suitable for input sources that do not support 
drive enhancement 

 Drive Enhance (default): Suitable for standard cable 
lengths and environments 

Swing Adjust Set the swing adjustment gear. 

CDR Enhance Set the CDR enhancement gear, suitable for environments 
with high interference. 

EQ Compensation Set the EQ compensation gear to rectify signal transmission 
issues. Greater signal degradation necessitates higher 
compensation, but excessive compensation may cause 
distortion. Adjust incrementally according to the 
environment. 

Configure EDID 

Configure the resolution and frame rate of the input. You can select the standard 
resolution provided by the device, customize a resolution, or set the advanced 
parameters. 
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The front-end device outputs the video source from the graphics card. 

 The input connector must be DP 1.2 or HDMI 2.0. 12G-SDI does not support this 
function. 

Notes 

 It is recommended the advanced settings be carried out by the trained personnel 
only. 

 Only the Q8 supports setting and display of the monitor name. 

 Only the Q8 and P20-DS support audio configuration. When HBlank is less than 
110, the audio function cannot be enabled. 

Interface Example (Q8) 

 

Description 

On the EDID tab interface, configure the following parameters and click Apply after 
the settings. 

Parameter Sub-Parameter Description 

Monitor - Display and modify the monitor name. 

Mode - The options include Standard, Custom and 
Advanced. 

Standard Resolution The number of horizontal pixels and vertical pixels of 
the image 

Config method: Select the desired resolution from 
the drop-down list. 

Frame Rate The image frames per second (unit: Hz) 

Config method: Select the preset common frame 
rates from the drop-down options. The available 
frame rates may vary according to the chosen 
resolution. 
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Parameter Sub-Parameter Description 

Audio Turn on or off the audio function. 

Custom Width The horizontal pixels of the image 

Height The vertical pixels of the image 

Frame Rate The image frames per second (unit: Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration of the 
horizontal and vertical blanking intervals in the video 
signal to ensure synchronized image display 

Options include Standard, CVT-RBv1, CVT-RBv2, and 
CVT-RBv3. 

HBlank Horizontal blanking parameter to complete the 
current line scan and prepare for the next one. 

 When Standard is selected for Reduced Blanking, 
HBlank is displayed but cannot be adjusted. 

 When CVT-RBv1 is selected for Reduced Blanking, 
HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced Blanking, 
HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced Blanking, 
HBlank is adjustable, ranging from 80 to 200. 

Audio Turn on or off the audio function. 

Advanced H Total Total pixel count per line 

H Active The horizontal size in pixels of the active area 

H Front Porch The offset between the end of the active area and the 
beginning of the H sync 

H Sync The horizontal sync width in pixels (or between 
pixels) 

H Polarity The polarity of the horizontal sync pulse 

V Total Total pixel count per column 

V Active The vertical size in pixels of the active area 

V Front Porch The offset in lines between the end of the active 
output area and the beginning of V sync 

V Sync The vertical sync width in rows (or between rows) 

V Polarity The polarity of the vertical sync pulse 

Frame Rate The image frames per second (unit: Hz) 

Audio Turn on or off the audio function. 
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Import and Export EDID 

When compatibility problem occurs on an input connector, import an intact EDID file 
into the device; or export an EDID file from a device and provide the EDID file to other 
devices or input connectors to solve the compatibility issues. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The input connector must be DP 1.2 or HDMI 2.0. 12G-SDI does not support this 
function. 

Notes 

Each input connector supports importing one EDID file only and the EDID file must be 
less than 1 MB. 

Interface Example (P20) 

 

Description 

 EDID Import 

On the EDID tab interface, click EDID Import. In the dialog box that appears, select 
an EDID file and click Open. 

 EDID Export 

On the EDID tab interface, click EDID Export. In the dialog box that appears, select 
a path and click Save. 

 Note 

If you need to modify the content of an imported EDID file, just modify it and then re-
import it to overwrite the original one.  

Mac Settings 

If the device is incompatible with the Mac system's EDID, you can enable the Mac 
compatibility feature to resolve the issue. When using a Mac computer for output, 
configuring Mac mosaic will automatically produce a mosaic display. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 
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Prerequisites 

None 

Notes 

 Ensure the connector timing is the same as the input source before enabling Mac 
mosaic. 

 A mosaic group can be used by up to two input sources. 

Interface Example (P20) 

 

Description 

On the EDID tab interface, configure the following parameters and click Apply after 
the settings. 

Parameter Description 

Mac EDID 
Compatibility 

Turn on or turn off the function. 

 : On 

 : Off 

Mac Mosaic Set Mac mosaic method, including None, Left, and Right. 

Mosaic Group Set Mac mosaic group (1~16). When the mosaic method is set to 
None, Mosaic Group cannot be set. 

Configure OPT Parameters 

Configure the OPT port parameters of the ST 2110 related cards. 

7.3.3.10.1 Configure OPT Port Stream Parameters 

Configure the destination IP, port, source IP and more parameters. 

Applicable Products 

Q8 

Prerequisites 

 The input connector is an OPT port. 

 If you need to configure parameters by importing an SDP file, you must prepare 
the SDP file (.sdp) in advance. 
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Notes 

None 

Interface Example (Q8) 

  

Description 

 25G OPT ports: Select the Stream tab on the right pane, configure the following 
parameters as needed and click Apply. 

− Configure the parameters by importing an SDP file 

Click SDP File, select the SDP file from the window that appears, and click 
OK. 

− Manually configure the parameters 

Click Advanced and configure the following parameters as needed. 

Type Parameter Description 

Primary OPT Destination IP The destination IP of the video stream for 
the primary OPT port 

Port The destination port of the video stream for 
the primary OPT port 

Source IP The source IP of the video stream for the 
primary OPT port 
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Backup OPT Destination IP The destination IP of the video stream for 
the backup OPT port 

Port The destination port of the video stream for 
the backup OPT port 

Source IP The source IP of the video stream for the 
backup OPT port 

Advanced 
Source 
Information 

Resolution The resolution of the video stream 

Frame Rate The frame rate of the video stream 

Color Space/Sample The color space and sampling rate of the 
video stream 

Bit Depth The bit depth of the video stream 

Interlaced/Progressive The scanning method of the video stream 

 100G OPT ports: Select the Input Source tab in the right pane, select the target ST 
2110 source, and select the Stream tab to configure the following parameters as 
needed. 

− Configure the parameters by importing an SDP file. 

Click Load SDP File, select the SDP file from the window that appears, and 
click OK. 

− Manually configure the parameters. 

Click Edit and configure the following parameters as needed. After the 
configuration, click OK and then click Export SDP to export the current 
configuration as an SDP file. 

Type Parameter Description 

Primary OPT Destination IP The destination IP of the video stream for the 
primary OPT port 

Port The destination port of the video stream for 
the primary OPT port 

Source IP The source IP of the video stream for the 
primary OPT port 

Backup OPT Destination IP The destination IP of the video stream for the 
backup OPT port 

Port The destination port of the video stream for 
the backup OPT port 

Source IP The source IP of the video stream for the 
backup OPT port 

Advanced 
Source 
Information 

Resolution The resolution of the video stream 

Frame Rate The frame rate of the video stream 

Color Space/Sample The color space and sampling rate of the 
video stream 

Bit Depth The bit depth of the video stream 
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7.3.3.10.2 Configure OPT Port IP Addresses 

Configure the network settings for the primary and backup OPT ports.  

Applicable Products 

Q8 

Prerequisites 

The input connector is an OPT port. 

Notes 

None 

Interface Example (Q8) 

  

Description 

 25G OPT ports: On the Stream tab interface in the right pane, configure the 
following parameters and click Apply. 

 100G OPT ports: On the ST 2110 tab interface in the right pane, configure the 
following parameters and click Apply. 

Parameter Description 

Network Mode The configuration method for the OPT port 

 Manual: Manually configure a static IP address for the OPT 
port. 

 DHCP: The OPT port obtains the IP address automatically. 

IP Address The IP address of the OPT port 

Subnet Mask The subnet mask of the OPT port 
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Gateway The default gateway of the OPT port 

7.3.3.10.3 Configure PTP 

PTP settings synchronize the clocks of all audio and video devices within the 
network, ensuring that separately transmitted audio, video, and auxiliary data can be 
precisely aligned and presented at the receiving end. 

Applicable Products 

Q8 

Prerequisites 

The input connector is an OPT port (100G). 

Notes 

None 

Interface Example (Q8) 

 

Description 

Parameter Description 

Lock Input to PTP Turn on or turn off the function. 

 : On. The input is locked to PTP, which enables high-
precision synchronization with the network's master 
clock. 

 : Off. The input is not locked to PTP. 

Leader/Follower Defaulted as a slave clock, which cannot be modified 

Domain PTP domain number, used to distinguish different PTP clock 
domains 

Announce Interval Time interval for announce messages 
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Sync Interval Time interval for sync messages 

Daley Request Interval Time interval for delay request messages 

Master Clock MAC MAC addr4ess of the PTP master clock 

Time Lock Status PTP master clock synchronization status 

Offset from Leader Time difference between the master and slave clock 

7.3.3.10.4 Configure FEC 

FEC enhances video signal transmission reliability by automatically detecting and 
correcting errors. 

Applicable Products 

Q8 

Prerequisites 

The input connector is an OPT port (100G). 

Notes 

None 

Interface Example (Q8) 

 

Description 

Parameter Description 

Status Turn on or turn off the function. 

 : On 

 : Off 

FEC feature must be enabled on the switch and its status must 
match the device's before optical streaming can begin. 

7.3.3.10.5 Check IGMP 

Check the IGMP multicast protocol version number. 

Applicable Products 

Q8 

Prerequisites 

The input connector is an OPT port (100G). 
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Notes 

None 

Interface Example (Q8) 

 

Description 

View the IGMP multicast protocol version number. 

Configure Input Color 

Set the image quality parameters of the input connector, so that all video sources 
connected to it will display the same image quality. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

The gamma adjustment is applicable to P80 and Q8 only. 
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Interface Example (Q8) 

 

Description 

On the Effect tab interface, configure the following parameters. 

Parameter Description 

Contrast The ratio of the luminance of the brightest color to that of the 
darkest color 

Adjust the contrast value either as a whole or individually adjust 
the RGB components. 

Brightness The shading of lights in the image 

Adjust the brightness value either as a whole or individually adjust 
the RGB components. 

Hue The relative degree of how bright or dark the input source image is 

Saturation The color purity of the image 

The higher the value, the more vivid the color. 

Gamma Adjust the gamma value. 

Configure DSK 

Achieve the luma, chroma or smart keying effect on the input source. 
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Applicable Products 

Q8 

Prerequisites 

A fine signal is connected to the input connector. 

Notes 

None 

Interface Example (Q8) 

 

Description 

On the DSK tab interface, configure the following parameters. 

Type Parameter Description 

Function 
switch 

DSK Turns on or turn off the function. 

 : On 

 : Off 

Description: 

 Smart: Suitable for standard keying scenarios. This 
feature reduces the need for parameter adjustments, 
facilitating a more convenient and swift fulfillment of 
user requirements for image keying. 

 Luma: Suitable for application scenarios where the 
brightness of the background is significantly smaller 
than that of the foreground. The result of luma key is 
that the background becomes transparent and the 
foreground is keyed out. 

 Chroma: Suitable for application scenarios with a 
single background color, such as blue/green screen 
matting 
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Type Parameter Description 

Smart key 
parameters 

Pick The RGB values of the pick point 

 Config method 1: Click Pick, and then click the 
position to be picked in the input source image. 

 Config method 2: Set the coordinates of the pick 
point in the input source image. 

 Config method 3: Set the RGB values of Background 
Point. 

After the settings, click Apply. You can also adjust the 
following parameters to optimize the keying effect. 

Matting 
Strength 

To adjust the intensity with which the background is 
processed 

Gain Adjust To adjust the shadow/noise areas present in the 
foreground 

Luma key 
parameters 

Clip To distinguish between the foreground and 
background 

Smooth The hue softness of the transition area  

The larger the value, the softer the transition. 

Foreground 
Color 

Turn on or turn off the function. 

 : On. After the function is turned on, the 
associated parameter Color can be used to adjust 
the keying effect. 

 : Off 

Color The RGB values of the foreground color 

Chroma key 
parameters 

Pick The RGB values of the pick point 

 Config method 1: Click Pick, and then click the 
position to be picked in the input source image. 

 Config method 2: Set the coordinates of the pick 
point in the input source image. 

 Config method 3: Set the RGB values of Background 
Point. 

After the settings, click Apply. You can also adjust the 
following parameters to optimize the keying effect. 

Hue Ramp To distinguish between the foreground and 
background 

Hue Clip The hue range 

The larger the value, the larger the removal area. The 
maximum value is the current value of Hue Ramp. 

Saturation 
Clip 

To distinguish between the foreground and 
background 

Saturation 
Gain 

The hue softness of the transition area  

The larger the value, the softer the transition. 

Spill To remove the overflow from the foreground image 
edges and semi-transparent areas 
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Type Parameter Description 

Shadow To remove the shadow areas 

Highlight To remove the highlight areas 

Configure Output Properties 

Click the target output connector on the graphical device rear panel (if you need to 
configure the card properties, please click the desired card on the rear panel), and 
then set the output-related properties in the property area on the right pane. 

 Output properties (P20) 

 

View Output Card Info 

View the output card related information. 

Applicable Products 

P80, Q8 

Prerequisites 

None 

Notes 

None 
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Interface Example (Q8) 

 

Description 

None 

Configure Output Card Properties 

Configure the connector capacity (resource usage), desired output connectors and 
output connector copying function. The copy connector outputs the same image as 
the primary output connector outputs. 

Applicable Products 

P20, P20-DS, P10, Q8 

Prerequisites 

 The connector capacity configuration is applicable to the P10, P20 and P20-DS.  

 The function of output connector copying and the selection of output connectors 
are applicable to Q_4xHDMI2.0+4x12G-SD|+8xFiber Output Card and 
Q_4xHDMI2.0+4xDP1.2+8xFiber Output Card of the Q8. 

Notes 

When the copy connector is already used to load the screen, you cannot enable the 
connector copying function for the output card where the copy connector is located. 

Interface Example (P20) 
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Interface Example (Q8) 

 

Description 

Parameter Description 

Capacity Set the output connector capacity from the drop-down list. 

Connector Copying Turn on or turn off the function. 

 : On 

 : Off 

The default copy relations between connectors are as follows: 

 HDMI: Connectors 1 and 3 are primary connectors.  

Connector 2 copies the output on connector 1, while connector 
4 copies the output on connector 3. 

 SDI: Connectors 5 and 7 are primary connectors.  

Connector 6 copies the output on connector 5, while connector 
8 copies the output on connector 7. 

Select Connector Select the desired output connectors. 

 : Selected 

 : Not selected 

When the connector copying function is disabled, select the 
required output connectors and click Apply. 

View Output Info 

View the basic output properties, and change the output connector name.  

Applicable Products 

P80, P20, P20-DS, P10, Q8 
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Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Basic tab interface, enter a new connector name, and then click elsewhere in 
the interface to complete the connector name change. 

For the P80, you can configure the mode of each pair HDMI 2.0 connectors. The 
options include Copy and Split. 

Configure Output HDCP 

Enable or disable the output HDCP encryption. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 
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Description 

Parameter Description 

HDCP Turn on or turn off the function. 

 : On 

 : Off 

HDCP Select the HDCP version. 

 Note 

The output HDCP is disabled by default. Once enabled, the default HDCP version is 
set to the lowest. 

 

Configure Output Info 

Configure the output-related parameters. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The output connector is not used by any screen. 

Notes 

When Color Space/Sample is set to YCbCr, Gamut cannot be selected as DCI-P3. 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Type Parameter Description 

General 
parameters 

Color/Sample The sampling format of the output 

Bit Depth The bit depth of the output, i.e., the binary digits to 
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Type Parameter Description 

represent a single color 

HDR format 
conversion 
parameters 

Dynamic Range The dynamic range 

Color Gamut The color gamut standard 

Gamma The gamma value 

When Dynamic Range is SDR, this parameter is 
available. 

Peak Brightness The peak brightness  

When Dynamic Range is HDR10 or HLG, this 
parameter is available. 

Configure Output Driver Mode 

 For HDMI: When the connector is connected to the backend device and the signal 
does not match, adjusting the output mode can try to restore the signal driving 
mode. 

 For DP: When the DP cable degradation is excessive, adjusting the swing/pre-
emphasis parameter can enhance connector performance. 

Applicable Products 

Q8 

Prerequisites 

The HDMI output mode is displayed by default. To use additional features on the 
HDMI and DP connectors, simultaneously press Ctrl+Shift+Alt+D to enter the 
developer mode. 

Notes 

None 

Interface Example (Q8) 

  

Description 

On the Basic tab interface, configure the following parameters. 

Type Parameter Description 

HDMI Output 
Mode 

Output Mode The options include Auto, HDMI, DVI, Force HDMI, and 
Force DVI. 
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Type Parameter Description 

 Auto (default): Automatically detects. 

 HDMI: Output HDMI signal. 

 DVI: Output DVI signal. 

 Force HDMI: Output HDMI signal regardless of 
connection to backend devices. 

 Force DVI: Output DVI signal regardless of 
connection to backend devices. 

Driver Mode The options include Normal, Enhanced and Advanced. 

 Normal (default) 

 Enhanced: Suitable for long-distance environments 

 Advanced: After adjusting the advanced mode 
parameters, observe the signal quality. 

The adjustable options include Pre-emphasis/De-
emphasis/Slope Gear, Current/Swing Gear, and 
Termination Resistor Gear. 

DP Output 
Mode 

Swing/Pre-
emphasis 
Mode 

The options include Adaptive and Manual. 

 Adaptive: Apply the recommended parameters. 

 Manual: Manually adjust the parameters and 
obs4erve the signal quality. 

Configure OPT Port Mode 

Configure the OPT port transmission mode. 

Applicable Products 

P20, P20-DS, P10 

Prerequisites 

This feature requires entering the developer mode by simultaneously pressing 
Ctrl+Shift+Alt+D. 

Notes 

None 

Interface Example (P20) 
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Description 

On the Basic tab interface, set the OPT port transmission mode to Default, SM or 
MM. 

Configure Output Timing 

Configure the resolution and frame rate of the output. You can select the standard 
resolution provided by the device, customize a resolution, or set the advanced 
parameters. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The back-end device's EDID is obtained. 

 The output connector is not used to load any screens. 

Notes 

 It is recommended the advanced settings be carried out by the trained personnel 
only. 

 Only the Q8 supports setting and displaying monitor name. 

 Only the Q8, P80 and P20-DS support audio configuration. When HBlank is less 
than 110, the audio function cannot be enabled. 

Interface Example (P20-DS) 

 

Description 

On the Timing tab interface, configure the following parameters and click Apply after 
the settings. 

Parameter Sub-Parameter Description 

Mode - The options include Standard, Custom and 
Advanced. 
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Parameter Sub-Parameter Description 

Standard Resolution The number of horizontal pixels and vertical pixels of 
the image 

Config method: Select the desired resolution from 
the drop-down list. 

Frame Rate The image frames per second (unit: Hz) 

Config method: Select the preset common frame 
rates from the drop-down options. The available 
frame rates may vary according to the chosen 
resolution. 

Audio Turn on or off the audio function. 

Custom Width The horizontal pixels of the image 

Height The vertical pixels of the image 

Frame Rate The image frames per second (unit: Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration of the 
horizontal and vertical blanking intervals in the video 
signal to ensure synchronized image display 

Options include Standard, CVT-RBv1, CVT-RBv2, and 
CVT-RBv3. 

HBlank Horizontal blanking parameter to complete the 
current line scan and prepare for the next one. 

 When Standard is selected for Reduced Blanking, 
HBlank is displayed but cannot be adjusted. 

 When CVT-RBv1 is selected for Reduced Blanking, 
HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced Blanking, 
HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced Blanking, 
HBlank is adjustable, ranging from 80 to 200. 

Audio Turn on or off the audio function. 

Advanced H Total Total pixel count per line 

H Active The horizontal size in pixels of the active area 

H Front Porch The offset between the end of the active area and the 
beginning of the H sync 

H Sync The horizontal sync width in pixels (or between 
pixels) 

H Polarity The polarity of the horizontal sync pulse 

V Total Total pixel count per column 

V Active The vertical size in pixels of the active area 

V Front Porch The offset in lines between the end of the active 
output area and the beginning of V sync 

V Sync The vertical sync width in rows (or between rows) 
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Parameter Sub-Parameter Description 

V Polarity The polarity of the vertical sync pulse 

Frame Rate The image frames per second (unit: Hz) 

Audio Turn on or off the audio function. 

Export EDID 

When the EDID compatibility of the input connector of the back-end device is good, 
the device can learn the EDID of the back-end device through the output connector 
and export the EDID to a local computer for possible future use. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The output connector is connected to the back-end device normally. 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Timing tab interface, click EDID Export. In the dialog box that appears, select a 
path and click Save. 

Configure OPT Parameters 

Configure the OPT port parameters of Q_1xST2110(100G)+4x12G SDl 0utput Card of 
the Q8. 

7.3.4.10.1 Configure OPT Port IP Addresses 

Configure the network settings for the primary and backup OPT ports.  

Applicable Products 

Q8 

Prerequisites 

None 
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Notes 

None 

Interface Example (Q8) 

  

Description 

On the ST 2110 tab interface, configure the following parameters and click Apply. 

Parameter Description 

Network Mode The configuration method for the OPT port 

 Manual: Manually configure a static IP address for the OPT 
port. 

 DHCP: The OPT port obtains the IP address automatically. 

IP Address The IP address of the OPT port 

Subnet Mask The subnet mask of the OPT port 

Gateway The default gateway of the OPT port 

7.3.4.10.2 Configure PTP 

PTP settings synchronize the clocks of all audio and video devices within the 
network, ensuring that separately transmitted audio, video, and auxiliary data can be 
precisely aligned and presented at the receiving end. 

Applicable Products 

Q8 

Prerequisites 

None 
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Notes 

None 

Interface Example (Q8) 

 

Description 

On the ST 2110 tab interface, configure the following parameters. 

Parameter Description 

Lock Input to PTP Turn on or turn off the function. 

 : On. The input is locked to PTP, which enables high-
precision synchronization with the network's master 
clock. 

 : Off. The input is not locked to PTP. 

Leader/Follower Defaulted as a slave clock, which cannot be modified 

Domain PTP domain number, used to distinguish different PTP clock 
domains 

Announce Interval Time interval for announce messages 

Sync Interval Time interval for sync messages 

Daley Request Interval Time interval for delay request messages 

Master Clock MAC MAC addr4ess of the PTP master clock 

Time Lock Status PTP master clock synchronization status 

Offset from Leader Time difference between the master and slave clock 

7.3.4.10.3 Configure FEC 

FEC enhances video signal transmission reliability by automatically detecting and 
correcting errors. 
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Applicable Products 

Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (Q8) 

 

Description 

On the ST 2110 tab interface, configure the following parameters. 

Parameter Description 

Status Turn on or turn off the function. 

 : On 

 : Off 

FEC feature must be enabled on the switch and its status must 
match the device's before optical streaming can begin. 

7.3.4.10.4 Check IGMP 

Check the IGMP multicast protocol version number. 

Applicable Products 

Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (Q8) 
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Description 

View the IGMP multicast protocol version number. 

7.3.4.10.5 Configure OPT Port Stream 

Configure the related parameters for the OPT output video stream. 

Applicable Products 

Q8 

Prerequisites 

If you need to configure parameters by importing an SDP file, you must prepare the 
SDP file (.sdp) in advance. 

Notes 

None 
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Interface Example (Q8) 

 

Description 

Select the Output tab on the right pane, configure the following parameters as 
needed and click Apply. 

 Configure the parameters by importing an SDP file 

Click Load SDP File, select the SDP file from the window that appears, and click 
OK. 
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 Manually configure the parameters 

Click Edit and configure the following parameters as needed. After the 
configuration, click OK. 

Type Parameter Description 

Primary OPT Destination IP The destination IP of the video stream for 
the primary OPT port 

Port The destination port of the video stream for 
the primary OPT port 

Source IP The source IP of the video stream for the 
primary OPT port 

Backup OPT Destination IP The destination IP of the video stream for 
the backup OPT port 

Port The destination port of the video stream for 
the backup OPT port 

Source IP The source IP of the video stream for the 
backup OPT port 

Advanced 
Output 
Settings 

Resolution The resolution of the video stream 

Frame Rate The frame rate of the video stream 

Color Space/Sample The color space and sampling rate of the 
video stream 

Bit Depth The bit depth of the video stream 

Miscellanrous Sync Source Identifier Identifier of the sync source 

Packet Type The encoding format of the packet 

Traffic Shaping The algorithm used for traffic shaping 

Packet Encapsulation The method used for data packet 
encapsulation 

To export an SDP file, click Export SDP. In the dialog box that appears, select a path 
and click OK. 

Configure Output Color 

Configure the output color parameters. The ultimate output image quality is decided 
by the layer color, input color and output color settings. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 
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Notes 

The gamma adjustment is applicable to P80 and Q8 only. 

Interface Example (Q8) 

 

Description 

On the Effect tab interface, configure the following parameters. 

Parameter Description 

Contrast The ratio of the luminance of the brightest color to that of the 
darkest color 

Adjust the contrast value either as a whole or individually adjust 
the RGB components. 

Brightness The shading of lights in the image 

Adjust the brightness value either as a whole or individually adjust 
the RGB components. 

Hue The relative degree of how bright or dark the image is 

Saturation The color purity of the image 

The higher the value, the more vivid the color. 

Gamma Adjust the gamma value. 
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Configure SDI Matrix 

Configure SDI matrix for mapping any content from the input sources, MVR, PGM and 
flex outputs. 

Applicable Products 

P80 

Prerequisites 

Before you configure SDI matrix, make sure the device model is P80. 

Notes 

 Sources not meeting SDI standards cannot be selected for SDI matrix. 

 SDI matrix output does not support test patterns and FTB. 

Interface Example (P80) 

  

Description 

Select the SDI connectors on the flex output card and select sources for SDI matrix 
output. 

Parameter Description 

SDI 5 to 8 Select sources for SDI 5 to 8 from the input sources, MVR, 
main outputs, and flex outputs. 

Reset Click Reset to revert to the default settings: 

 SDI 5: Output-1-HDMI 2.0 

 SDI 6: Output-3-HDMI 2.0 

 SDI 7: Output-5-HDMI 2.0 

 SDI 8: Output-7-HDMI 2.0 
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Configure Multiviewer 

Configure the connector mode and resolution of the Multiviewer connector. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

Before you configure the Multiviewer connector mode, make sure the device model is 
the P80 and Q8. 

Notes 

The Multiviewer connector resolution of the P20, P20-DS and P10 is fixed at 
1920×1080, with frame rate adjustable. 

Interface Example (Q8) 

 

Description 

Configure the following parameters and click Apply. 

Parameter Description 

Mode Configure the working mode of the Multiviewer connector. 

 Independent: Two Multiviewer connectors output their own 
monitoring images. 

 Copy: HDMI 2 copies the monitoring data on HDMI 1. 

When the output resolution is 4K×2K@60Hz, only copy mode 
is supported. 

Resolution Select the desired connector resolution. 

Frame Rate Select the desired frame rate. 

Configure Multiviewer HDCP 

Enable or disable the Multiviewer HDCP encryption. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 
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Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

For the main output connectors, flex, AUX and MVR connectors, whether the HDCP 
function is enabled or not only affects whether the image content is encrypted or not 
during output, but does not affect the image content itself. That is, when HDCP is 
enabled, the output is encrypted; when HDCP is disabled, the output is decrypted. 

 Note 

 For the specific output images after configuring the global, input, output HDCP 
respectively, please refer to the table in 7.3.2.7 Configure HDCP. 

 The Multiviewer HDCP is disabled by default. Once enabled, the default HDCP 
version is set to the lowest. 

 

Configure Audio Properties 

View Dante Info 

View basic information about the Dante connectors, including Dante software 
information, primary Dante port, and backup Dante port. 

Applicable Products 

P20-DS, P80, Q8 

Prerequisites 

 The Dante network has been set up. 

 The Dante Controller software has been installed and is running on a computer 
within the same network segment. 

Notes 

None 
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Interface Example (P20-DS) 

 

Description 

Click the Dante connector on the device rear panel, and view the basic properties in 
the Basic tab in the Dante Properties area on the right pane. 

 Note 

How to set up the Dante network and use Dante Controller software, please contact 
the technical support.  

Configure RX 

View audio data input from the Dante audio network, and support renaming audio 
channel names. 

Applicable Products 

P20-DS, P80, Q8 

Prerequisites 

The Dante network matrix configuration has been completed in Dante Controller 
software. 

Notes 

None 
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Interface Example (P20-DS) 

  

Description 

 Rename audio channels: In the RX tab, click the channel name to edit it.  

 View audio source: After completing the matrix configuration in Dante Controller, 
the RX end will display the currently connected audio source. 

Configure TX 

The TX end serves as the audio output of the device, allowing audio to be output to 
the Dante network. 

Applicable Products 

P20-DS, P80, Q8 

Prerequisites 

The Dante audio matrix configuration has been completed in PixelFlow. For specific 
operations, refer to 7.7 Audio Matrix. 

Notes 

None 

Interface Example (P20-DS) 
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Description 

 Rename audio channels: In the TX tab, click the channel name to edit it.  

 View audio source: After completing the matrix configuration in PixelFlow, the TX 
end will display which audio source is currently assigned to the TX channel. 

Screen Configuration 

Configure Screens 

Configure the layout of a main screen, as well as add and replace the output 
connectors. The connectors of the same type and output resolution can be 
configured for the same mosaic screen. 

 Enter the device configuration page as described in 7.3.1 Enter Device Configuration 
Page. 

 Select the target device on the left, and then select Screen at the top of the page. 

 Screen configuration (P20) 

 

 Click  to add a new screen, or click  in the lower-left to create a new screen. 
The following steps illustrate creating a screen by expanding the screen list. 

 Click  to expand the screen list on the left, then click Add Screens. 

 Search for screens by name and click  or  to hide or show devices under 
each screen. 

 To adjust screen order, drag the screens manually. 

 To delete a single screen, place the mouse on the screen name and click . To 

delete all screens, click . 

 Click the layout style icon in the toolbar above the editing area, or click  to 
customize the layout by setting the number of rows and columns. 
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 Toolbar (P20) 

 

 Drag the output connector at the bottom to the desired screen to complete the 
screen configuration. 

 

To change an output, simply drag another output connector to the screen. 

Configure Screen Properties 

Click the desired screen, and then set the screen-related properties in the property 
area on the right pane. 

Rename Screens 

Change the screen name. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Basic tab interface, enter a new screen name, and then click elsewhere in the 
interface to complete the screen name change. 
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Configure Connector Position 

Configure the start position of the output connector. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The screen is a main (not flex/AUX) screen. 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

H Position The horizontal start position of the output connector 

V Position The vertical start position of the output connector 

Configure Test Patterns 

Test patterns are used to check the connection relation between the output 
connectors and the screen, and check whether the screen display is good. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The screen is a main screen. 

 Only the Q8 supports the screen-level test patterns. 

Notes 

 Once the screen test pattern is enabled, the Device page does not allow 
operations related to output connectors, such as adjusting positions. 
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 Once the screen test pattern is enabled, if the configured screen resolution 
exceeds the maximum limit of 16383×16383, the screen test pattern cannot be 
used. 

Interface Example (Q8) 

  

Description 

On the Basic tab interface, configure the following parameters. 

Type Parameter Description 

Test Pattern / Turn on or turn off the function. 

 : On 

 : Off 

Connector Connector Display only the enabled test pattern within the 
connector, excluding SMPTE. 

Grayscale Adjust the overall grayscale of the test pattern (4 
levels) to suit different display environments. 

H Spacing Adjust the lateral distribution of vertical lines.  

This parameter can be adjusted when the device 
model is Q8 and the grid style pattern is selected. 

V Spacing Adjust the longitudinal distribution of horizontal 
lines.  

This parameter can be adjusted when the device 
model is Q8 and the grid style pattern is selected. 

Spacing Level Adjust the spacing between colors. 
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Type Parameter Description 

This parameter can be adjusted when the device 
model is and the color style pattern is multi-color 
or gradient.  

The spacing levels range from Auto to 1-8. When 
the color style is striped, it can be set to Auto. 

Spacing (px) Adjust the grid line spacing.  

This is adjustable when the device models are 
N10/N20 and the grid style is configured 

This parameter can be adjusted when the device 
model is P80, P20, P20-DS, and P10 and the grid 
style pattern is selected. 

Grid Width Adjust the thickness of grid lines to test display's 
clarity and edge-rendering capability under varying 
line width conditions. 

This parameter can be adjusted when the grid 
style pattern is selected. 

Speed Adjust the speed of grid line movement (5 levels). 

This parameter can be adjusted when the grid 
style pattern is selected. 

Screen Screen Display only the enabled test pattern within the 
screen, including SMPTE, circular alignment 
checkerboard, and circular alignment grid. 

Once settings are complete, click Apply to make 
the settings take effect. 

Grayscale Adjust the overall grayscale of the test pattern (4 
levels) to suit different display environments. 

H Spacing Adjust the lateral distribution of vertical lines.  

This parameter can be adjusted when the circular 
alignment grid is selected. 

V Spacing Adjust the longitudinal distribution of horizontal 
lines. 

This parameter can be adjusted when the circular 
alignment grid is selected. 

Spacing Level Adjust the spacing between colors. 

This parameter can be adjusted when the circular 
alignment grid is selected. 

Grid Width Adjust the thickness of grid lines to test display's 
clarity and edge-rendering capability under varying 
line width conditions. 

This parameter can be adjusted when the circular 
alignment grid is selected. 
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Type Parameter Description 

Index Position Adjust the display position of grid-based locator 
markings. 

This parameter can be adjusted when the circular 
alignment checkerboard or circular alignment grid 
is selected. 

Configure AOI 

When the output connector resolution is greater than the actual screen resolution, 
you can configure an unequal mosaic rather than changing the resolution of the 
output connector. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The screen is a main or flex (not AUX) screen. 

Notes 

None 

Interface Example (P20) 

 

Description 

Select the output connector on the canvas, and then configure the following 
parameters on the Basic tab interface. After the settings, click Apply. 
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Parameter Description 

X The horizontal offset relative to the starting position of the original 
connector 

Y The vertical offset relative to the starting position of the original 
connector 

Width The horizontal pixels 

Height The vertical pixels 

Configure Screen Color 

Configure the screen color parameters. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

The gamma adjustment is applicable to P80 and Q8 only. 
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Interface Example (Q8) 

 

Description 

On the Effect tab interface, configure the following parameters. 

Parameter Description 

Contrast The ratio of the luminance of the brightest color to that of the 
darkest color 

Adjust the contrast value either as a whole or individually adjust 
the RGB components. 

Brightness The shading of lights in the image 

Adjust the brightness value either as a whole or individually adjust 
the RGB components. 

Hue The relative degree of how bright or dark the image is 

Saturation The color purity of the image 

The higher the value, the more vivid the color. 

Gamma Adjust the gamma value. 
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Configure Timing 

Configure the resolution and frame rate of the output. You can select the standard 
resolution provided by the device, customize a resolution, or set the advanced 
parameters.  

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The EDID of the back-end device is obtained. 

Notes 

 It is recommended the advanced settings be carried out by the trained personnel 
only. 

 Once the output resolution is changed, the AOI parameters associated with the 
connector will be automatically reset. 

 Only the Q8, P80 and P20-DS support audio configuration. When HBlank is less 
than 110, the audio function cannot be enabled. 

Interface Example (P20-DS) 

 

Description 

On the Output tab interface, configure the following parameters and click Apply. 

Parameter Sub-Parameter Description 

Mode - The options include Standard, Custom and 
Advanced. 

Standard Resolution The number of horizontal pixels and vertical pixels of 
the image 

Config method: Select the desired resolution from 
the drop-down list. 

Frame Rate The image frames per second (unit: Hz) 

Config method: Select the preset common frame 
rates from the drop-down options. The available 
frame rates may vary according to the chosen 
resolution. 
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Parameter Sub-Parameter Description 

Audio Turn on or off the audio function. 

Custom Width The horizontal pixels of the image 

Height The vertical pixels of the image 

Frame Rate The image frames per second (unit: Hz) 

Reduced 
Blanking 

Start and end times, as well as the duration of the 
horizontal and vertical blanking intervals in the video 
signal to ensure synchronized image display 

Options include Standard, CVT-RBv1, CVT-RBv2, and 
CVT-RBv3. 

HBlank Horizontal blanking parameter to complete the 
current line scan and prepare for the next one. 

 When Standard is selected for Reduced Blanking, 
HBlank is displayed but cannot be adjusted. 

 When CVT-RBv1 is selected for Reduced Blanking, 
HBlank is fixed at 160. 

 When CVT-RBv2 is selected for Reduced Blanking, 
HBlank is fixed at 80. 

 When CVT-RBv3 is selected for Reduced Blanking, 
HBlank is adjustable, ranging from 80 to 200. 

Audio Turn on or off the audio function. 

Advanced H Total Total pixel count per line 

H Active The horizontal size in pixels of the active area 

H Front Porch The offset between the end of the active area and the 
beginning of the H sync 

H Sync The horizontal sync width in pixels (or between 
pixels) 

H Polarity The polarity of the horizontal sync pulse 

V Total Total pixel count per column 

V Active The vertical size in pixels of the active area 

V Front Porch The offset in lines between the end of the active 
output area and the beginning of V sync 

V Sync The vertical sync width in rows (or between rows) 

V Polarity The polarity of the vertical sync pulse 

Frame Rate The image frames per second (unit: Hz) 

Audio Turn on or off the audio function. 

Configure Output Parameters 

Configure the output-related parameters. 
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The general parameters are applicable to both the main screen, flex screen and 
AUX screen. 

 Before setting the HDR-related parameters here, make sure the screen is a main or 
flex (not AUX) screen. 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Output tab interface, configure the following parameters. 

Type Parameter Description 

General 
parameters 

Color 
Space/Sample 

The sampling format of the output 

Bit Depth The bit depth of the output, i.e., the binary digits 
to represent a single color 

HDR parameters Dynamic Range The dynamic range format of the output 

Color Gamut The color gamut standard of the output 

Gamma The Gamma value 

When Dynamic Range is SDR, this parameter is 
available. 

Peak Brightness The peak brightness  

When Dynamic Range is HDR10 or HLG, this 
parameter is available. 

 Note 

 For the P20-DS, the output connector parameter area is divided into two parts: 
HDMI and SDI. 
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 The HDMI connector parameters of the P20-DS are consistent with those of the 
P20. 

 The SDI area allows only viewing the Color Space/Sample and Bit Depth info.  

Configure Screen HDCP 

Configure the HDCP settings for all connectors of the screen.  

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The function is applicable to the LCD screens only. 

Notes 

None 

Interface Example (P20) 

 

Description 

Enable or disable the HDCP encryption function for all connectors of the device that 
loads the LCD screen. 

 Note 

 For the specific output images after configuring the global, input, output HDCP 
respectively, please refer to the table in 7.3.2.7 Configure HDCP. 

 The screen HDCP is disabled by default. Once enabled, the default HDCP version 
is set to the lowest. 

 For the P20-DS, HDCP setting is only applicable to the HDMI connector. 
 

Configure Connector Rotation 

Rotate the currently-selected output connector clockwise from the center point. Only 
the connector rotates, not the image, making it suitable for vertical playback or 
creative mosaic application scenarios. 

Applicable Products 

Q8 

Prerequisites 

The screen is a main (not AUX) screen. 
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Notes 

 When the vertical or horizontal resolution of the connector exceeds 4096 pixels, 
rotation operations are prohibited. 

 Once the connector rotation is enabled, the virtual pixel function will be reset, and 
there will be an additional one-frame delay from input to output. 

Interface Example (Q8) 

 

Description 

On the Advanced tab interface, configure the following parameters. 

Parameter Description 

Connector Rotation Turn on or turn off the function. 

 : On 

 : Off 

Angle (0°) Rotate the output connector clockwise from the central point. 

Configure Virtual Pixels 

With the help of the virtual pixel function, the complicated calculations during the 
screen configuration process will not be troublesome.  

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The screen is a main or flex (not AUX) screen. 

Notes 

The virtual pixels have no effect on the actual output content. 

Interface Example (P20) 
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Description 

On the Advanced tab interface, configure the following parameters and click Apply. 

Parameter Description 

Virtual Pixels Turn on or turn off the function. 

 : On 

 : Off 

Width (Actual Size) The width of the actual screen 

Height (Actual Size) The height of the actual screen 

Configure 3D 

Enable the 3D feature on the current screen and set the eye priority to optimize the 
3D visual effect. 

Applicable Products 

P80, Q8 

Prerequisites 

The screen is a main or flex (not AUX) screen. 

Notes 

None 

Interface Example (Q8) 

 

Description 

In the Advanced tab, configure the following parameters: 

Parameter Description 

3D Turn on or turn off the function. 

 : On 

 : Off 

Eye Priority Set the eye priority. 

Configure LCD Bezel Compensation 

Configure the edge compensation parameters for LCD splicing screens to make the 
image visually integrated. 
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The screen is a main (not flex/AUX) screen. 

Notes 

Edge blending and LCD bezel compensation are mutually exclusive. 

Interface Example (P20) 

 

Description 

In the canvas area, click the Advanced tab and configure the following parameters on 
the right pane. 

Parameter Description 

LCD Bezel 
Compensation 

Turn on or turn off the function. 

 : On 

 : Off 

Horizontal Spacing The total width of the borders at the horizontal joints of the 
screens 

Vertical Spacing The total width of the borders at the vertical joints of the 
screens 

Configure Edge Blending 

Edge blending is a technique used when using multiple projectors to display different 
regions of a single image. To display a single seamless image, adjacent projectors 
need to overlap edges slightly and compensate for the double brightness created in 
different regions. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The screen is a main (not flex/AUX) screen. 

 The offset angles of the projectors have been adjusted. 
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Notes 

Edge blending and LCD bezel compensation are mutually exclusive. 

Interface Example (P20) 

  

Description 

In the canvas area, click the Advanced tab and configure the following parameters on 
the right pane. 

Parameter Description 

Edge Blending Turn on or turn off the function. 

 : On 

 : Off 

Mode Select the edge blending mode. 

 Basic: Applicable to standard mosaic screens 

 Advanced: Applicable to both standard and irregular mosaic 
screens 

Blending Width Set the width of the blending area. 

When Basic is selected, this parameter is available. Select the 
desired screen edge, then configure the blending area width. 

Connector Position Set the horizontal and vertical start positions of the output 
connector. 

When Advanced is selected, this parameter is available. 
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Parameter Description 

Feathering Turn on or turn off the function. 

 : On 

 : Off 

In the Advanced mode, set the feathering parameters, including 
function switch, Gamma, width, for each output edge. For the 
Q8, each output supports up to two blending areas, with a min 
size of 64×64. 

Feathering Gamma Set the feathering Gamma for the blending area. 

Feathering Width Set the feathering width (inward direction) of the blending 
area. 

Edge Marker Highlight the edges of the output connector's loading area:  

 : On, highlight the edges of the output connector's 
loading area in the output image. 

 : Off 

Color Select the highlight color. 

Layer Operations 

Add Layers 

Add the layers to the screen. Multiple layers can be added to a main screen, but only 
one layer can be added to a flex/AUX screen. 

 Enter the device configuration page as described in 7.3.1 Enter Device Configuration 
Page. 

 Select Programming at the top of the page, and then select the target screen from 
Screen List on the left. 
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 Programming (P20) 

 

 Add the layers to the screens. 

 Main/Flex screen: Drag an input source, screen, local image, or MVR source (Q8) 
from the gallery to the screen. 

If Screen Resources is enabled in Settings > Preferences, the current layer 
resource usage appears at the bottom right of the programming area. 

When adding a layer using a 3D video source (P80/Q8): 

− 3D NOT enabled on the screen: The original 3D video source is displayed. 

− 3D enabled on the screen: The display synchronizes with the screen. 

Side-by-side source: The left-eye image is displayed. 

Top-and-bottom source: The upper image is displayed. 

 AUX screen: Drag an input source, screen, or local image from the gallery to the 
AUX screen. 

Note 

In the input source list, hover over an input source and click . In the pop-up, you 
can: 

 Capture the input source. 

 Configure the auto switch status.  

 Perform the desired layer operations as required. 
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 Layer operations 

 

1 Lock/Unlock PGM 17 Bring to front 

2 Capture PGM 18 Send to back 

3 Lock/Unlock layer 19 Fill horizontally 

4 1:1 display 20 Fill vertically 

5 Maximize display 21 Fill screen 

6 Delete 22 Align 

7 Maximize/Restore 23 Copy 

8 Zoom out 24 Mirror horizontally 

9 Zoom in 25 Swap PVW and PGM 

10 Zoom to selected 26 Copy PVW to PGM 

11 Auto fit 27 Match PVW with PGM 

12 Clear 28 Transition effect 

13 Lock/Unlock PGM and PVW 29 Transition duration 

14 Reset current view 30 FTB 

15 Bring forward 31 Freeze 
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16 Send backward 32 Select layer 

 BKG: Background layer 

 Lx: Regular layer 

 Ax: AUX layer 

 Fx: Flex layer 

To move a layer, drag it directly with the mouse to the desired position, or use the 
arrow keys to move, and Shift + arrow keys for quick movement. 

Send PVM to PGM via the following three ways: 

 CUT: Send PVW to PGM without any transition effect. 

 TAKE: Send PVW to PGM with a time-specified transition effect. 

 T-BAR: Send PVW to PGM with a transition effect, and the transition duration 
depends on the time duration you push the T-Bar. 

Note 

The layer or preset operations are NOT allowed during the transition process.  

Manage Gallery 

In the input source list area, select the Gallery tab, then perform the actions as 
needed. 

Import Images 

Click , select the desired images in the displayed dialog box and then click OK. 

 Gallery (P20) 

 

Export Images 

Click Edit, select the images you want to export, and click . In the pop-up dialog 
box, choose a destination path, and click OK. 

Delete Images 

Click Edit, select the images to be deleted, and then click  or click  in the top 
right of the image. In the pop-up dialog box, click Yes. 
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Manage BKGs 

Image BKGs 

In the input source list area, select the BKG tab, then perform the actions as needed. 

Enable or Disable BKGs 

Turn on or turn off the function. 

 : The function is turned on. 

 : The function is turned off. 

 BKG (P20) 

 

Import BKGs 

Click , select the desired BKGs in the displayed dialog box and then click OK. 

Export BKGs 

Click Edit, select the BKGs you want to export, and click . In the pop-up dialog box, 
choose a destination path, and click OK. 

Delete BKGs 

Click Edit, select the BKGs to be deleted, and then click  or click  in the top 
right of the BKG. In the pop-up dialog box, click Yes. 

Live BKGs 

This feature enables use of any live input signal as the background layer, eliminating 
the need for pre‑loading media files. It supports quick switching of dynamic 
backgrounds via presets, facilitating real‑time visual transitions between different 
event segments. 

Applicable Products 

P80 

Prerequisites 

The screen is a main (not flex/AUX) screen. 
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Notes 

 Live BKG and image BKG cannot be used simultaneously. Only one can be active 
at a time. 

 A maximum of 16 Live BKGs can be stored per screen. 

 Interlaced signal input sources are not supported for use as Live BKGs. 

Procedure 

 In the input source list area, select the BKG tab. 

 

 (Optional) Toggle the BKG switch. 

 Select the Live BKG tab. 

 Click Edit and go to the right pane to add live BKGs. 

 

 Select the Connector or Screen tab from the top of the editing area. 

 Connector: Create a live BKG by assigning one source to each connector within a 
screen, with each source displayed in its corresponding connector area. 

 Screen: Create a live BKG by assigning one source to the entire screen. 

 Drag a source from the Input, Screen or Gallery area to the editing area. 

 Select a live BKG slot from the Live BKG pane on the right and click Save to save a 
live BKG, or click Clear to cancel the operation. 

 Click Back and drag the saved live BKG to the PVW or PGM area to complete the BKG 
adding. 
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If you want to delete a single live BKG, click  in the top right; if you want to delete 
some or all live BKGs, click Action and select the BKGs to be deleted or check Select 

All, and then click . In the pop-up dialog box, click Yes. 

Manage Logos 

In the input source list area, select the LOGO tab, then perform the actions as needed. 

The P80 and Q8 do not support the logo function. 

Import Logos 

Click , select the desired logos in the displayed dialog box and then click OK. 

 Logo (P20) 

 

Note 

When the interface cannot display all tabs, press and hold Shift while scrolling the 
mouse wheel to navigate to the LOGO tab page.  

When the selected logo file's resolution exceeds 512×512 pixels, the Crop Image 
dialog will automatically appear. Perform the corresponding operation as needed. 

 Select Crop and set the coordinates (X, Y) and size (W, H) of the crop area. 

 Select Auto Fit to automatically adjust the logo's size. 
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 Crop images 

 

Export Logos 

Click Edit, select the logos you want to export, and click . In the pop-up dialog box, 
choose a destination path, and click OK. 

Delete Logos 

Click Edit, select the logos to be deleted, and then click  or click  in the top 
right of the logo. In the pop-up dialog box, click Yes. 

Configure Layer Properties 

Select the desired layer, and then set the layer-related properties in the property area 
on the right pane. 

Configure Basic Properties 

Configure the layer name, flipping, aspect ratio, position and size, as well as 3D. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The flipping function is applicable to the regular layers only. 

 Only the Q8 supports the 3D function. 
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Notes 

After enabling the 3D function in the Screen interface, the 3D switch for all layers is 
turned on. If you need to use a 2D layer, please navigate to the Screen interface to 
disable the function. 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Name The layer name 

Type The layer type 

No.  The layer number 

Flip The layer flipping mode 

The supported options include None, Flip Horizontally, Flip 
Vertically, Flip Horizontally and Vertically. 

Aspect Ratio The ratio of the layer's width to its height 

After the aspect ratio is changed, the height of the layer remains 
unchanged, and the device automatically calculates its width. 

X The horizontal starting position of the layer on the screen  

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

Y The vertical starting position of the layer on the screen  

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

W The horizontal size of the layer 

The minimum width of a layer can only be scaled down to 1/64 of 
the layer width. 

H The vertical size of the layer 
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Parameter Description 

The minimum height of a layer can only be scaled down to 1/64 of 
the layer height. 

Configure Layer Borders 

Configure the border style of a layer. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The layer is a regular (not flex/AUX) layer. 

Notes 

If the layer mask function is turned on, the border function is turned off. 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Border Turn on or turn off the function. 

 : On 

 : Off 

Type The layer border type 

Width The width of the layer left and right borders 

Height The height of the top and bottom borders 

Color The layer border color 

When the border function is set to , this parameter is available. 
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Configure Layer Mask 

Configure the mask-related parameters. The masked area becomes transparent and 
the layer size remains the same. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The layer is a regular or flex (not AUX) layer. 

Notes 

If the layer mask function is turned on, the border function is turned off. 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Mask Turn on or turn off the function. 

 : On 

 : Off 

Mask Top Set the masked area height from the top edge of the layer.  

Mask Bottom Set the masked area height from the bottom edge of the layer.  

Mask Left Set the masked area width from the left edge of the layer. 

Mask Right Set the masked area width from the right edge of the layer. 

Configure Layer Shadow 

Configure the layer shadow parameters, including the shadow position, size, opacity, 
edge blurring and shadow color. 
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Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The layer is a regular (not flex/AUX) layer. 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Shadow Turn on or turn off the function. 

 : On 

 : Off 

X The horizontal start position of the shadow on the screen  

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

Y The vertical start position of the shadow on the screen  

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

Width The width of the shadow 

Height The height of the shadow 

Opacity The opacity of the shadow 
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Parameter Description 

Shadow Blur The blurring degree of the shadow edge  

The greater the value, the more blurring the shadow edges 

Color The shadow color 

Configure KeyFrame 

Configure the speed, start time and animation duration for KeyFrame (the transition 
of layer position and size). 

Applicable Products 

P20, P20-DS, P10, Q8, P80 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

KeyFrame Turn on or turn off the function. 

 : On 

 : Off 

Speed  Linear Curve (default): The speed is constant.  

 S-Curve: The speed alternates between fast and slow. 

Start Time Time after which the KeyFrame effect commences 

Animation Duration Total time required for the transition effect 
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 Note 

After enabling the function, a persistent "KF" marker will display on the layer, serving 
as a visual cue to users. 

 

Crop Layer Sources (P20/P20-DS/P10) 

When there are black borders or other redundant info in the input source image, the 
required picture can be retained through the cropping the input source, so as to 
improve the screen utilization. 

Applicable Products 

P20, P20-DS, P10 

Prerequisites 

A fine signal is connected to the input connector. 

Notes 

The properties and capacity of the cropped source remain consistent with the 
original one. 

Interface Example (P20) 

 

Description 

On the Advanced tab interface, configure the following parameters. 

Parameter Description 

Layer Source Crop Turn on or turn off the function. 

 : On 

 : Off 

X The horizontal start position of the cropped area relative to the 
original source 

Y The vertical start position of the cropped area relative to the 
original source 
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Parameter Description 

Width The number of horizontal pixels (width) of the cropped area 

Height The number of vertical pixels (height) of the cropped area 

Crop Layer Sources (P80/Q8) 

Applicable Products 

P80, Q8 

Prerequisites 

A fine signal is connected to the input connector. 

Notes 

The properties and capacity of the cropped source remain consistent with the 
original one. 

Procedure 

 Select the Input tab. 

 Click the desired input source, then select  > Crop. 

 

 In the pop-up, configure these parameters and click Save to save the configuration. 

 

 Name: Set the name for the cropped source. 



All-New Event Presentation Switching Solutions 

User Manual 7 Event Management Software PixelFlow 

 

www.pixelhue.com 249 
 

 X: Set the horizontal starting position relative to the original input source. 

 Y: Set the vertical starting position relative to the original input source. 

 Width: Set the number of horizontal pixels (width) of the cropped source. 

 Height: Set the number of vertical pixels (height) of the cropped source. 

 Perform Rename, Delete, Edit, or Capture on the cropped source as required. 

 

Configure Cut & Fill 

Configure the relevant parameters for the Cut & Fill function. 

The original layer serves as the Fill layer, and the output will display the Cut layer that 
overlaps with the Fill layer, allowing users to define the output shape and effect more 
flexibly. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

The layer is a regular (not flex/AUX) layer. 

Notes 

 When the Cut & Fill function is enabled, the DSK function is disabled. 

 For the Q8 and P80, the Cut & Fill function occupies two layer resources. 

 For the P10, P20 and P20-DS, the total resources for the Cut layer are 2x DL (1x 
4K), and the Cut layer capacity must be less than or equal to that of the Fill layer. 
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Interface Example (P20) 

  

Description 

On the Advanced tab interface, configure the following parameters. 

Parameter Description 

Cut & Fill Turn on or turn off the function. 

 : On 

 : Off 

Cut Source The input source of the Cut layer 

Config method: Click  to select an input source in the pop-up 
dialog box, and click OK.  

You can also delete or replace the input source if necessary. 

Invert Colors Turn on or turn off the function. 

 : On, allowing black areas to be transparent and white 
areas to be cut 

 : Off, allowing white areas to be transparent and black 
areas to be cut 

Curve Adjustment The color curve for the Cut layer, which is used to adjust the 
transition effect of the Cut layer 

The farther apart the X coordinates of 1 and 2 are, the smoother 
the transition will be. 
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Parameter Description 

X The horizontal initial position of the Cut layer relative to the Fill 
layer 

Y The vertical initial position of the Cut layer relative to the Fill layer 

Width The horizontal pixels of the Cut layer 

Height The vertical pixels of the Cut layer 

Configure DSK 

Achieve the luma, chroma and smart keying effect on the input source. 

Applicable Products 

P80, P20, P20-DS, P10 

Prerequisites 

The layer is a regular (not flex/AUX) layer, and the layer input source is a good one. 

Notes 

After the DSK function is enabled, the layer capacity will automatically change to 4K, 
and the cut & fill function will be disabled. 

Interface Example (P20) 
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Description 

On the DSK tab interface, configure the following parameters. 

Type Parameter Description 

Function 
switch 

DSK Turns on or turn off the function. 

 : On 

 : Off 

Description: 

 Smart: Suitable for standard keying scenarios. 
This feature reduces the need for parameter 
adjustments, facilitating a more convenient and 
swift fulfillment of user requirements for image 
keying. 

 Luma: Suitable for application scenarios where 
the brightness of the background is 
significantly smaller than that of the 
foreground. The result of luma key is that the 
background becomes transparent and the 
foreground is keyed out. 

 Chroma: Suitable for application scenarios with 
a single background color, such as blue/green 
screen matting 

Smart key 
parameters 

Pick The RGB values of the pick point 

 Config method 1: Click Pick, and then click the 
position to be picked in the input source image. 

 Config method 2: Set the coordinates of the 
pick point in the input source image. 

 Config method 3: Set the RGB values of 
Background Point. 

After the settings, click Apply. You can also adjust 
the following parameters to optimize the keying 
effect. 

Matting 
Strength 

To adjust the intensity with which the background 
is processed 

Gain Adjust To adjust the shadow/noise areas present in the 
foreground 

Luma key 
parameters 

Clip To distinguish between the foreground and 
background 

Smooth The hue softness of the transition area  

The larger the value, the softer the transition. 

Foreground 
Color 

Turn on or turn off the function. 

 : On. After the function is turned on, the 
associated parameter Color can be used to 
adjust the keying effect. 

 : Off 

Color The RGB values of the foreground color 
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Type Parameter Description 

Chroma key 
parameters 

Pick The RGB values of the pick point 

 Config method 1: Click Pick, and then click the 
position to be picked in the input source image. 

 Config method 2: Set the coordinates of the 
pick point in the input source image. 

 Config method 3: Set the RGB values of 
Background Point. 

After the settings, click Apply. You can also adjust 
the following parameters to optimize the keying 
effect. 

Hue Ramp To distinguish between the foreground and 
background 

Hue Clip The hue range 

The larger the value, the larger the removal area. 
The maximum value is the current value of Hue 
Ramp. 

Saturation Clip To distinguish between the foreground and 
background 

Saturation Gain The hue softness of the transition area  

The larger the value, the softer the transition. 

Spill To remove the overflow from the foreground 
image edges and semi-transparent areas 

Shadow To remove the shadow areas 

Highlight To remove the highlight areas 

Configure Layer Color 

Configure the layer color parameters. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The layer color settings are applicable to regular (not AUX) layers only. 

 For the P80, the layer color settings apply to both regular and flex layers, except 
for opacity, which does not apply to flex layers. 

Notes 

None 
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Interface Example (P20) 

 

Description 

On the Effect tab interface, configure the following parameters. 

Parameter Description 

Contrast The ratio of the luminance of the brightest color to that of the 
darkest color 

Adjust the contrast value either as a whole or individually adjust 
the RGB components. 

Brightness The shading of lights in the image 

Adjust the brightness value either as a whole or individually adjust 
the RGB components. 

Hue The relative degree of how bright or dark the image is 

Saturation The color purity of the image 

The higher the value, the more vivid the color. 

Opacity The layer opacity 
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Parameter Description 

Monochrome Turn on or turn off the function. 

 : On, and the layer image is show in black and white. 

 : Off 

Invert Colors Turn on or turn off the function. 

 : On, and the layer image is show in the complementary color 
of its original color. 

 : Off 

Configure BKG Properties 

Configure the aspect ratio, position and size of the BKG. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Interface Example (P20) 

 

Description 

Select the BKG image and configure the following parameters in the property area on 
the right. 
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Parameter Description 

Aspect Ratio The proportional relationship between the horizontal width and 
the vertical height of the BKG 

Upon changing the aspect ratio, the height of the BKG remains 
unchanged and the system automatically calculates the width. 

X The horizontal starting position of the BKG on a screen 

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

Y The vertical starting position of the BKG on a screen 

The coordinates of the first pixel in the upper left corner of the 
screen are (0,0). 

W The horizontal pixels of the BKG 

H The vertical pixels of the BKG 

Manage Presets 

Click Preset on the right side of the Programming interface and perform the 
corresponding actions as needed. 

 Preset management (P20) 

 

Save Presets 

Click Add, set the relevant preset parameters, and click Save after completing the 
settings. 
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 Save presets 

 

 Load Method:  

− Relative: Load all layer parameters in the preset while retaining layers not 
included. 

− Complete: Load all layer parameters and remove layers not included in the 
preset. 

 Save From: Select PVW or PGM. 

 Name: Set the name for the new preset. 

 Transition: Take Duration can be selected.  

This option is unavailable in PGM Only mode for the P10, P20 and P20-DS. 

 Screen: Choose a screen. 

Empty screens cannot be saved. 

 Input Source: Options for image quality or DSK can be selected. 

 Layer: Select the layer (shown when Relative loading method is selected). 

Preset Settings 

Click  to select 

 Execute Take effect when loading preset to PGM 
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 Execute KeyFrame when loading preset (only appears if Execute Take effect when 
loading preset to PGM is selected) 

 

Load Presets 

In the preset list, click  or  (appears in Switcher mode for the Q8, P10, P20 
and P20-DS) to load the preset to PGM or PVW. 

 Q8, P80 

The preset is loaded to PVW or PGM. 

 P20, P20-DS, P10 

− Switcher mode: The preset is loaded to PVW or PGM. 

− PGM only mode: The preset is loaded directly to PGM. 

Upon successful loading, the indicator light at the top left of the preset preview will 
illuminate: 

 : The preset is in PVW. 

 : The preset is in PGM. 

  (P20, P20-DS, P10 PGM Only mode): The preset is in PGM. 

Rename Presets 

Hover the mouse over the preset and select  > Rename. Enter a new name and 
then click elsewhere to make the change take effect. 

View Preset Details 

Hover the mouse over the preset and select  > Details. In the pop-up dialog box, 
edit the preset name as needed, verify the preset display, and click OK to confirm. 

Delete Single Preset 

Hover the mouse over the preset and select  > Delete. In the pop-up dialog box, 
click OK. 

Delete All Presets 

Click Action, select the desired presets or select Select All, and then click . In the 
pop-up dialog box, click OK. 

Manage Layer Presets 

Users can preserve the layer properties and apply these configurations swiftly to 
other layers. 
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 Note 

 Up to 1024 layer presets can be saved. 

 Layer presets do not differentiate between PGM and PVW. 

 Layer presets are solely properties of the device and do not follow the screen. 

 The layer preset can be applied to one layer at a time. 
 

Save Layer Presets 

 Select Layer Preset on the right side of the Programming interface. 

 Layer presets 

 

 Assign a name to the layer preset. 

 Click to select a color, assigning it to the layer preset. 

 Click to select the data you wish to save, or check Select All to include all data. 

 Once the parameters are set, click Save. 

Upon successful saving, the list area will display a corresponding entry. 

Modify Layer Presets 

Within the layer preset list, go to  > Edit to modify relevant information of the layer 
preset. 
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Delete Layer Presets 

 To delete a single layer preset: In the layer preset list, click  > Delete. 

 To delete all layer presets: Click Select, check Select All, then click Delete. 

Apply Layer Presets 

To apply a layer preset, proceed with any of the following actions: 

 Select a layer, then double-click the target layer preset in the list area. 

 Simply drag the layer preset to the target layer. 

Multiviewer (MVR) 

Configure MVR Layout 

Configure the layout of the MVR windows. When the bandwidth of the input source 
exceeds the limit, the corresponding MVR image is black. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

Only the Q8 and P80 support custom MVR layouts, allowing for a maximum of 8 
custom layouts. 

Description 

 Enter the device configuration page as described in 7.3.1 Enter Device Configuration 
Page. 

 Select the target device on the left, and then select Multiviewer at the top of the 
page. 
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 MVR management (Q8) 

 

 Select a layout style. 

 (Optional) Add a custom layout 

To add a custom layout, click Add. In the Custom Layout window, configure the 
number of rows and columns, the outer and inner window spaces, window merging, 
and window type. 

 Grid: Set the layout's rows and columns, with a maximum of 12×12 and a 
minimum of 1×1. This field cannot be empty. 

 Outer Space: Configure the external margin surrounding the windows. 

 Inner Space: Configure the margin between the windows. 

 Split Window: Use the mouse or hold down the Ctrl key to select multiple windows, 
then click Merge to combine them. Select a merged window and click Unmerge to 
separate them. 

 Type: Upon selecting a window, you can set its type to PGM, PVW, or input source. 
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 Add custom layouts 

 

After setting up, click OK. You can then Edit, Delete, or Clear All from the added 
custom templates. 

 Edit: Modify the current custom layout template. 

 Delete: Remove the added layout template. 

 Clear All: Delete all added layout templates. 

 If the device model is P80/Q8, drag an input in the input list or drag PVW and PGM in 
the screen list to the MVR window. 

If the device model is the P20, P20-DS and P10, please skip this step. 

To replace a signal of a specified window, simply drag another signal to the window. 
If the device model is the P80/Q8, the following operations can be performed: 

 Delete signal: Click  to delete the signal from the window. 

 Maximize signal image: Click  to maximize the signal image according to the 
windows it crosses. 

Toolbar Operations 

 : Zoom in the MVR layout. 

 : Zoom out the MVR layout. 

 : Adaptively display the MVR layout. 

 : Enable or disable snapping to grid. 

 : Clear all current MVR content. 
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Configure MVR Windows 

Configure the aspect ratio, position, size, UMD and borders of the MVR window. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

 The settings of the aspect ratio, position and size are applicable to the P80, P20, 
P20-DS, P10 and Q8. 

 The UMD and border settings are applicable to the P80 and Q8 only. 

 The background color setting is applicable to the P80 and Q8 only. 

Notes 

None 

Interface Example (Q8) 

 

Description 

Select an MVR window (P80/Q8) or select a PGM or PVW MVR window (P20/P20-
DS/P10), and then set the related properties in the property area on the right pane. 

Type Parameter Description 

- Background 
Color 

The background color the MVR layout 

- Aspect Ratio The aspect ratio of the MVR window 
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Type Parameter Description 

Window position X The X coordinate of the window on the MVR 
screen 

Y The Y coordinate of the window on the MVR 
screen 

W The horizontal pixels of the window 

H The vertical pixels of the window 

UMD UMD Turn on or turn off the function. 

 : On 

 : Off 

Color The color of the UMD text 

Border Width The width of the layer left or right border 

Height The height of the top or bottom border 

Color The window border color 

Audio Matrix 
Configure the audio matrix to precisely manage and transmit audio signals within the 
Dante network. 

Applicable Products 

P20-DS, P80, Q8 

Prerequisites 

 The device has been connected to the Dante network. 

 The Dante network matrix configuration has been completed in Dante Controller 
software. 

Notes 

None 

Description 

 Enter the device configuration page as described in 7.3.1 Enter Device Configuration 
Page. 

 Select the device on the left side of the interface, then choose Audio Matrix at the 
top. 
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Figure 5-22 Audio matrix (Q8) 

 

 Select the input and output audio source type. 

You can click All to select all input and output audio source types, or switch between 
the three audio source types: Inputs/Outputs (embedded), Dante and Audio (analog). 

The input audio supports the mute function, and the output audio supports both mute 
and test tone functions. 

 : Normal audio playback 

 : Mute 

 : Test Tone: A fixed audio segment is output regardless of whether the output 
audio has been mapped to a source, used to check if the audio link is connected. 

 In the matrix grid, select the intersection cell of the input audio source and output 
audio source. After clicking, the following indicators will appear: 

 : Indicates that all output channels in this group have been mapped to audio 
sources, and the audio link is complete and configured. 

 : Indicates that some output channels in this group have been mapped to 
audio sources. 

 Empty: Indicates that no output channels in this group have been mapped to audio 
sources. 
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 (Optional) Click or Expand to expand the audio source types, or click  or 
Collapse to collapse the audio source types. Click Clear to clear all mapping 
relationships between input and output audio sources. 

 Note 

The audio matrix configuration functions for the P20-DS, P80 and Q8 are identical, 
with the only difference being the number of audio channels. The Q8 and P80 
supports 64x64 channels, while P20-DS supports 32x32 channels.  

Tools 

Maintenance 

In the menu bar, navigate to Tools > Maintain. Select the Device List or Screen List 
tab and the target devices or screens, and then do the following as required. 

 Maintenance 

 

 Note 

The P80 and Q8 support the separate update, restart, factory reset and log export for 
input cards, output cards, and main control card. 
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Update 

 Caution 

During the update process, power-off and all operations are NOT allowed. 
 

 Click Update. 

 In the pop-up dialog box, select the update file (.img) and click OK. 

 Confirm the devices to be updated, and click the Update button. 

 In the pop-up dialog box, click Yes and wait until the update completes. 

 After the update completes, click OK. 

Restart 

Click Restart. In the displayed dialog box, click Yes to restart the device. 

Factory Reset 

 Caution 

 Please do this with great caution. 

 The reset action does not affect the device firmware version. 

 Power-off is NOT allowed during the reset process. 

 The device will restart automatically after the reset is completed. 
 

Click Factory Reset. In the pop-up dialog box, select the desired reset option and then 
click OK. 

 Retain user data 

Retain the device IP address, input connector EDID, gallery files, device language 
settings, device name and belonged project. 

 Retain IP only 

Retain the device IP address. 

 Reset all 

Retain the device IP address and belonged project. 

Export Logs 

Click Export Log. In the dialog box that appears, select a path and click Save to save 
the device logs to local computer. 

Diagnostics 

Click Diagnostics. After the diagnostics completes, you can view the test result and 
take necessary measures as required. 
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Device Discovery 

Navigate to Tools > Device Discovery from the menu bar. In the popup, click Add to 
manually input the device IP. Once added, click OK. 

 Device discovery 

 

Advanced Uniform Control 

For devices in the same project, the advanced uniform control function can be 
activated to facilitate simultaneous operations on multiple seamless switchers. 

 Access the device configuration interface as described in 7.3.1 Enter Device 
Configuration Page. 

 Navigate to Tools > Uniform Control from the menu bar. 

 Uniform control 

 

 In the window that appears, toggle on the switch. 

 Notes 

 A single event controller or control PC can simultaneously control multiple 
seamless switchers. 

 All seamless switchers within the same local network and project as the event 
controller can be controlled simultaneously. 

 With advanced uniform control function enabled, if multiple seamless switchers 
are together used to control a screen and the sync sources of the switchers are 
consistent, it ensures that the content displayed and switched on the screen 
remains frame-synchronized. 
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Test Tool 

Utilize test patterns to assess display performance and pinpoint issues. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

For better software operation when the display window is large, it is recommended to 
prepare an extended display for viewing test patterns. 

Notes 

The test tool only supports Windows operating systems. 

Description 

Navigate to Tools > Test Tool from the menu bar to open the test tool configuration 
interface. Please refer to the Test Tools User Manual for specific operations. 

 Test tool 

 

Plugins 

PixelFlow supports the Companion plugin. For Companion operations, please refer to 
Stream Deck Configuration Guide. 
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Settings 

Export Logs 

In the menu bar, go to Settings > Export Log. 

 On a PC, you can export the logs of the PixelFlow software. 

 On an event controller, you can export the logs of both the PixelFlow software and 
event controller. 

Preferences 

In the menu bar, navigate to Settings > Preferences. Turn on the desired features 
(checked "√") or off (unchecked). 

 Lock Aspect Ratio: Lock the aspect ratio when adjusting the width and height of 
new layers if enabled. 

 Input View: Show the live image of the input source on the software interface if 
enabled. 

 Screen Resources: Show the usage of the main screen resources on the 
Programming interface if enabled. 

 Sync Visibility with Selection: When enabled, the screen's visibility aligns with its 
selection status. Select to make it visible; deselect to hide it. 

Input View Settings 

When a project contains a large number of devices, it can cause the software to 
become sluggish. In such cases, you can manually disable the input view function. If 
the number of devices exceeds a predefined threshold, the software will 
automatically disable the function for all devices to ensure smooth operation. 

Applicable Products 

P80, P20, P20-DS, P10, Q8 

Prerequisites 

None 

Notes 

None 

Description 

 From the menu bar, go to Settings > Input View Settings. 

 In the dialog box that appears, perform the operations as needed. 
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 Input view settings 

 

 Configure project-level input view: 

− : The input view switch for all devices in the project becomes 
configurable. The input view is shown or hidden based on each device's 
current switch state. 

− : The input view switches for all devices in the project are non-
configurable and maintain their previous state. The input view for all devices 
is hidden. 

 Configure device-specific input view: 

− : The input view for this device is displayed. 

− : The input view for this device is hidden. 

 After configuration, click OK. 

Link Settings 

By configuring the link function, two devices under the same local area network can 
establish a link relationship, allowing input source sharing via the device link ports. 

Applicable Products 

Q8, P80 

Prerequisites 

 The link ports between devices are connected. 

 Devices to be shared must be within the same project. 

 The model, version, and link card type of shared devices must be identical. 

Notes 

The connected status of link ports must align with the mapping relationship. 

Description 

 From the menu bar, go to Settings > Link Settings. 

 In the Add Link Device window, click  to add devices to be linked and set the link 
group name. Once configured, click OK. 
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 Add link devices (Q8) 

 

 The Link Settings interface displays the recommended mapping relationships 
between two linked devices, global sources, and device source list. 

 Link settings (Q8) 

 

 Add link group: Click  on the left to add a link group. 

 Recommended mapping relationship: 

Q8: For the three CXP ports, the mapping relationship is a one-to-one connection: 
1->1, 2->2, 3->3. For the eight QSFP ports, the mapping is similarly paired: 1->1, 
2->2, 3->3, 4->4, 5->5, 6->6, 7->7, 8->8. This forms a loop with LINK IN (input) to 
LINK OUT (output). 

Click Edit or  next to the link group to modify the current group, or click 
Disconnect to break the mapping between two devices.  
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 Note  

A link group can only be disconnected, not edited, under the following conditions: 

 A device in the link group is offline. 

 Inconsistencies in model, version, or lin card type within the link group 
 

 Global source: Input sources shared from other devices 

 Device source list: All input sources of the two current devices 

 Select an input source from one of the devices, then click  or Add to Link Source 
to include it in the mapping source (global source). Once added, the other device can 
also utilize this input source (global source). 

You can also batch add or batch delete the sources by checking the Batch Add 
option in the Device Source List area or the Batch Delete option in the Global source 
area. 

Configure VPU 

4K layer resources from a device's output cards can be shared across cards. Once a 
resource borrowing relationship is established, the borrowing card can utilize the 
layer resources of the lending card, enabling more complex editing and display 
scenarios. 

Applicable Products 

Q8 

Prerequisites 

None 

Notes 

The hot-swapping of the output cards does not affect the VPU configuration. 

Description 

 From the menu bar, go to Settings > VPU. 

 In the dialog box that appears, select the target device from the dropdown menu in 
the top-right corner. 
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 VPU 

 

 Locate the adjacent borrowing and lending cards. Click Borrow between the two 
cards to allocate layer resources from the card on the right to the card on the left. 

To cancel a borrowing relationship, click Cancel. 

 Resource borrowing 

 

 After configuration, click OK. 

Event Controller 
The event controller offers the same functionalities as the physical event controller's 
operation panel, enabling you to use the keys and display business statuses in 
PixelFlow. The features of the event controller include: 

 Option to simulate the U5 or U5 Pro event controller 

 Display of a simulation operation panel in a pop-up window on a PC 

 Device control through the simulation operation panel 

Fully customizable keys, identical to those on the physical event controller. For more 
information, refer to 8.3.16 Key Customization. 
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Help 

About Us 

In the menu bar, go to Help > About Us to view the software-related info and user 
manual. 

User Manual 

In the menu bar, go to Help > User Manual to scan the QR code or click the link 
provided to access the latest product documentation. 

User Interface Settings 

Change Skin 

In the upper right corner of the interface, click  to select the desired skin. 

 Change skin 

 

Switch Language 

In the top right corner, switch the language as needed. The options include English, 
Simplified Chinese, and Traditional Chinese.
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8 U5/U5 Pro Event Controllers 

About This Chapter 

This chapter introduces you to the U5/U5 Pro event controller. 

Overview 

 Introduction 

 Device Operations 
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Introduction 
The U5 series event controllers are equipped with two touchscreens, a main 
touchscreen and a smart touchscreen. On the main touchscreen, you can do various 
intuitive and free configurations for the seamless switchers, such as configurations 
of layers, layer position, input sources, output resolutions, input keying, layer borders, 
input crop and presets.  

The 8'' smart touchscreen displays still images, timecode, switcher and event 
controller status, and a Multiviewer image (Multiviewer 1, Multiviewer 2, or HDMI 1.3), 
and can be customized as a simulation MIDI keyboard. 

The U5 series event controllers include the following two models: 

 U5 event controller 

 U5 Pro event controller 

Hardware Introduction 

Front Panel 

U5 Front Panel 

 U5 front panel 

 

1. Main touchscreen 7. Function control area 

2. Screen buttons 8. Switching control area 

3. Layer buttons 9. T-Bar 

4. Signal source buttons 10. Power button 

5. Preset buttons 11. MIDI module area 

6. Smart touchscreen  

 Note 

The U5 LCD screen can be folded and locked at any angle between 45° and 125°.  
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U5 Pro Front Panel 

 U5 Pro front panel 

 

1. Main touchscreen 9. Number buttons 

2. Screen buttons 10. Switching control area 

3. Signal source buttons 11. MIDI module area 

4. Layer buttons 12. Power button 

5. Preset buttons 13. T-Bar 

6. Function control area 14. Keyboard 

7. Camera and timecode control area 15 Drawers 

8. Smart touchscreen  
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Rear Panel 

U5 Rear Panel 

 U5 rear panel 

 

1. 2x USB 3.0 5. 2x HDMI 2.0+1x HDMI 1.3 connectors 

2. Timecode module connector 6. 4x USB 2.0 ports 

3. Gooseneck lamp connector 7. USB (type-B) 

4. 2x ETHERNET ports 8. 1x Power module 

U5 Pro Rear Panel 

 U5 Pro rear panel 
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1. 2x USB 3.0 5. 2x HDMI 2.0+1x HDMI 1.3 connectors 

2. Gooseneck lamp connector 6. USB (type-B) 

3. Timecode module connector 7. 4x USB 2.0 ports 

4. 2x ETHERNET ports 8. 2x Power modules 

Connector Description 

No. Area Connector Qty Function 

1 USB USB 3.0 2 2x USB 3.0 on the right side of U5 

Connect to the mouse, keyboard, 
USB drive, etc. 

2 Gooseneck lamp 
connector 

- 1 
or 
2 

Connect the gooseneck lamp. 

The U5 has one gooseneck lamp 
connector and the U5 Pro has two. 

3 Timecode 
module 

LTC 3-pin XLR 
connector 

3 1x LTC IN, 2x LTC OUT 

 Connect to the external LTC-
format timecode input device. 

 LTC timecode output 

 MTC 5-pin XLR 
connector 

3 1x MTC IN, 1x MTC OUT, 1x USB 
(type-B) 

 MTC IN: Connect to the external 
MTC-format timecode input 
device. 

 MTC OUT: MTC timecode output 

 USB DEVICE: Support input and 
output of MTC timecodes from 
USB MIDI device 

4 ETHERNET Neutrik 
Ethernet ports 

2 2x Neutrik Gigabit Ethernet ports 

 Connect to the Ethernet control 
port of the backend control 
device. 

 Support mutual backup mode. 
The two Ethernet ports use the 
same IP address. 

 Support independent mode. The 
two Ethernet ports use two IP 
addresses. 

 Support transmission of the 
input view information. 

5 MULTIVIEWER HDMI 2.0 2  Generally connect to the MVR 
connector of the seamless 
switcher to view the output 



All-New Event Presentation Switching Solutions 

User Manual 8 U5/U5 Pro Event Controllers 

 

www.pixelhue.com 281 
 

monitoring. 

 Up to 4K×2K@60Hz 

HDMI HDMI 1.3 1  Generally connect to the output 
connector of the media server to 
display its user interface. 

 Up to 2K×1K@60Hz 

6 USB USB 2.0 4 Connect to the mouse, keyboard, 
USB drive, etc. 

7 MIDI / KVM USB (type-B) 1  KVM: Connect to a PC or media 
server via USB cable for KVM 
control. 

 MIDI: Connect to the MIDI control 
device for MIDI command 
output. 

 KVM and MIDI can be turned on 
at the same time. 

8 Power module 

- 

- 1 
or 
2 

 Power connector specifications: 
100-240V~, 6A, 50/60Hz 

 The U5 has one power module. 

 The U5 Pro has two power 
modules, one primary and one 
backup. 

Device Operations 

Basic Operations 

 Press: Press the button and release it within 3 seconds. 

 Hold down: Press and hold the button for 1.5 seconds or longer. 

 Click/Tap: Click or tap the menu once on the screen. 

 Double click/tap: Click or tap the same area twice quickly. 

 Combination of buttons: Hold down  or  to activate combination 
function and then press another function button to trigger the corresponding 
function. 

 Pinch in or stretch out: Place two fingers on the touchscreen and pinch in or 
stretch out. This operation is only to zoom in or out pictures on the smart 
touchscreen. 

Startup and Shutdown 

Prerequisites 

A power supply is connected and the power is supplied normally. 
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Startup 

Press the  button in the upper right corner of the panel, and the system will 
automatically start up. After startup, the main touchscreen displays the home screen. 

Shutdown 

Power off the event controller through the following methods: 

 Press the  button in the upper right corner of the panel, select OK in the pop-
up dialog box on the main touchscreen, and the system will shut down. 

 During the startup process, hold down the  button to force shutdown. 

 On the main touchscreen, choose Settings > Event Controller at the top and select 
the Other tab on the displayed page. In the Event Controller Power area, click Shut 
Down, and the device will automatically shut down. 

Restart Event Controller 

On the main touchscreen, choose Settings > Event Controller at the top and select 
the Other tab on the displayed page. In the Event Controller Power area, click Restart, 
and the device will automatically restart. 

 Note 

During startup or shutdown, the PIXELHUE logo is displayed on the home screen.  
 

Main Touchscreen 

The U5 has a 21.5’’ multi-touch main touchscreen with a resolution of 1920×1080. 

The U5 Pro has a 43.8’’ multi-touch main touchscreen with a resolution of 
1920×1080. 

On the main touchscreen, the built-in software user interface is displayed for you to 
do a lot of operations, such as adding devices, configuring screens, configuring 
inputs and outputs, configuring gallery, adding and deleting layers, configuring 
presets, configuring Multiviewer, importing and exporting project files, configuring 
the smart touchscreen, configuring the event controller skin, language and light, and 
much more. 

The main touchscreen supports the click, double-click, tap and double tap operations 
via the connected mouse or your finger. 

Screen Buttons 

Pressing a screen button selects the corresponding screen, and the PVW page of 
that screen will be displayed on the main touchscreen. 

The screen name displayed in the screen button can be modified through the screen 
editing page.  

The screen quantity and screen name depend on the selected device connected to 
the event controller. 
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 Screen buttons 

 

Screen Button Status 

The screen buttons have the following statuses: 

 Green: Screens are added to this button and being operated. 

 Yellow: Screens are added to this button but not selected. 

 Blank: No screens are added to this button. 

Screen Button Operations 

 Press the screen button (yellow) bound with screens to select this screen. After 
the screen is selected, the screen button turns green, and the corresponding 
screen in the main touchscreen enters the PVW activated status (the button will 
have a dazzling effect upon activation). 

 Press different screen buttons consecutively to select multiple screens. 

 Holding down the selected screen cancels screen selection. The button will turn 
yellow, and the screen corresponding to the button will become unselected in the 
main touchscreen. 

 Pressing the button with no screens bound (blank button) quickly creates a 
screen. For that created screen, the system uses an unused and top-ranked output 
connector to add a screen. If there is no unused output connector, an empty 
screen will be created. 

Screen Page Up/Down 

If there are too many screens, they will be displayed on different screen pages on the 
screen buttons. The first page is displayed by default and the page jumping operation 
is performed in the following method. 

 Page Down: Press  to jump to the next page. For example, when the page 

button displays Page 1 currently, press  to jump to the screens displayed in 
Page 2. 

 Page Up: Press  or use a key combination to jump to the previous page: 

U5: Press  while holding down the control button  in the control area to 
jump to the previous page. For example, when the page button displays Page 2 

currently, use the combination of  and  buttons to jump to the screens 
displayed in Page 1. 
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Signal Source Buttons 

Press to select a signal source for the layer. 

When a layer is selected, press a signal source button to switch the layer’s signal 
source. 

The U5 Pro has 28 signal source buttons, 1 device switching button, 1 signal source 
type switching button, and 2 page turning buttons. 

The U5 has 12 signal source buttons, 1 device switching button, 1 signal source type 
switching button, and 2 page turning buttons. 

 Signal source buttons 

 

 SWITCH DEVICE: Switch the device of the currently active screen and display a list 
of signal sources for the selected device. 

 Signal SOURCE: Switch between signal source types, including input sources, 
gallery, screen sources, MVR sources, etc. 

 The signal source page turning buttons support cyclic page turning. 

 All the signal sources are bound to the buttons by default. When the signal source 
changes, the button name will be automatically updated. 

 The status of signal source buttons are described as follows: 

− Green: The signal source is being used by the selected layer. 

− Yellow: The signal source has signal but it is not used by the layer. 

− Red: The signal source has no signal but it is used by the layer. 

− Orange: The signal source exceeds the connector's load capacity. 

− White: The input source has no signal. 

− Blank button: The button does not have corresponding signal source. 

Layer Buttons 

Pressing a layer button selects the corresponding layer and the PVW page of the 
screen corresponding to that layer will be displayed on the main touchscreen with 
that layer in the selected status. 
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The layer name displayed in the layer button can be modified on the layer editing 
page. 

 The U5 Pro has 30 layer buttons and 2 page turning buttons. 

 The U5 has 14 layer buttons and 2 page turning button. 

 Layer buttons 

 

Layer Button Status 

 Green: The layer is selected. 

 Yellow: The layer is added but not selected. 

 Blank button: The button does not have corresponding layer. 

Layer Button Operations 

 Pressing the layer button (yellow) bound with layer selects this layer. After the 
layer is selected, the layer button turns green. On the main touchscreen, the PVW 
area of the screen where the layer belongs to enters the activated status and the 
corresponding layer is selected. 

 Pressing the button with no layers bound (blank button) quickly creates a layer. 
The system uses an unused and top-ranked source with signal as the source for 
that created layer. 

The default source used by the system is the one connected to the input 
connector that has the smallest number on the input card with the smallest 
number as well. 

Preset Buttons 

Pressing the preset button loads a saved preset to the screen PVW area. 

The preset name displayed in the preset button can be modified on the preset list 
page. 

 The U5 Pro has 30 preset buttons and 2 page turning buttons. 

 The U5 has 14 preset buttons and 2 page turning button. 
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 Preset buttons 

 

Preset Button Status 

 Green: The preset has been loaded to the screen PVW. 

 Yellow: The preset is saved but not loaded. 

 Red: The preset has been loaded to the screen PGM. 

 Blue: This button is bound with the program of the media server. Pressing this 
button switches the program of the media server. 

 Purple: This button is bound with a preset and the program of the media server. 
Press this button to switch the program of the media server and switch the preset 
of the seamless switcher. 

 Blank button: The button does not have corresponding preset or program. 

Function Control Area 

 Function control area of U5 Pro 

 

 FTB: Make the output image fade to black. 

 FRZ: Freeze the current frame of the output image. 

 MATCH PGM: Press to synchronize all layer information in PGM to PVW. 

 PGM EDIT: Enable or disable the PGM editing function. After it is enabled, 
the layers in the current screen PGM can be edited. 
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  / : Control button, which can be used together with another button. 
Press and hold this key, and then press another function button (Page/TIME) to 

realize the corresponding function. For example, press  while holding down 

 on the U5 Pro to jump to the previous page. 

 : MVR button for checking the Multiviewer image on the right side of the 
main touchscreen from the MULTIVIEWER and HDMI IN connectors on the rear 
panel. If you press it consecutively, the Multiviewer image will be switched with 
the order of MULTIVIEWER (HDMI 1) > MULTIVIEWER (HDMI 2) > HDMI I 

 : MEDIA button. When the HDMI IN connector is connected to the media server, 
its user interface will be displayed on the main touchscreen. If its user interface is 
displayed by pressing the MVR button, pressing the MEDIA button enables KVM 
control. 

 : Press to stretch the selected layer to fill the screen area(s) in which the 
selected layer is located before it is stretched.  

 : Press to enter the DSK page for you to do chroma key and luma key 
operations on the input source. 

 : Press to bring the selected layer to front. 

 : Press to send the selected layer to back. 

 : Press to copy the selected layer. 

 : Press to flip the selected layer 

 : Hold down to lock the T-Bar. After it is locked and then pushed, the layer will 
not be switched. 

 : Hold down to lock the front panel and main touchscreen of the event 
controller. After locked, they cannot be used. 

 : In the U5 event controller, press this button to turn the page of the two rows of 
buttons on the left of this button. 

 Blank button: Reserved button for custom functions. 

Camera and Timecode Control Area 

The U5 and U5 Pro allow for adjusting the PTZ camera position and the timecode 
output. (The U5 requires key customization to enable this feature.) 
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 : Save to button. Press to activate the save to function and the button 
flashes yellow. Then, press a preset button, and the current layer or program will 
be saved to the selected preset. 

 : Delete button. Press to activate the delete function and the button 
flashes yellow. Then, press a preset, layer or screen button, and the selected 
preset, layer or screen will be deleted. 

 : Timecode module control buttons 

 

 PTZ camera adjustment buttons: 

− : Save the PTZ position after adjustment as a pattern for quick PTZ 
switching in the future. Press the button to activate it and it flashes yellow. 
Then, press Pattern 1 or Pattern 2 to save the PTZ camera positions in the 
two buttons. 

−  /  /  / : Adjust the PTZ camera shooting angle up, 
down, left and right. 
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−  / : The saved PTZ camera positions. Press these buttons to apply 
the position to quickly adjust the PTZ camera. 

Smart Touchscreen 

 Smart touchscreen home 

 

Import Still Images or Files 

 Save the pictures or files to be imported into the smart touchscreen to the USB drive. 

 Insert the USB drive to the USB port on the side panel of the event controller. 

 On the main touchscreen, choose Settings > Event Controller, and select the Smart 
Screen tab to enter the tab page. 

 In the Still Images or Files area, click  to add pictures or files. 

 Still images 
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Enable Slideshow as needed and set the duration and transition. 

 File management 

 

 Select the inserted USB drive in the pop-up dialog box, select the necessary pictures 
or files, and click Open to import the selected pictures or files to the smart 
touchscreen. 

 Up to 8 pictures in png, jpeg, jpg, and bmp formats can be imported into the smart 
touchscreen. 

 Up to 20 files can be imported into the smart touchscreen, with each file not 
exceeding 50 MB. After importing, you can open up to 5 files simultaneously and 
delete files as needed. Supported file formats for the smart touchscreen include 
PDF (.pdf), PowerPoint (.ppt, .pptx), Word (.doc, .docx), Excel (.xls, .xlsx), and text 
(.txt). 

View Images on Smart Touchscreen 

On the smart touchscreen, tap Still Images to enter the subpage. 

 Still images are displayed in full screen mode on the smart touchscreen by 
default. 

 Swipe left or right to view the next or previous image. The images will cycle in a 
continuous loop as long as you keep swapping.  

 After you turn on slideshow function, the images will automatically cycle in a 
continuous loop as long as the slideshow function is turned on.  

 Pinch with two fingers to zoom in or out the still images. 

View Files on Smart Touchscreen 

On the smart touchscreen, tap Files to enter the file display screen. 
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 Viewing files 

 

 You can view the file list and open multiple files. 

 Pinch with two fingers to zoom in or out the files. 

View Timecode 

On the smart touchscreen, tap Timecode and view the timecode information of 
output. 

 Timecode displayed 

 

There are two ways to configure timecode:  

 On the main touchscreen, choose Settings > Event Controller, select the Smart 
Screen tab to enter the tab page, and configure the timecode display format and 
display information. 
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 Timecode information 

 

 In the “timecode control area” on the U5 Pro panel, press the corresponding 
button to change the timecode format, enable or reset timecode. 

PTZ Control 

On the smart touchscreen, tap PTZ to enter the PTZ control screen, where you can 
perform the following operations for cameras using different protocols: 

 PTZ 

 

Protocol Common Operations Other Operations (VISCA Protocol Only) 

ONVIF  Patterns 1~8: Eight 
patterns for saving IP 
camera related 
parameters. 

 Save to Pattern: Save 

/ 

VISCA  White Balance (K): Calibrate the color temperature of light 
sources to ensure white objects appear without a color cast. 

Support Preset, Auto, and Manual modes. In Auto mode, click 
Calibrate for automatic white balance. 
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Protocol Common Operations Other Operations (VISCA Protocol Only) 

the configured pattern. 

 Zoom: Control the 
camera's zoom 
function to zoom in (+) 
or out (-). 

 Focus: Adjust the 
camera’s focus for 
closer (+) or farther (-) 
objects. 

 Aperture: Control the 
camera's aperture size 
to increase (+) or 
decrease (-). 

 Speed: Adjust the 
camera's movement 
speed, ranging from 1 
to 7 levels, with options 
to increase (+) or 
decrease (-). 

 Mode: Support Indoor and Outdoor modes. 

Available when White Balance (K) is set to Preset. 

 Red Gain: Adjust red channel gain to correct green or cyan tints. 

Adjustable when White Balance (K) is set to Preset. 

 Blue Gain: Adjust blue channel gain to correct yellow or red tints. 

Adjustable when White Balance (K) is set to Preset. 

 Exposure Control (EV): Select exposure mode. 

Support Manual, Auto, Shutter Priority, and Aperture Priority 
modes. 

 Exposure Compensation: Manually adjust brightness on top of 
automatic exposure to retain depth between background and 
subject. 

Adjustable when Exposure Control (EV) is set to Auto or 
Aperture Priority. 

 Backlight Compensation: Automatically increase the foreground 
brightness to counteract silhouetting caused by strong 
backlight. 

− : On. 

− : Off. 

Adjustable when Exposure Control (EV) is set to Auto. 

 Shutter Speed: Control exposure time per frame. 

Adjustable when Exposure Control (EV) is set to Manual or 
Shutter Priority. 

 Gain: Increase brightness of dark areas. 

Adjustable when Exposure Control (EV) is set to Manual. 

 Aperture: Control camera's aperture size. 

Adjustable when Exposure Control (EV) is set to Aperture 
Priority. 

Check Event Controller Running Status 

On the home of smart touchscreen, click Health to enter the subpage where you can 
check the following information: 

 CPU, RAM, motherboard, and disk running status 

 Power supply and HDMI connector connection status 

 Transmission rate of the Ethernet ports 
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 Event controller health 

 

View Multiviewer Images 

On the home of smart touchscreen, click Multiviewer to enter the Multiviewer (MVR) 
page. 

 Video page 

 

The following requirements must be met to view Multiviewer images. 

 The HDMI 2.0 connector in the MULTIVIEWER area on the rear panel of the event 
controller has been connected to the Multiviewer connector of the seamless 
switcher. 

 The Multiviewer configuration is completed on the main touchscreen. 

 The software control output connector of the media server has been connected to 
the HDMI 1.3 connector on the rear panel of the event controller. 
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 On the event controller area of the front panel, press  to switch between 
Multiviewer image and image from the media server. Each time you press it, the 
image displayed on the smart touchscreen display screen changes from MVR1 to 
MVR2 and then HDMI 1.3 (control interface of the media server). 

Number Buttons 

The U5 Pro is equipped with number buttons, which are used to enter numbers when 
adjusting layer size, position, etc. 

 Number buttons 

 

  to : Press to enter the corresponding number. 

 : Press to subtract 1 from the current number for fine adjustment. 

 : Press to add 1 to the current number for fine adjustment. 

 : Press to enter the decimal point. 

 : Press to delete a number or character to the left of the cursor. 

 : Confirm and exit the current input. 
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Switching and Control Area 

 Switching and control area 

 

 FRZ: Freeze all the images of the selected screen. 

 FTB: Make the output images displayed on the selected screens fade to black. 

 LOCK T-BAR: Lock the T-Bar. After it is lock, pushing T-Bar does not take effect. 

 SWAP: Press the button to enable or disable the SWAP function. 

 SWAP enabled: The button is solid green and the switching mode from PVW to 
PGM is swapping. That is, the PVW and PGM images are swapped during image 
switching. 

 SWAP disabled: The button is off and the switching mode from PVW to PGM is 
copying. That is, PGM copies the PVW image during image switching. 

 TIME: Set the transition effect duration. 

The combination key operations for C5 and C5 Pro are as follows: 

− U5: While holding down  in the control area, press TIME to decrease the 
effect duration; holding down TIME (>300ms) to rapidly decreases the effect 
duration. 

− U5 Pro: While holding down  in the control area, press TIME to 
decrease the effect duration; holding down TIME (>300ms) to rapidly 
decreases the effect duration. 

 

 Trans: Set the transition effect during switching. 
Currently only the Fade effect is supported. 

 CUT: Press to send PVW to PGM directly without transition effect. 

 TAKE: Press to send PVW to PGM with a selected transition effect. 

MIDI Module Area 

The MIDI module has 4 encoders and 8 faders, which can be used for property 
adjustment or MIDI keyboard control. 
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 When used as a property adjustment, they can adjust the layer size, position, 
image quality, etc. 

 To use them used as a MIDI keyboard, connect the USB (MIDI/KVM) connector of 
the event controller to the controlled device, such as an audio console, a lighting 
console, etc. 

After the property adjustment information is bound to the encoders and faders, the 
corresponding encoder or fader icons will be displayed on the property adjustment 
page. 

 Bound to encoders 

 

When you enter a property area, the adjustment parameters are automatically bound 
to the encoders and faders, and the binding relation icons are displayed under the 
menu in the property area. The corresponding relation between the icons and MIDI 
buttons is shown in the figure below. 

When you rotate an encoder or a fader, the system automatically adjusts the 
parameters corresponding to the encoder or fader. If a property parameter does not 
have a corresponding encoder or fader, rotating the encoder or pushing the fader 
does not take effect. 

 Turn the encoder right to increase the corresponding parameter value, and turn 
the encoder left to decrease the value. 

 Push the fader up to increase the corresponding parameter value, and pull the 
fader up down to decrease the value. 
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 Binding relationship between menu adjustment and MIDI buttons 

 

Power Button 

 Press the  button in the upper right corner of the panel, and the system will 
automatically start up. After startup, the main touchscreen displays the home 
screen. 

 Power off the event controller through the following methods: 

− Press the  button in the upper right corner of the panel, select OK in the 
pop-up dialog box on the main touchscreen, and the system will shut down. 

− During the startup process, hold down the  button to force shutdown. 

T-Bar 

Pushing the T-Bar up or pulling it down to manually control the switching from PVW 
to PGM. The LED indicator shows the switching progress. 

During the process of pushing or pulling the T-Bar, pressing the buttons on the front 
panel of the event controller does not take effect. 
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 T-Bar area 

 

Key Customization 

This feature supports the following functions: 

 Supports simulation of all physical keys, encoders, faders and T-bar of the event 
controller. 

 Allows you to customize the business bound to the keys, key function properties, 
key styles, and MIDI parameters. 

 Allows you to save the key customizations as multiple configuration files for easy 
recall and transfer them across different event controllers. 

Switcher Layout Configuration 

This function allows you to bind devices, screens, inputs, layers and presets to the 
physical keys in the corresponding key area on the event controller. 

 From the device list on the primary touchscreen, double tap a device to enter its 
page. 

 From the menu bar on the top, tap Custom Keys. 

 In the Switcher Layout area, select a configuration file and tap Edit. 

 Switcher layout configuration 

 

 From the switcher layout menu bar on the left, select a desired business and bind it 
to a key (Refer to Figure 8-33 for key area description and Table 8-1 for binding area 
restrictions.) 
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 Binding switcher business to keys 

 

 Tap a desired business and then tap the target key in the corresponding area to 
complete binding. 

 Tap and drag a business to the target key in the corresponding area to complete 
binding. 

 Batch binding: In the Batch Bind area in the left menu bar, select the binding type, 
enter the business start, business end, key start and key interval, and tap Bind. 

 (Optional) Reset: From the switcher layout menu bar on the left, tap Reset in the 
corresponding business property area. 

 Reset 

 

 Note  

 You can only edit and save the default switcher layout configuration file. 

 You can bind a business to multiple physical keys. 

 You can not clear the binding relationships of the switcher layout configuration. 
 

Event Controller Layout Configuration 

This feature allows you to configure the key properties for areas 1 to 8 (refer to Table 
8-2 for key area descriptions) as device, screen, input, layer, preset, or custom 
settings. You can also bind keys to various events, including system functions, layer 
editing, timecode editing, PTZ control, input parameter adjustment, output parameter 
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adjustment, screen parameter adjustment, layer parameter adjustment, and PTZ 
parameter adjustment. 

 From the device list on the primary touchscreen, double tap a device to enter its 
page. 

 From the menu bar on the top, tap Custom Keys. 

 In the Event Controller Layout area, tap New to enter the layout configuration file 
editing page (To edit an existing file, tap to select it and then tap Edit.) 

 New/Edit 

 

 From the key property drop-down box, select a property to complete key area 
property customization. 

For example, after you set the property of a key area to SCREEN, you can bind 
screens to keys in this key area. After you set the property of a key area to CUSTOM, 
you can bind the system functions, layer editing, timecode editing, and PTZ control 
events to keys in this key area. 



All-New Event Presentation Switching Solutions 

User Manual 8 U5/U5 Pro Event Controllers 

 

www.pixelhue.com 302 
 

 Key properties 

 

 From the left menu bar, select an event and bind it to a key. (Refer to Figure 8-33 for 
key area description and Table 8-1 for binding area restrictions.) 

 Binding events to keys 

 

 Select an event, and tap the target key in the corresponding key area. 

 Tap and drag an event to the target key in the corresponding key area. 

 (Optional) Set the key properties. (Refer to Table 8-2 for related restrictions.) 
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 Property settings 

  

 Enable/Disable key functions/events: Tap the switch button on the right menu bar. 

 Set common style: select a key and set the title and background on the right menu 
bar. 

 Event precondition: Only the events that can be bound to key area 11 have 
precondition. 

 Set MIDI: Select MIDI from the right menu bar, enable the event switch, and set the 
MIDI parameters. 

 (Optional) Clear binding: On the menu bar of event controller configuration, tap Clear 
in a business property area. 
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 Clearing 

 

 Tap Save or Save As to save your customization as a configuration file. 

 Go back to the configuration file list, select a configuration and tap Apply to apply it 
to the event controller. 

 Applying 

 

 Tap Select at the top of the layout configuration file list. A drop-down menu will 
appear, allowing you to delete, share, import, or export configuration files. 
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 Related operations 

 

 Note  

 You can create up to 128 event controller layout configuration files, including 
one default configuration. 

 The default configuration file can be edited, but cannot be deleted, shared, or 
exported. 

 A single event can be bound to multiple physical keys. 

 The event controller supports MIDI key parameter customization and MIDI 
output switch settings, but these features are not available in the PixelFlow on 
PC. 

 

 Key areas of the U5 Pro (the U5 lacks areas 5 to 9) 

 

Table 8-1 Binding area restrictions 

Business/Event Properties Available Key Areas  

Switcher layout 
configuration 

Screen 1, 2 

Input 7, 8 

Layer 5, 6 

Preset 3, 4 

Event controller layout 
configuration 

System 
functions 

Page+, Page- 1 to 10, 12 to 15, custom 
property key area 

Others 9, 10, 13, custom property 
key area 
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Business/Event Properties Available Key Areas  

Layer editing 9, 10, 13, custom property 
key area 

Timecode editing 9, 10, 13, custom property 
key area 

PTZ control 9, 10, 13, custom property 
key area 

Input parameter adjustment 11 

Output parameter 
adjustment 

11 

Screen parameter 
adjustment 

11 

MVR parameter adjustment 11 

Layer parameter 
adjustment 

11 

PTZ parameter adjustment 11 

Table 8-2 Key area description 

Key Area Key Property Settings Number of Businesses/Events That Can Be 
Bound to a Key 

1 to 8 None 1 business 

9 Support common style 
settings 

1 event 

10 Support common style 
settings 

1 event 

11 Support event and MIDI 
settings 

Multiple events (The preconditions for these 
events must be distinct.) 

12 to 15 None Do not support binding. 

Keyboard 

The U5 Pro has a built-in 61-key mechanical keyboard. To open the keyboard, just pull 
the middle section on the front panel. 
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Drawers 

The U5 Pro is equipped with two drawers for you to put some wires or small objects. 
To open the drawers, just pull the two sections next to the keyboard out on the front 
panel. 

 

Event Controller Settings 

PTZ Control 

 In the top menu bar, select Settings > Event Controller. 

 Event controller settings 

 

 Select the PTZ Control tab. 

 In the device list, click Add Device. 

 In the Add Signal pop-up window, configure the relevant information. 
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 Signal Name: Name of the signal source accessed by the camera. 

 Protocol: Select the protocol type, including ONVIF and VISCA. 

 IP Address: The IP address of the camera. 

 Port: The protocol communication port for the camera (1-65535). 

 User Name: Enter the user name. 

 Password: Enter the password. 

 Manufacturer: Select the manufacturer. This parameter is available when VISCA is 
selected as the protocol. 

 Stream Address: After selecting the protocol, the corresponding stream address 
will be automatically filled. If Other is selected, it can be entered manually. This 
parameter is available when VISCA is selected as the protocol. 

 After configuration, click OK to view the added device, and you can edit, view details, 
or delete the device. 

Smart Touchscreen Configuration 

 In the top menu bar, select Settings > Event Controller. 

 Select the Smart Screen tab. 

 Import still images and files, and configure timecode information. For detailed 
operations, refer to Smart Touchscreen. 
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 Smart touchscreen configuration 

 

Light Settings 

 In the top menu bar, select Settings > Event Controller. 

 Select the Light tab. 

 Adjust screen brightness, light switches, light brightness, and light color as needed. 

 Light settings 

 

Button Style 

 In the top menu bar, select Settings > Event Controller. 

 Select the Event Controller tab. 

 Change the button style as needed, and click Apply after selection. You can preview 
the new style on the simulation event controller. 
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 Changing button style 

 

Basic Info 

 In the top menu bar, select Settings > Event Controller. 

 Select the Basic Info tab. 

 Perform network settings, time settings, event controller maintenance, factory reset, 
and power operations. 

Network Settings 

 Select the Ethernet port mode: Backup or Independent. 

 Backup Mode: Configure network settings on Ethernet port 1; Port 2 will mirror 
Ethernet port 1 and cannot be modified. 

 Independent Mode: Configure network settings for both Ethernet port 1 and 
Ethernet port 2. 

 Once done, set the mode (Manual or DHCP), IP address, subnet mask, and gateway. 

 Click Apply. 
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 Network settings 

 

Time Settings 

Configure time zone, date, time format, and time. Click Apply when done. 

 Time settings 

 

Event Controller Maintenance 

Perform maintenance or updates. Click Maintain for diagnostics (refer to Event 
Controller Diagnostics). Click Update to select files for updating. 

Factory Reset 

Select the reset conditions for factory reset and click Apply. The device will reset 
according to the chosen conditions. After restoring factory settings, the device will 
automatically restart. 

 Retain IP only: During a factory reset, the event controller retains its IP address, 
while all other parameters are restored to their default values. 
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 Reset all: During a factory reset, all parameters of the event controller are restored 
to their default values. 

Event Controller Power 

Set event controller power options. Click Restart to reboot or Shut Down to power 
off. 

Event Controller Skin 

Click  on the far right of the top menu bar to choose between Cosmic Gray or 
Midnight Black skins. 

Event Controller Diagnostics 

The event controller diagnostics can assess the device's operational status, identify 
potential issues, enhance device reliability, and ensure operational accuracy. It 
includes button test, touchscreen calibration, and T-Bar correction. 

 In the top menu bar, select Settings > Event Controller. 

 Select the Other tab. 

 In the Event Controller Maintenance area, click Maintain to enter the event controller 
tool page. 

 Event controller maintenance 

 

Alternatively, press the first and last buttons of the first row in the button area at the 
top left of the event controller simultaneously to enter the event controller tool page. 
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Butten Test 

The button test can verify if each button is making good contact, ensuring that all 
buttons function properly.   

 Select Diagnostics > Button Test and click Click to Test. 

 Button test 

 

 Wait for the test to complete, and then view the results (avoid other operations during 
the process). 

 Test completed 

 

Touchscreen Calibration 

The U5 and U5 Pro support touchscreen calibration. This aligns the touchpoints with 
the display content, enhancing the accuracy of touch operations and overall user 
experience. 

 Select Diagnostics > Touchscreen Calibration and click Click to Calibrate. 

 Touchscreen calibration 

 

 Following the prompts in the button area near the main touchscreen or smart 
touchscreen, use one finger to tap the indicated screen, and then press Enter to 
proceed to the next step. 
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 Following the prompts in the button area near the main touchscreen or smart 
touchscreen, use one finger to tap the indicated screen, and the calibration is 
finished. 

T-Bar Correction 

When the T-Bar doesn't reach 100% at the top or 0% at the bottom, T-Bar correction is 
needed. 

 Select Diagnostics > T-Bar Correction. 

 T-Bar correction 

 

 Set the tolerance, click Start, and follow the prompts to complete the correction 
steps. After all steps, a "Correction completed" message will appear. 
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 Correction completed 
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A Specifications  

A.1 P80 Specifications 

 Description 

Inputs 16x 4K concurrent inputs 

Main Outputs 4x 4K concurrent main outputs 

OPT Ports 8x 10G SFP 

Flex Outputs 4x HDMI 2.0 

Matrix Outputs 4x 12G-SDI 

Layers 8x 4K mixing main layers and 4x 4K mixing PIP layers 

Multiviewer Connectors 2x HDMI 2.0 

Presets 256 

BKG 1 GB of storage space 

Front Screen 7" touchscreen 

Gigabit Ethernet Ports 2 

Control  Front panel touchscreen 

 Event Management Software PixelFlow 

 Event Controller U5/U5 Pro 
 Third-party control system Stream Deck (Companion integrated into the 

P80) 

Processing FPGA-based high-performance image enhancement architecture 

Chassis  4 RU 

Dimensions W 482.6 mm × D 536.0 mm × H 177.0 mm 

W 19.0 in × D 21.1 in × H 7.0 in 

Weight Net Weight 23.0 kg / 50.7 lbs 

With Flight Case 59.6 kg / 131.4 lbs 

Electric Parameters Power connector: 100-240V~, 50/60Hz 
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Max power consumption: 450 W 

Noise on Average (@1, 
0.75m height) 

45 dB 

Operating Environment 
Temperature: 0°C to 50°C (32°F to 122°F) 

Humidity: 5% RH to 85% RH, non-condensing 

Storage Environment 
Temperature: –20°C to +70°C (–4°F to 158°F) 

Humidity: 5% RH to 95% RH, non-condensing 

A.2 P10/P20/P20-DS Specifications 

 P20 P20-DS P10 

Inputs 
8x DP 1.2/HDMI 2.0 

4x 12G-SDI (in & loop) 

8x DP 1.2/HDMI 2.0 

4x 12G-SDI 

4x DP 1.2/HDMI 2.0 

2x 12G-SDI 

Outputs 8x HDMI 2.0 
8x HDMI 2.0 

4x 12G-SDI 

2x HDMI 2.0 

6x HDMI 1.3 

OPT Ports 8 4 

AUX Connectors 4x HDMI 1.3 2x HDMI 1.3 

3.5 mm Audio Jacks  

2x 3.5 mm line in 

2x 3.5 mm line out 

2x Dante connectors 

2x 3.5 mm line in 

2x 3.5 mm line out 

2x 3.5 mm line in 

2x 3.5 mm line out 

*The audio function of the P20 and P10 will be implemented in future 
updates. 

Layers 
12 DL layers (2×MAIN+10×PIP) or 8 DL 
layers (4×MAIN+4×PIP) 

6x DL layers or 3x 4K layers 

Multiviewer Connectors 1x HDMI 1.3 

Presets 128 

BKG & LOGO Up to 255 BKGs & LOGOs (Maximum storage space: 512 MB) 

Front Screen 5" LCD 

Gigabit Ethernet Ports 2 

Control 

 Front panel buttons and LCD 
 Event Controller U5/U5 Pro 
 Event Management Software PixelFlow 
 Third-party control system Stream Deck (Companion integrated into the 

P20/P20-DS/P10) 

Processing 
 FPGA-based high-performance image enhancement architecture  
 Real 4K60p 4:4:4 10-bit internal video processing 

Chassis  3 RU 2 RU 

Dimensions 
W 482.6 × D 501.0 × H 139.0 mm 
W 19.0 × D 19.7 × H 5.5 inches 

W 482.6 × D 493.0 × H 94.6 
mm 
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 P20 P20-DS P10 

W 19.0 × D 19.4 × H 3.7 
inches 

Weight 

Net Weight 10.2 kg / 22.5 lbs 10.7 kg/23.6 lbs 7.9 kg / 17.4 lbs 

With Paper Box 14.3 kg / 31.5 lbs 14.8 kg/32.6 lbs 10.2 kg / 22.5 lbs 

With Flight Case 25.2 kg / 55.6 lbs 25.7 kg/56.7 lbs 20.6 kg / 45.4 lbs 

Electric 
Parameters 

Input Power 100-240V~, 50/60Hz 
100-240V~, 3.0-1.5A, 
50/60Hz 

Max power 
consumption 

140 W 160 W 82 W 

Noise on Average (@1, 
0.75m height) 

45.6 dB 41.9 dB 

Operating Environment 
Temperature: 0°C to 50°C (32°F to 122°F) 

Humidity: 0% RH to 80% RH, non-condensing 

Storage Environment 
Temperature: –20°C to +60°C (–4°F to 140°F) 

Humidity: 0% RH to 95% RH, non-condensing 

A.3 Q8 Specifications 

 Description 

Inputs Up to 48x 4K concurrent inputs through 6 input cards 

Outputs Up to16x 4K concurrent outputs through 4 output cards 

OPT Ports 8 

Layers 32x 4K mixing layers in switcher mode 

Multiviewer Connectors 2x HDMI 2.0 

Presets 1024 

BKG & LOGO Unlimited picture quantity in 1G storage space 

Front Screen 7" touchscreen 

Gigabit Ethernet Ports 2 

Control 

 Front screen 

 Event Management Software PixelFlow 

 Event Controller U5/U5 Pro 
 Third-party control system Stream Deck (Companion integrated 

into the Q8) 

Processing 
FPGA based high performance image processing architecture with 
SuperView scaling engine inside 

Chassis  7 RU 
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Dimensions 
W 482.6 mm × D 694.7 mm × H 335.3 mm 

W 19 × D 27.4 × H 13.2 inches 

Weight 

Net Weight 42.6 kg / 93.9 lbs 

Gross 
Weight 

Packed with a 
Flight Case 

99.7 kg / 219.8 lbs 
Note: It is the total weight of the product, accessories, and packing 
materials packed with a flight case. 

Packed with a 
Flight Case, a 
Paper box and a 
Wooden Pallet 

123 kg / 271.2 lbs 
Note: It is the total weight of the product, accessories, and packing 
materials packed with a flight case, a paper box and a wooden 
pallet. 

Electric Parameters 
Power connector: 100‒240V~, 10A-5A, 50/60Hz 

Max power consumption: 1400 W 

Noise on Average (@1, 0.75m 
height) 

45 dB 

Operating Environment 
Temperature: 0°C to 50°C (32°F to 122°F) 

Humidity: 0% RH to 80% RH, non-condensing 

Storage Environment 
Temperature: –20°C to +60°C (–4°F to 140°F) 

Humidity: 0% RH to 95% RH, non-condensing 

A.4 U5/U5 Pro Specifications 

 U5 U5 Pro 

Front Screen 
Main touchscreen: 21.5" 

Smart touchscreen: 8" 

Main touchscreen: 43.8" 

Smart touchscreen: 8" 

Dimensions W 740 × D 651.4 × H 431.6 mm 

W 29.13 × D 25.65 × H 16.99 inches 

W 1129.6 × D 695.4 × H 422.7 mm 

W 44.47 × D 27.38 × H 16.64 inches 

Weight  Net weight 24 kg 46 kg 

With a Flight 
Case and a 
Paper Box 

56.9 kg 110.8 kg 

Electric Parameters Power connector: AC100-240V~, 
6A, 50/60Hz  

Max power consumption: 240 W 

Power connector: AC100-240V~, 6A, 
50/60Hz  

Max power consumption: 330 W 

Noise on Average (@1, 
0.75m height) 

40 dB 40 dB 

Operating Environment 
Temperature: 0°C to 50°C (32°F to 122°F) 

Humidity: 0% RH to 80% RH, non-condensing 

Storage Environment 
Temperature: –20°C to +60°C (–4°F to 140°F) 

Humidity: 0% RH to 95% RH, non-condensing 
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B Supported Resolutions 

B.1 P80 

Input Bit Depth Sampling Format Supported Resolutions Connector Bandwidth 

DP 1.2 8bit RGB 4:4:4 8192×1080@60Hz 

4096×2160@30Hz 

3840×2160@60Hz 

21.6 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 8192×1080@60Hz 

4096×2160@60Hz 

3840×2160@60Hz 
YCbCr 4:4:4 

YCbCr 4:2:2 

12bit RGB 4:4:4 4096×2160@30Hz 

YCbCr 4:4:4 

YCbCr 4:2:2 8192×1080@60Hz 

3840×2160@60Hz 

HDMI 2.0 8bit RGB 4:4:4 4096×2160@60Hz 

8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12G-SDI 10bit YCbCr 4:2:2 4096×2160@60Hz 11.88 Gbps 
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B.2 P20/P20-DS/P10 

Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

DP 1.2 8bit RGB 4:4:4 

4096×2160@60Hz 
8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 
4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

HDMI 2.0 8bit RGB 4:4:4 
4096×2160@60Hz 

8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12G-SDI 10bit YCbCr 4:2:2 4096×2160@60Hz 11.88 Gbps 

B.3 Q8 

Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

HDMI 2.0 8bit RGB 4:4:4 4096×2160@60Hz 

8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 
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Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

HDMI 2.1 8bit RGB 4:4:4 4096×2160@60Hz 

8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

DP 1.2 8bit RGB 4:4:4 8192×1080@60Hz 

4096×2160@30Hz 

3840×2160@60Hz 

21.6 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

12bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

DP 1.4 8bit RGB 4:4:4 8192×1080@60Hz 

4096×2160@30Hz 

3840×2160@60Hz 

21.6 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

12bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

12G-SDI 8bit YCbCr 4:2:2 4096×2160@60Hz 11.88 Gbps 

10bit YCbCr 4:2:2 

12bit YCbCr 4:2:2 

25G OPT 8bit RGB 4:4:4 4096×2160@60Hz 25 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 



All-New Event Presentation Switching Solutions 

User Manual B Supported Resolutions 

 

www.pixelhue.com 323 
 

Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

10bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

100G OPT 8bit RGB 4:4:4 4x 4096×2160@60Hz 100 Gbps (4x 25 Gbps) 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

 Note  

In the current version, the DP 1.4 and HDMI 2.1 connector specifications are limited 
to 4K×2K@60Hz. Once the device supports 8K layers in the future, the specifications 
will be expanded to 8K×4K@30Hz.  

B.4 U5/U5 Pro 

Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

HDMI 2.0 8bit RGB 4:4:4 

4096×2160@60Hz 
8192×1080@60Hz 

18 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 4096×2160@30Hz 
4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

12bit RGB 4:4:4 4096×2160@30Hz 

4096×1080@60Hz YCbCr 4:4:4 

YCbCr 4:2:2 4096×2160@60Hz 

HDMI 1.3 8bit RGB 4:4:4 

2048×1152@60Hz 

4.95 Gbps 

YCbCr 4:4:4 

YCbCr 4:2:2 

10bit RGB 4:4:4 

YCbCr 4:4:4 

YCbCr 4:2:2 

12bit RGB 4:4:4 

YCbCr 4:4:4 
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Input Bit Depth Sampling Supported Resolutions Connector Bandwidth 

YCbCr 4:2:2 
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